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This manual is part of a collection of GNOME manuals distributed under the GFDL.
If you want to distribute this manual separately from the collection, you can do so by
adding a copy of the license to the manual, as described in section 6 of the license.

Many of the names used by companies to distinguish their products and services are
claimed as trademarks. Where those names appear in any GNOME documentation,
and the members of the GNOME Documentation Project are made aware of those
trademarks, then the names are in capital letters or initial capital letters.

DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT ARE PROVIDED
UNDER THE TERMS OF THE GNU FREE DOCUMENTATION LICENSE WITH THE
FURTHER UNDERSTANDING THAT:

1. DOCUMENT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION
OF THE DOCUMENT IS FREE OF DEFECTS MERCHANTABLE, FIT FOR A
PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO THE
QUALITY, ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR
MODIFIED VERSION OF THE DOCUMENT IS WITH YOU. SHOULD ANY
DOCUMENT OR MODIFIED VERSION PROVE DEFECTIVE IN ANY RESPECT,
YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY CONTRIBUTOR) ASSUME
THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS
LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED VERSION OF THE
DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS
DISCLAIMER; AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER
IN TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL
THE AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR
OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT, OR ANY
SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
OF ANY CHARACTER INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR ANY AND ALL OTHER DAMAGES OR LOSSES ARISING
OUT OF OR RELATING TO USE OF THE DOCUMENT AND MODIFIED
VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY SHALL HAVE BEEN
INFORMED OF THE POSSIBILITY OF SUCH DAMAGES.

Feedback
To report a bug or make a suggestion regarding this package or this manual, follow

the directions at the GNOME Bug Tracking System.
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Introduction

GnuCash is the personal finance software package made for you. It is versatile
enough to keep track of all your financial information, from the simple to the very
complex. It is one of the few financial software packages that supports global
currencies, and it is the only open-source program of its kind. Best of all, GnuCash is
easy to learn and use!

So, what can GnuCash do for you? It can keep track of your personal finances in as
much detail as you prefer. If you are just starting out, use GnuCash to keep track of
your checkbook. You may then decide to track cash as well as credit card purchases
to better determine where your money is being spent. When you start investing, you
can use GnuCash to help monitor your portfolio. Buying a vehicle or a home?
GnuCash will help you plan the investment and track loan payments. If your financial
records span the globe, GnuCash provides all the multiple-currency support you
need.
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This image shows a Chart of Accounts with multiple currencies and investments.

While GnuCash is well suited for personal finances, it is also powerful enough for
business use. There are many business features, from integrated accounts receivable
and payable systems, to tax table construction. You will find these and the many
other business features surprisingly powerful and easy to use.

Features

Easy to Use

Within a matter of minutes you will be able to enter your personal finance
information and generate color graphs that represent your financial status. If you
can use the register in the back of your checkbook - you can use GnuCash! Type
directly into the register, tab between fields, and use quick-fill to automatically
complete transactions. The interface is customizable from within the application
itself.

e Easy to Use Menus: GnuCash menus conform with the GNOME Human Interface

Guidelines. This means that they are simple and similar in appearance to many
other GNOME applications.
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e Documentation: GnuCash has built in Help and extensive User Guide
documentation.

o Import Methods: GnuCash supports many ways to input transactions besides
manual entry. If you can access your bank accounts on-line, this is especially
useful, as most banks and credit card companies support one of the following
import methods. You will spend less time entering data and more time analyzing
results.

o Quicken Import File (QIF): Import Quicken QIF style files, a popular file
format with many commercial personal finance software packages.

o Open Financial Exchange (OFX): GnuCash is the first free software
application to support the Open Financial Exchange protocol. Many financial
institutions are moving towards this format.

o Home Banking Computer Interface (HBCI): GnuCash is the first free
software application to support the German Home Banking Computer
Interface protocol. This protocol includes statement download, initiates bank
transfers, and makes direct debits possible.

e Reports: GnuCash comes with over 30 prebuilt reports, including Account
Summary, Income, Expenses, Transaction Report, Balance Sheet, Profit&Loss,
Portfolio Valuation, and many others. Reports support graphical views of the
data, including pie charts, bar charts, and scatter plots. The reports can be
exported to HTML files, and are easily customized.

e Scheduled Transactions: GnuCash now has the ability to automatically create
and enter transactions, or remind you when these transactions are due, giving
you the choice of entering, postponing or removing the automated transaction.

e Mortgage and Loan Repayment Druid: Used to set up a variable payment loan
scheduled transaction.

e FEasy Account Reconciliation: Integrated reconciliation makes reconciling your
GnuCash accounts with statements simple and effective.

o Multi-platform Compatibility: GnuCash is supported on a variety of platforms
and operating systems. The list of fully supported operating systems (and
platforms) for GnuCash v2.0.x is: GNU/Linux (x86, Sparc, PPC), FreeBSD (x86),
OpenBSD (x86), Solaris (Sparc), and MacOS X (PPC). Previous versions of
GnuCash have been known to work with, SGI IRIX (MIPS), IBM AIX 4.1.5
(RS/6000), Unixware 7 (Intel), and SCO OpenServer 5.0.4 (Intel), but their
current status is unknown.

Tracks Your Investments
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GnuCash has a number of investment features. From simple certificates of deposit,
to publicly traded stocks, GnuCash will track all your investments.

e Stock/Mutual Fund Portfolios: Track stocks individually (one per account) or in a
portfolio of accounts (a group of accounts that can be displayed together).

e On-line Stock and Mutual Fund Quotes: With GnuCash, you no longer need look
up your stock values one at a time. The process can be automated, to always
present you with the latest value of your stocks.

International Support

GnuCash is truly an application that works with and understands users from all
around the world. There are many built-in features to facilitate interaction with the
international world we live in today.

e Native Languages: GnuCash has been fully translated into 12 languages:
Chinese, Czech, Dutch, English, French, German, Italian, Portuguese, Russian,
Slovak, Spanish and Swedish. More than 13 other languages are partially
supported.

e Multiple Currencies and Currency Trading: Multiple currencies are supported
and can be bought and sold (traded). Currency movements between accounts are
fully balanced when double-entry is enabled.

o International Date Handling: GnuCash understands that different countries
display the date differently. You are able to work with the date format you are
accustomed to.

e On-line exchange rates: With GnuCash, you no longer need look up your
exchange rates one at a time. The process can be automated, to always present
you with the account values converted to your preferred currency using the
latest exchange rates.

Business Support

GnuCash has many features to support the needs of the business accounting
community.

o Accounts Receivable/Payable: GnuCash has an integrated Accounts Receivable
and Accounts Payable system. You can track Customers, Vendors, Invoicing and
Bill Payment, and use different Tax and Billing Terms in a small business.

e Depreciation: GnuCash can track depreciation of capital assets.

e Reports: GnuCash offers a wide variety of ready-to-use business reports.
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Accounting Features

For those knowledgeable in accounting, here is a list of GnuCash's accounting
features.

e Double Entry: Every transaction must debit one account and credit others by an
equal amount. This ensures the "books balance" - that the difference between
income and expense exactly equals the sum of all bank, cash, stock and other
assets.

e Split Transactions: A single transaction can be split into several pieces to record
taxes, fees, and other compound entries.

e Chart of Accounts: A master account can have a hierarchy of detail accounts
underneath it. This allows similar account types such as Cash, Bank, or Stock to
be grouped into a master account such as “Assets”.

e General Ledger: One register window can display multiple accounts at the same
time. This eases the trouble of tracking down typing/entry errors. It also
provides a convenient way of viewing a portfolio of many stocks, by showing all
transactions in that portfolio.

e Income/Expense Account Types (Categories): These categorize your cash flow
and, when used properly with the double-entry feature, will provide an accurate
Profit&Loss statement.

What's New in v2.0

e Gnome 2.0 (Gtk2)

GnuCash is now using the latest tool-kits from gtk, and follows the normal
Gnome?2 HIG standards.

e UTF-8 support

GnuCash now stores and reads each country's special character sets by using
UTF-8.

e Budget

GnuCash now comes with a budget feature that can help you keep your expenses
under control.

e Import of MT940 files

Data files with transactions in MT940 format (as can be downloaded from some
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banks) can now be imported into GnuCash.
* Bug fixes

GnuCash is now more stable and secure than ever before due to the long testing
phase before we reached 2.0, as well as using more stable and mature libraries
(gtk2 for instance). Numerous corrections has been made in every part of
GnuCash, and too many for us to highlight any special area.

About this Book

This manual's goal is to save you time. It will get you started using GnuCash as
quickly as possible.

Each chapter follows a simple format. A chapter begins with a “Concepts” discussion
which introduces general themes and terminology, addressed and used within that
chapter. “How-To” sections, which address specific procedures follow. Finally, a
“Putting It All Together” section ends the chapter by giving detailed, concrete
examples.

Beginning users will find the “Concepts” sections very helpful. They provide a
reference for good ways to track your finances, and serve as a general introduction
to financial background and terminology. Experienced users can flip to the “How-To”
sections to quickly scan procedures. These sections provide to-the-point steps for
accomplishing specific tasks. The “Putting It All Together” sections present
real-world examples in the form of a tutorial. Beginning with creation of a file in
Chapter 2, The Basics, each successive chapter builds on the previous chapter's
tutorial.

This manual is organized into 3 main parts:

e Getting Started

e Managing Your Personal Finances

e Managing Your Business Finances.
Getting Started provides you with the most basic information needed to begin using
GnuCash. Use this part as a quick-start guide. Its chapters will get you up and
running:

e Chapter 1, Overview

e Chapter 2, The Basics

o Chapter 3, Accounts
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e Chapter 4, Transactions

Managing Your Personal Finances addresses common applications and features of
GnuCash in greater detail. You will see more specific cases, based on frequently
asked questions about applying GnuCash to everyday situations. Here are the
applications and features covered in this part:

e Chapter 5, Checkbook

e Chapter 6, Credit Cards

e Chapter 7, Loans

o Chapter 8, Investments

e Chapter 9, Capital Gains

e Chapter 10, Multiple Currencies

Managing Your Business Finances discusses the use of GnuCash in business
accounting:

e Chapter 11, Depreciation

o Chapter 12, Accounts Receivable
o Chapter 13, Accounts Payable

e Chapter 14, Payroll

This manual also has an appendix, which contains extra information you might want
to know:

e Appendix A, Migration Guide - Guide for former Quicken®, MS Money or other
QIF users

o Appendix B, Frequently Asked Questions

o Appendix C, Contributed Account Trees

o Appendix D, Auxiliary File Formats

e Appendix E, GNU Free Documentation License

Last, but not least, a glossary and index help you quickly locate topics.

Top Ten Reasons to Use GnuCash

18 de 273



We've already discussed some of the general advantages of using GnuCash. Here are
some specific features offered by GnuCash that may not exist in other programs.

1.

Simple user interface

GnuCash is as easy to use as a checkbook register. It's simpler than a paper
register, because auto-completion and other entry shortcuts not only do work for
you, but reduce data entry errors.

. Easy import

GnuCash allows you to import data from on-line bank statements and software
packages using QIF (Quicken® Interchange Format), OFX and HBCI files. An
easy-to-use “druid” walks you through reviewing resulting changes and actually
importing them into GnuCash.

. Statement reconciliation

Reconcile monthly statements quickly by entering the statement ending balance
and checking off transactions. GnuCash helps you catch any discrepancies
between your data and statements you receive.

. Investment tracking

GnuCash offers a host of ways to track your investment portfolio. Special
investment accounts simplify data entry, and on-line tools allow you to update
prices of your holdings as the markets change. Reports complete the picture,
allowing you to analyze your investment decisions.

. Multiple currency support

GnuCash allows you to track multiple currencies. If you have bank accounts,
investments or other financial data in different currencies, use GnuCash to
monitor them.

. Customized reports and graphs

Reports and graphs give you valuable information for filing taxes, budgeting, or
simply figuring out where your money goes. GnuCash offers a variety of
easy-to-use reports and graphs to help analyze your financial position. It gives
you the freedom to customize your own reports to suit your unique needs.

. Double entry

To provide complete records, GnuCash uses the double entry method of
bookkeeping. Double entry simply means that money doesn't just appear or
disappear - an equal amount must come from one location and go to another
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location. By tracking the transaction in both locations, GnuCash will give you
detailed reports from the perspective of either account.

8. Sources of help

A Tip of the Day dialog gives helpful tips to new users about GnuCash features.
Within the program, a searchable Help menu guides you to information or
connects to the GnuCash web page for further assistance. GnuCash also has
strong, helpful developer and user communities who provide help through
mailing lists as well as through the IRC channel.

9. Shortcuts

GnuCash offers many shortcuts to help you enter data. Type the first few
characters of a common entry and GnuCash will automatically fill in the rest!
You can also use copy, paste and duplicate functions to save typing time.
Keyboard shortcuts let you quickly choose a menu option or to enter numerical
data. Many numeric entry fields can act as a calculator: enter "92.18+33.26"
and watch GnuCash input the corresponding sum for you!

10. Open source

GnuCash doesn't hide its methods. If you wonder how GnuCash computed a
number, you can find it out. In addition, you can set preferences that tell
GnuCash how much information to display to you. There is no “secret code” used
in GnuCash - it continues to be an open-source program.

These are only a few of the advantages you'll discover when you start using GnuCash
to track your financial information. Now get ready to enjoy the benefits of GnuCash
for yourself!

Installation

Installation of GnuCash can be simple, as most modern linux distributions come with
GnuCash precompiled and ready to go. In fact, most likely, GnuCash is already
installed. If you do not have GnuCash installed, the simplest method for installing it
is to insert the installation CD that came with your distribution and follow the
instructions.

The GnuCash home page contains detailed instructions on how to install GnuCash in

the event your current distribution does not include it or you want to install a
different version. You can also read the README file in the source code.

Chapter 2. The Basics
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This chapter will introduce some of the basics of using GnuCash. It is recommended
that you read through this chapter, before starting to do any real work with
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GnuCash. The chapters which follow this will begin to show you hands on examples.

Accounting Concepts

GnuCash is easy enough to use that you do not have to have a complete
understanding of accounting principles to find it useful. However, you will find that
some basic accounting knowledge will prove to be invaluable as GnuCash was
designed using these principles as a template. It is highly recommended that you
understand this section of the guide before proceeding.

The 5 Basic Accounts

Basic accounting rules group all finance related things into 5 fundamental types of
“accounts”. That is, everything that accounting deals with can be placed into one of
these 5 accounts:

o Assets - things you own.

o Liabilities - things you owe.

o Equity - overall net worth.

e Income - increases the value of your accounts.

» Expenses - decreases the value of your accounts.

It is clear that it is possible to categorize your financial world into these 5 groups.
For example, the cash in your bank account is an asset, your mortgage is a liability,
your paycheck is income, and the cost of dinner last night is an expense.

The Accounting Equation

With the 5 basic accounts defined, what is the relationship between them? How does
one type of account affect the others? Firstly, equity is defined by assets and
liability. That is, your net worth is calculated by subtracting your liabilities from
your assets:

Assets - Liabilities = Equity

Furthermore, you can increase your equity through income, and decrease equity
through expenses. This makes sense of course, when you receive a paycheck you
become "richer" and when you pay for dinner you become "poorer". This is
expressed mathematically in what is known as the Accounting Equation:

Assets - Liabilities = Equity + (Income - Expenses)
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This equation must always be balanced, a condition that can only be satisfied if you
enter values to multiple accounts. For example: if you receive money in the form of
income you must see an equal increase in your assets. As another example, you
could have an increase in assets if you have a parallel increase in liabilities.

Equity

(Assets — Liabilities)

Income Expenses
—_— Qawﬂww m._mg_ammu —_—

Positive Value Negative Value

A graphical view of the relationship between the 5 basic accounts. Net worth
(equity) increases through income and decreases through expenses. The arrows
represent the movement of value.

Double Entry

The accounting equation is the very heart of a double entry accounting system. For
every change in value of one account in the Accounting Equation, there must be a
balancing change in another. This concept is known as the Principle of Balance, and
is of fundamental importance for understanding GnuCash and other double entry
accounting systems. When you work with GnuCash, you will always be concerned
with at least 2 accounts, to keep the Accounting Equation balanced.

Double entry accounting serves two purposes. The first is to create an accounting
trail, money always has to come from somewhere and go to somewhere.
Additionally, double entry accounting historically served to double check the math of
an accountant. Because the numbers are entered into multiple accounts
simultaneously, there are multiple places to check to make sure the totals match. Of
course, with the advent of computers, the chances of a mathematical problem are
low, but it is good to know that the concept still exists!

Double entry accounting has been around since the late 15th century, when it was
described by an Italian friar, Luca Pacioli. Traditional double entry accounting
involves recording each transaction in a book called a ledger, then copying each
part of the transaction to separate books called journals. This method is still used in
businesses today as a way to avoid entry errors and to track the source of those
errors. GnuCash simplifies this traditional accounting by copying part of each
transaction for you, so it may not catch some of the entry errors that would show up
in traditional accounting. But it will flag transactions that are not balanced, and it
will let you know when an account name is missing.

Note
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Calling this double-entry bookkeeping is a bit misleading; it would be
somewhat more accurate to call it multiple- entry bookkeeping, since a
transaction can affect more than two accounts. Unfortunately, there's 700
years of history of use of the term, which sufficiently discourages changing
it.

Data Entry Concepts

When entering data in GnuCash, you should be aware of the 3 levels of organization
in which GnuCash divides your data: files, accounts and transactions. These levels
are presented in their order of complexity, one file contains many accounts and one
account contains many transactions. This division is fundamental to understanding
how to use GnuCash.

Files, Accounts and Transactions

GnuCash uses files for storing information. GnuCash provides three types of files:
data files, backup files, and log files. The main file that you will use to store your
data is a data file. You will probably have only one data file that you use for your
home data, but GnuCash will automatically save a backup copy for you each time
you save that data file. GnuCash also provides log files which can be used to help
reconstruct data. Backup and log files are described later in this chapter.

An account is a place for keeping track of what you own, owe, spend or receive.
Although you only have one main data file, that file will contain many accounts. You
probably already think of money you own or owe as being in an account. For
example, at some point you opened checking and savings accounts at a particular
bank, and that bank sends you monthly statements showing how much money you
own in these accounts. Credit card accounts also send you statements showing what
you owe to a credit card company, and the mortgage company may send you
periodic statements showing how much you still owe on your loan.

In GnuCash, accounts are also used to categorize money you receive or spend, even
though these are not physical accounts that receive statements. As we will cover
more in Chapter 3, Accounts, income type accounts are used to categorize money
received (like a paycheck), and expense type accounts are used to categorize money
spent (for pizza, to pay a bill, etc.) These accounts function much like categories in
some other financial programs, with a few advantages discussed in Chapter 3,
Accounts.

A transaction represents the movement of money from one account to another
account. Whenever you spend or receive money, or transfer money between
accounts, that is a transaction. In GnuCash, as we will see in the next section,
transactions always involve at least two accounts. Examples of transactions are:

24 de 273



paying a bill, transferring money from savings to checking, buying a pizza,
withdrawing money, and depositing a paycheck. Chapter 4, Transactions goes more
in depth on how to enter transactions in GnuCash.

Double Entry

You've probably heard the saying, “Money doesn't grow on trees”. It means that
money must come from somewhere - it doesn't just “appear”. Double entry
accounting is a method of record-keeping that lets you track just where your money
comes from and where it goes. Using double entry means that money is never gained
nor lost - an equal amount is always transferred from one place to another. When
you withdraw cash, you are transferring money from your bank account to your
wallet. When you write a check to the grocery store, you are transferring money
from your checking account to the grocery store. And when you deposit a paycheck,
you are transferring money from your source of income to your bank account.

In GnuCash, these transfers are known as transactions, and each transaction
requires at least two accounts. To enter the cash withdrawal, for example, you
would enter a transfer of money from a bank account to a cash account. You would
record the grocery check as a transfer from a checking account to a groceries
expense account. And the paycheck deposit is recorded as a transfer from an income
account to a bank account.

Unlike traditional accounting packages, GnuCash makes it very easy to enter your
double entry transactions. Chapter 4, Transactions gives more detail on entering
transactions, but for now let's take a general look at how they work. For a basic
transaction like writing a check, you first create two accounts: a checking account
and an account for the expense. For example, if you write a check to pay for
groceries, then you need both a checking account and a groceries account. (See
Chapter 3, Accounts for more detail on creating accounts.) To record the check, you
simply enter a transaction to transfer money from the checking account to the
groceries account. In this example, the GnuCash transactions look like this when
viewed from the register windows of the checking account:

1 =na file> - Checking Account —lax
File Edt \iew Wapsaction Actions Business Reports Tols Windows Help
=] % s =] + X 3 = -
Save  Close  Duplicate Delete Enter  Cancel glank  Spit  jump
| i Accounts @l Checking Account
Hure | Description’ Tanster R [Deposit |withdrawal |Balance | =
Opening Balance Equity:Opening EBalances | n | 1.000.00 1,000.00

Grocery Store Expenses Groceries | n 50.00| 95000

n -
Present:USD 850,00 Fulure LISD 850,00 Cleared USD 0.00 Reconcied USD 0.00 Projected Minimurm USD §50.00
Thursday 12 January 2006

This image shows entering the date, description and transfer account for a payment
of $50 to the Grocery Store.
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In this transaction, a check is written to Grocery Store for $50. Since this is a double
entry transaction, at least two accounts are affected and must be part of the
transaction. GnuCash automatically enters the current account name
(Assets:Checking Account) for you so you only enter the other account name affected
(Expenses:Groceries).

To emphasize that GnuCash stores everything as double entry transactions, we
change the view to Transaction Journal and see how it looks.

<no file> - Checking Account
Ele Edt Mew TWapsaction Actions Business Beporis Bols windows Help
B x ol | + X - bt v
save  Close  Duplicate  Delete Enter  Cancel Blank Jumg
| Accounts| @ Checking Account
[Date__ [Wun [Description [ [Tot Diepos [ Tot ithdra | Balance | =
010106 | [opening Balance | | | rooco.eo| | 100000]
Assets:Current AssetsiCheck | n | 1,000.00
" Equity:Opening Balances n 1.000 00
120106 | Grocery Stere [ L | sawo] ssous]
Expanses:Groceries n 50.00
Assets:Current Assets Check | n 50,00
EEE [ I [ 1 I [ [~
Prasent:USD 950.00 Future:USD 550,00 Cleared: USD 0.00 Reconcled:USD 0.00 Projectad Minimurm: USD 950.00
Thursday 12 january 2006

This image shows the Transaction Journal of the Checking Account

Observe that we have one entry for depositing (debiting) the Expense:Groceries
account, and one entry for withdrawing (crediting) from Assets:Checking Account.

Let's have a quick look to see how this same transaction looks from the
Expense:Groceries account

=ne file> - Groceries

Bls Edt iew Fansaction Actions Business Beports Bols Windows Help
H o x b & + X 2 D =
Save  Close  Duplicate Delete Enter  Cance Blank Jump

| @ Accounts @ Cheeking Account | Groceries

Cate Hum | i [ | ot Expen [ Tot Rebate [Balance | =
| |Grocery stare | [ | sowoo| | so.o]

Expanses:Groceries n 50.00
n 50,00 -

| D
SD 0.00 Projected Minimum: USD 50,00

This image shows the Transaction Journal of the Groceries Account

Note

In this example for double entry accounting we used a checking account to
pay for the groceries. But, notice that concept is the same no matter what
method you use to pay for the groceries. If instead you used a credit card,
the double entry accounting would simply involve your Credit Card account
instead of the Checking account.
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What about your paycheck? You can see that money goes into a bank account, but
where does it come from? In double-entry, the money has to come from somewhere.
Technically, that money comes from your employer, but you don't care about
tracking your employer's accounts. So how do you account for money coming in? In
GnuCash, you create a special income type account to track your incoming
paychecks. (See Chapter 3, Accounts for more information on creating income
accounts.) To record the paychecks, you simply enter a transaction to transfer
money from the income account to a bank account.

Here's what a paycheck deposit looks like in GnuCash.

<no file> » Checking Account -Bx
fle Edt View Tapsaction Actions Husiness feports Bols Mindows Help
= x =1 + X 2 = ) @ .
Save  Close @ Delata Erter  Cancel alank Spit Jump  Schaduls
@ Accounts @ Checking Account
[T Murr | Description [Fansfer W _[Deposit_[withdrawal [Balance ||~
0LOLDE Opaning Balance | Balancas | n [ 1o00.00] 1,000.00
120106 Gracery Stara Expenses:Grocanias | n 50.00]  950.00
25101085 Employers RUs | IncameSalary | n | #00.00 | 1.550.60
= _ | coe] !
Prasent; USD 1,550.00 Future:USD 1,550.00 Clearsd:USD 0.00 Reconciled:USD 0.00 Projacted Minimum; USD 1,580.00
Wwadnesday 25 january 200

This image shows entering the date, description and transfer account for a $600
Salary payment from Employers R Us.

In this example, $600 is transferred from a Salary income account to the Checking
Account. Because of the special nature of income accounts, discussed in Chapter 3,
Accounts, this transaction increases both the checking account balance and the
income account balance by the amount transferred.

So what if you want to record your gross pay and all the deductions that come out of
your check as well? You enter a transaction with multiple splits, which we will cover
in the section called “Split Transaction”. In this type of transaction, you are
transferring a sum of money from one location to several locations. For any double
entry transaction, the total amount of money transferred from accounts must equal
the total amount transferred to other accounts.

For example, your gross pay might be $1000, but only $655 of that gets deposited in
your checking account. The remaining $345 is split between your deductions, such as
federal taxes, FICA and state taxes. How do you account for this in GnuCash? First,
you should have accounts set up for the gross income (salary), checking, and each of
the deductions (See Chapter 3, Accounts). Then you enter a transaction to transfer
$1000 from the Salary account to the other accounts: Checking Account, Federal,
Medicare, Social Security and State/Province. Because this is a double entry
transaction, the total amount transferred to these five accounts must equal the
original $1000 total coming from the income account. We cover this type of
transaction in more detail in Chapter 4, Transactions, but for now here's a peek at
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what it looks like:

=no file> - Salary

Gl Edt Mew Tapsaction Actions Business Beports bals Windows Help

[= B @ + X 2 0 @ =

save  Clse @ Deleta Erter  Cancel 8lank St | ump  schedule

f Accounts | Checking Account i Salary
[Bate [Hurr [ Description T [ot tharg [t Income [Balance | |~
250106 | Employers R Us Jznt AssetsiChecking Account [ n | | coooa| s00.00]
[zsiams| E | 1 | 1.000.00] 1.600.00]
Aer Tax AsSeLs CuTEnt Assets Check 55.00
Federal Tax Expenses TaxesiFader: 125.00
Social Security Expenses Taxes:Social Secur 50.00
State Tax Expenses TesiState/Pravn 75.00
Medicars Expenses-Taxes:Medicars 55.00
Salary Income:Salary 1.000.00

alalal=lala

:a:.hr.vc.anan:E:ﬁcw:m.nnn...r“:aﬂcmc...uux:ozn:aLwnaS_ua_nn.zs_.icaucwc_ouu.nn

Employers & Us

This image shows entering the date, description and transfer account for a $1000
Salary payment from Employers R Us . This is then made into a split transaction to
Checking Account, Federal , Medicare, Social Security and State/Province.

The main principle to remember is that there are at least two parts to every
transaction, and the total amount transferred from a set of accounts must equal the
total amount transferred to another set of accounts. When a transaction transfers an
equal sum from accounts to other accounts, that transaction is said to be in balance.
In GnuCash, as in double-entry accounting, you want to have all of your transactions
in balance.

Why is this important to you? If all of your transactions are in balance, then your
money is all accounted for. GnuCash has a record of where that money came from
and where it was used. By storing the names of all accounts involved in each
transaction, you provide data that can be sorted and viewed in report form later.
Reports allow you to see things like how much money you made for the year and
where it all went, what your net worth is, and what your taxes might be for the year.
The more information you provide when entering transactions, the more detailed
your reports will be.

Accounting Terminology

Accountants use the terms debit and credit to describe whether money is
being transferred to or from an account. Money is recorded in the debit
column, which is always the left column, when it is being transferred to an
account. Money is recorded in the credit column, which is always the right
column, when it is being transferred from an account. Money always flows
from the right column of one account to the left column of another
account.

The main rule of accounting is this: For every transaction, total debits
must equal total credits. This is just another way of repeating the double

28 de 273



entry rule, that for each transaction, the amount of money transferred
from accounts must equal the amount transferred to other accounts

You don't have to use the terms debit and credit to use GnuCash, however.
GnuCash account registers default to common column headings such as
deposit and withdrawal - if you are more comfortable with those headings,
use them. If you prefer the credit and debit headings, you can change the
column headings to use accounting labels from the menu item Edit ->
Preferences General (see the section called “Setting Preferences” for more
detail on setting preferences).

The GnuCash Interface

The very first time you open GnuCash, you will see the Welcome to GnuCash! dialog.

From there, GnuCash provides other tools to help you easily find what you are
looking for. Let's take a look at some of the common screens and dialog boxes you
will see.

Create a new set of accounts

The New Account Hierarchy Setup druid allows you to create several accounts at
once. When you open GnuCash the first time, you will get this dialog:

New Account Hierarchy Setup

New Account Hierarchy Setup

This druid will help you create a set of GnuCash accounts

far your assets (such as investments, checking or savings
accounts), liabilities (such as loans) and different kinds of
income and expenses you might have.

Click 'Cancel' if you do not wish to create any new accounts
now.

X Cancel |

| & Forward |
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This image shows the first screen of the New Account Hierarchy Setup Druid.

Click Next and follow the instructions provided in the dialog. The dialog provides a
default set of accounts with predefined account types, and you simply select the
accounts you want. For more information on account types, see the section called
“GnuCash Accounts”.

] New Account Hierarchy Setup

Choose Currency
Please choose the currency to use for new accounts.
usD (US Dollar) s
X cancel , 4@ Back 7 | & Forward |

This image shows the second screen of the New Account Hierarchy Setup Druid
where you select the currency.

The currency you select here, will be assigned to all the accounts created in this
druid.
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duad ciszosns Hllosaising Sty In this dialog you will be able to set an Opening Balance on each of the accounts, as
Choose accounts to create well as indicate if it the account should be a Placeholder (only sub-accounts allowed,
no transactions. Like Current Assets in above image)

Select categories that correspond to the ways that you
will use GnuCash, Each categery you select will cause

several accounts to be created. Select the categories
that are relevant to you. You can always create
additional accounts by hand later.

New Account Hierarchy Setup

Finish Account Setup

Categories Accounts in 'Common Accounts'
Selected | Account Types v = o @assets =
[]  childcare Expenses it Current Assets L
/| Common Accounts @t Cash in wallet
[Tl Education Loan = 8 Checking Account
F— ] D Sawvings Account
i Selact Al Clear Al Press *Apply' to create your new accounts.
= fm Equity
Category Description it Opening Balances Press *Back' to review your selections.
Most users will want to select this set of  [+] ~ ft Expenses Press " Cancel' to close this dialogue without creating any new
accounts. It includes most commonly it Adjustmant 10 accounts.
used accounts (checking, savinas, cash, [~ - =)

X cancel _ [ 4@ Back _ — Gmn_imi_

This image shows the third screen of the New Account Hierarchy Setup Druid where
you choose the various accounts.

| X concel | | qagack | [ v avely |

Select one or more of the predefined account-groups here. For more information on
account types, see the section called “GnuCash Accounts”. This image shows the Last screen of the New Account Hierarchy Setup Druid.

New Account Hierarchy Setup Click Apply to create all the accounts and leave the druid.
Setup new accounts

If you intend to import your data from another program and you want to keep the

If you would like an account to have an opening balance, click . .

e e e e e same account names you used in that program, you may want to delay setting up
palscas cElimi anc ten entar e s s g oalance N default accounts at this time. You can simply import the data and the account names
accounts except Equity and placeholder accounts may have an N . ” . | ”

opening balance. into GnuCash from the other program (the section called “Importing QIF Files

If you would like an account to be a placehelder account, just QNHL.NHSM how to do Hrmwv.

click the checkbox for that account.

Tip of the Day

Account Name ~  Type Placeholder Opening Balance u
= fill Assets Asset
= i Current Assets Asset
i CashinWallet  Cash
i Checking Accou Bank
@i Savings Accoun Bank
= fm Equity Equity

GnuCash provides a Tip of the Day dialog to give helpful hints for using the program:

|EO000& A

A

¥ | [ @eee | (B

This image shows the fourth screen of the New Account Hierarchy Setup Druid
where you can set Opening Balance.
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GnuCash Tip Of The Day

Tip of the Day:

The GnuCash developers are easy to contact. As
well as several mailing lists, you can chat to them
live on IRC! Join them on #gnucash at

irc.gneme.org

<@ Back _ _ mvmog_ma__ _ X Close _

This image shows the Tip of the Day.

These tips provide useful information for beginning users. To view more of the tips,
click Next to continue. If you do not wish to see this dialog box on start-up, deselect
the box next to Show tips at startup. When you have finished viewing the helpful tips,
click Close to close the Tip dialog.

Account Tree Window
You should now see the Accounts window, which appears as shown below. The exact
layout of the account tree will depend on which default accounts you selected during

the New Account Hierarchy Setup. In this example, the "Common Accounts" are
shown.
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1 =no file> - Accounts

File Edit Mew Actions Business Reports Tools Windows Help

= W @

Save Open  Edit New Delete
il Accounts
Account Name ¥  Type Commodity Total 3
| - & Assets uUSDollar  USD 0,00
= @ Current Assets Asset  US Dollar uUsD 0,00
@ Cash in Wallet Cash US Dollar USD 0.00
fm Checking Account Bank Us Dollar USD 0.00
fit Savings Account  Bank Us Dollar USD 0.00
I @ Equity Equity  US Dollar USD 0.00
P fi® Expenses Expense US Dollar UsD 0.00
b @ Income Income  US Dollar USD 0.00
P #m Liabilities Liability US Dollar UsD 0.00
%, grand total: Assets: $0.00 Profits: $0.00 H

This image shows the Accounts window.

The Account Tree window provides an overview of the data contained in the current
file. It contains a list of account names and their current balances. From this
window, you can open any of the accounts. The individual account windows are
called account registers. GnuCash allows you to have as many account registers
open as you wish.

At the top of this window is the title bar, which displays the file name (once you have
saved the file.) Below that is the menu bar. You can access the menu options by
either clicking on these menu headings or by using shortcuts and access key
combinations, covered later in this chapter. Next is the tool bar, which contains
buttons for the most common functions.

The account tree appears below the tool bar. Once you have started creating
accounts, the account names will appear in the account tree. You can customize
which headings show up by using the small down-arrow at the far right just above the
account tree.

At the bottom is the status bar, which tells you information about what you own (Net
Assets) and how much money you have made (Profits).

Account Register Window

The Account Register windows are used to enter and edit your account data. As the
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name suggests, they look similar to a checkbook register. When you double-click an
account name in the Accounts window, the Register window for that account will

open.

geashdata_6 - Checking
Ela Edt Mew Tapsaction Actions Business Beponts Bols Windaws Help

8 =x [ + X 3 =L -
Save  Clo Duplicate  Dalste Ever  Cancel Blank  Spit  Jump  Scheduls

i Accounts |t Checking

[Date Hum [ Description [Transfer Deposit | Withdrawal [Balance |«
0603106 Transfere Money | Assets Savngs 100.00 675,79
06/03/08 | 106 _| ABE Hardware tion 10000| 57878
14/03/08 Employers R Us | — Splk Transaction -~ 570.00 134878 |

24003008 Transfar Monay > auings 500.00 174878
2500306 ATM Withdrawal | Assetsicash
Intemet Subscription

Light Company |
Phane Company

a2 f< e« << [<[< <[~ < =

Fartial Payment of \isa Bill

75 Future:USD 50178 Cleared: USD 145178 Aeconciled: USD 145178 Projected Minimum-LiSD 501,78

This image shows The Checking Account - Register with several transactions.

Chapter 4, Transactions explains more about account register windows and how to
enter data into them. For now, note that the parts of an account register window are
similar to the parts of the account tree window described earlier. The title bar at
the top contains the account name. Below that, the menu bar contains menu options
related to the account register. Tool bar buttons simplify common data entry
functions. The status bar at the bottom of the window, displays some account
balances covered in Chapter 4, Transactions. At the bottom of the account register
window, information appears about the current location of the cursor.

You can resize the various columns that GnuCash displays, but keep in mind that the
description column will automatically expand to fill all unused space. Therefore you
should increase the size of all your other columns first and then decrease the size of
the description column.

Tool Bar Buttons

Both the account tree window and the account register window contain tool bar
buttons. These buttons provide quick access to common functions such as Save and
Open in the account tree window and Record and Delete in the account register
window. If you are not sure what a button does, move the mouse pointer over that
button, and you should see a description of the function appear.

Here is a summary of the account tree window buttons:
» Save - Use this function often to save the current file to disk.

o Close - Use this function to close the current notebook page.
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« Open, Edit, New and Delete - These are functions related to accounts. They are
discussed in Chapter 3, Accounts.

Register buttons are discussed in Chapter 4, Transactions.
Menu Items

The account tree window and the account register window both contain menu
headings in a menu bar. Clicking on a menu heading brings up the menu items for
that heading.

You can click on the account tree menu headings and then move the mouse pointer
over the menu items to see what they do. As the pointer moves over a menu item, a
description of the item appears in the lower left-hand corner of the window. To
select a menu item, click on it.

You can also access the most common menu items in a window by right-clicking the
mouse anywhere in that window. In the account tree window, this will bring up a list
of account items. In the account register window, this will bring up a list of
transaction items.

Other ways of accessing menu items are through keyboard shortcuts and access
keys, described next.

Menu Shortcuts

All of the menu items have access keys which are marked by underlined characters
in the menu names. Pressing the Alt key with the underlined character in the menu
heading will bring up the menu items for that heading. Once the menu items are
displayed, type the underlined character in the menu item to activate it. For
example, typing Alt+F in the main window brings up the File menu, then typing S
will save the file. Access keys are fixed and may not be changed by users.

Some of the more commonly used menu items also have shortcut keys that directly
activate the command without having to traverse the menu structure. These
shortcuts typically use the Ctrl key, although they can use any key combination.
Menu shortcuts are displayed at the end of each menu item. These shortcuts may be
edited by users by setting a preference in the "Menu and Toolbar" preference panel.

GnuCash, as a Gnome application, also allows you to define your own menu
shortcuts. To define a shortcut, first go to the "Menu and Toolbar" preference panel
and select the "Editable menu accelerators" check box. Then return to GnuCash,
click on the menu header and move the mouse pointer over the menu item. While
the menu item is highlighted, press a key or key combination to set the shortcut.
You should now see your shortcut choice next to the item in the menu. To delete a
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shortcut, press the Delete key while the menu item is highlighted. Be careful when
setting shortcuts as Gnome does no checking on the key values pressed, and you can
easily do things like set a letter of the alphabet as your shortcut.

Setting Preferences

GnuCash allows you to customize your session by setting several preference options.
From the menu select Edit -> Preferences, then make your desired changes using
the list of items shown on the left. The changes you made will be applied directly. To
close the preference window press the Close button.

Accounts

In Accounts, you will see the default settings shown here:

GnuCash Preferences

Accounts Separator Character
Business Character: colon

Sample: Income:Salary:Taxable
DatefTime £ e
General Reverse Balanced accounts

Income & Expense
® Credit Accounts
None

online Banking
Register

Register Defaults
Labels

MpaE Use formal accounting labels

Accounting Period
Default Currency

Scheduad ape s oS Locale: AUD (Australian Dollar)

Windows

# Choose:] | usp (s Dollar) :

| X close

e |

This image shows The Preferences - Accounts

e Separator Character - The account separator is the character that separates a
parent account from its sub-account, for example Utilities:Electric. The default
is a :(Colon), but you can also select /(Slash), \(Backslash), -(Dash) or .(Period),
or any single non alphanumeric unicode. Parent accounts and sub-accounts are
discussed in the section called “GnuCash Accounts”

* Reverse Balanced accounts - This option lets you determine whether account
balances will display as positive or negative numbers:

o None shows all credit balances as negative and all debit balances as
positive. (See Accounting Terminology note in this chapter for more
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information on debits and credits.)

o Credit Accounts (default) displays a positive balance for account types that
would normally carry a credit balance (income, credit, liability, equity). See
Chapter 3, Accounts for more information on these account types.

o Income & Expense assigns a positive credit balance to income account
balances and a negative debit balance to expense account balances. See
Chapter 3, Accounts for more information on these account types.

o Labels - Select this option if you want column headings to refer to debits and
credits instead of the default informal headings. (See Accounting Terminology
note in this chapter for more information on debits and credits.)

e Default Currency - This item determines which currency will be selected by
default when creating new accounts.

o Locale will use whatever currency is specified in your system.

o Choose will let you specify a specific currency to use, independent of your
system settings.

Business

In Business, you will see the default settings shown here:

GnuCash Preferences

Accounts Invoices

Business Open in a new window

+| peeumnulate splits on post Number ofrows: |10

DatefTime -
| Bax Included
General
online Banking Bills
7 -
Register +| Notify when due Rays in advance: |7 =

% +| Tax Included?
Register Defaults

Reports

Accounting Period

Sehadulad Transactions

Windows

| X close

Bueh |

This image shows The Preferences - Business

e Open in a new window - If checked, each invoice will be opened in its own top
level window. If clear, the invoice will be opened in the current window.
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e Accumulate splits on post - Whether multiple entries in an invoice which transfer
to the same account should be accumulated into a single split by default.

o Number of rows - Default number of register rows to display in invoices.

e Tax Included (Invoices) - Whether tax are included by default in entries on
invoices. This setting is inherited by new customers and vendors.

o Notify when due - Lets you set whether you want to be notified of when a bill is
soon to be due.

e Days in advance - How many days in the future to warn about bills coming due.

e Tax Included (Bills) - Whether tax are included by default in entries on bills. This
setting is inherited by new customers and vendors.

Date/Time

In Date/Time, you will see the default settings shown here:

GnuCash Preferences

Accounts Time Format

Business #I|Use 24-hour time format|
Date/rime Date Format
General ® Locale:  31/07/05

us: 07/31/05
online Banking i e

UK 31/07/05
Regleay Europe:  3107.05

Register Defaults 150: 2005-07-31
Reports
Accounting Period

Scheduled Transactions

Windows

[ % close

Help |

This image shows The Preferences - Date/Time

e Time Format - lets you specify if you want to use 24 or 12 hours time format.
That is if 23:00 should be represented as 11PM or 23.

e Date Format - This item controls the appearance of the date. The available
options are US, UK, Europe, ISO, and Locale. Choosing "Locale" will
automatically determine the date format based on your operating system
settings.
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General

In General, you will see the default settings shown here:

GnuCash Preferences

Ganeral S
| Display "tip of the Day" dislogue
Perform account list setup on new file

Accounts
Businass

ateTim
DetefTime Show close button on notebook tabs
General Enable EURO support

online Banking

Mumbers
Register 7| Display negative amounts in red

Register Defaults Automatic Decimal Point

Reports N Decimal Places: 2
Acecounting Pariod Files

Scheduled Transactions  |v| Comgress files

Windows Retain log files 30 "W days

Search Dialog

New search limit: 1

[ % close

el |

This image shows The Preferences - General

» Display "tip of the Day" - You can turn on or off the option to display the “Tip of
the Day” dialog on start-up.

e Perform account list setup on new file - This option turns off the display of the
New Account Hierarchy Setup druid when File -> New File is selected.

e Show close button on notebook tabs - Adds a small close icon on each tab, to
make it easier to close the various tabs.

e Enable Euro support - If selected, enables support for the European Union EURO
currency. Needed if you have any accounts with EURO currency.

o Display negative amounts in red - If you turn off this option, GnuCash will display
negative numbers in black.

e Automatic Decimal Point - This option will automatically insert a decimal point
into numbers you type in.

o Decimal Places - This option allows you to set the number of decimal places to
be used.

e Compress files - This option determines whether the GnuCash data file will be
compressed or not.

40 de 273



» Retain log files - This option deletes log files (and backup files) after the number
of days set here.

e New search limit - Defaults to 'new search' if fewer than this number of items is
returned.

On-line Banking

In Online banking, you will see the default settings shown here:

GnuCash Pre

Accounts QIF Import

Business Show documentation

Date/Time Generic Importer

General Use bayesian matching )

online Banking Match display threshold 1 B

Register Auto-gdd thresheld 3 =
Auto-clear threshold 6 A

Register Defaults

r

Reports Commercial Cash Machine fees threshold | 2.00

Kl

Acecounting Pariod

Schaduled Transactions

Windows

| X close

Buel |

This image shows The Preferences - Online banking

o Show documentation - The first time you use the QIF importer (discussed later
in this chapter), you may notice that the importer has detailed instructions on
how to import a file. Once you have become familiar with using the importer,
you might want to turn off this option. Turning off the option gives you less detail
in the importer dialogs.

« Use Bayesian matching - Use Bayesian algorithms to match new transactions
with existing accounts.

o Match display threshold - The minimal score a potential match must have to be
displayed in the match list.

e Auto-add threshold - A transaction whose best match's score is in the red zone
(above display threshold, but below or equal to Auto-add threshold) will be
added by default.

¢ Auto-clear threshold - A transaction whose best match's score is in the green
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zone (above or equal to Auto-clear threshold) will be cleared by default.

o« Commercial Cash Machine fees threshold - If the ATM machine automatically
adds a small transaction fee, GnuCash will still be able to match it to the
transaction as long as the difference is below this threshold

Register

In Register, you will see the default settings shown here:

GnuCash Pre

Accounts Actions
: 3 ‘Enter’ moves to blank transaction
+| Aute-raise lists

Business
DatefTime

General Reconciling
| Check cleared transactions

online Banking 5
Automatic
Register | Automatic credit card payment
Register Defaults
Graphics
Reports Use systam theme colours

Acecounting Pariod Double mode colours alternate with transactions

Schadliad Fansachas +| Draw harizontal lines between rows
——————  [<] Drawvertical lines between columns
Windows

| X close

Buel |

This image shows The Preferences - Register

« 'Enter' moves to blank transaction - If selected, move to the blank transaction
after the user presses 'enter', otherwise move down on row.

o Auto-raise lists - If selected, all lists will automatically be expanded when input
focus is in the list field.

o Check cleared transactions - If selected, automatically check off cleared
transactions when reconciling.

o Automatic interest transfer - If selected, prior to reconciling an account which
charges or pays interest, prompt the user to enter a transaction for the interest
charge or payment. Currently only enabled for Bank, Credit, Mutual, Asset,
Receivable, Payable, and Liability accounts.

« Automatic credit card payments - If selected, after reconciling a credit card
statement, prompt the user to enter a credit card payment.

e Use system theme colours - If selected, GnuCash will use the system theme

42 de 273



colours instead of the default colours.

« Double mode colors alternate with transactions - If selected, configures the
register window to alternate between the primary and secondary colors with
each transaction, instead of each row.

e Draw horizontal lines between rows - If selected, GnuCash will draw a horizontal
line between each row.

« Draw vertical lines between cells - If selected, GnuCash will draw a vertical line
between the cells in each row.

Register Defaults
The Register Defaults preferences item affects the behavior of the transaction
register windows. More information about the transaction register can be found in

the section called “The Account Register” of this guide.

In Register, you will see the default settings shown here:

GnuCash Preferences

Accounts Default Style
Business ® Basic Ledger
; Auto-split ledger
steTim
Daeilme Transaction journal
General
Other Defaults

online Bankin:
) Register opens in a new window

Register Double Line Mode
Register Defaults Mumber of ransactions: |0 &
Regonts Mmbsrow: [ T2

Accounting Period
Scheduled Transactions

Windows

el | [ % glose

This image shows The Preferences - Register Defaults

e Default Style - you can choose from 3 different styles for register windows, Basic
Ledger (default), Auto-Split Ledger, and Transaction Journal. The basic style is a
standard one-line register where everything appears on a single line. The
auto-split style is similar to the basic style except that the current transaction is
split-expanded. The journal style has every transaction split-expanded.

« Register opens in a new window - If selected, Register will be in a separate
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window instead of in a tab.

e Double Line Mode - If selected, show two lines of information for each
transaction instead of one.

« Number of transactions - How many transactions to show in a register

e Number of rows - How many rows to display when the register is opened.
Reports
The Reports preferences item affects the behavior of the transaction register
windows. More information about the transaction register can be found in the

section called “The Account Register” of this guide.

In Reports, you will see the default settings shown here:

GnuCash Preferences

Accounts Default Report Currency

B Tl Locale: AUD (Australian Dollar)

DatefTime ® Choose: USD (US Dollar) =
General CHeation

online Banking Report opens in @ new window

Register

Register Defaults
Reports
Accounting Period

Scheduled Transactions

Windows

Beh | [ % close

This image shows The Preferences - Reports

o Default Report Currency - This item determines which currency will be used by
default when creating reports. You can choose between Locale which uses
system settings, or Choose which lets you specify your own default report
currency.

e Location - if you select this option, the reports will open up in a new window,
instead of in a tab.

Accounting Period
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In Accounting Period, you will see the default settings shown here:

GnuCash Preferences
Accounts Summarybar Content
Business | lInclude grand total
- +| Include non-currency totals

DatefTime
General Start Date
ERT e ® Relative: | Start of this year +|  ouoyos
Register Absolute: |18/04/06 ~ |
Register Default:

bhaadten 215 End Date
Reports & Relative: | End of this year s 31/12/06
ccauntogEeEie Absolute: |18/04/06 |
Scheduled Transactions
Windows

Beh | [ % close

This image shows The Preferences - Accounting Period

« Include grand total - if this item is selected, GnuCash will include a grand total
on the report.

o Include non-currency totals - if this item is selected, GnuCash will include a total
of non-currency items (for instance number of shares) in the report.

o Start Date - This item determines which from which start date the report will
report from. You can choose between Relative which uses a dynamic start date
(like "start of this year", "start of this month" etc), or Absolute which lets you
specify a specific start date (which will not change as time goes by).

e End Date - This item determines which to which end date the report will report
to. You can choose between Relative which uses a dynamic end date (like "end
of this year", "end of this month" etc), or Absolute which lets you specify a
specific end date (which will not change as time goes by).

Scheduled Transactions
The Scheduled Transactions preferences item affects the behavior of GnuCash for

scheduling transactions. More information about scheduled transactions can be
found in the section called “The Account Register” of this guide.

In Scheduled Transactions, you will see the default settings shown here:
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GnuCash Preferences

Accounts Since Last Run Dialogue

Bun when data file opensd

Business

DatefTime Transaction Editor Defaults
General Auto-create new transactions
online Banking i~
- Create in advance, days 0 days
Lot Rgmind in advance, days: _ﬂ_n days

Register Defaults
Reports
Accounting Pariod

Scheduled Transactions

Windows

Beh | [ % close

This image shows The Preferences - Scheduled Transactions

 Run when data file opened - If selected, the "Since-Last-Run" window will appear
on GnuCash start-up (or rather when GnuCash opens the file).

e Auto-Create new transactions - If selected, new Scheduled Transactions will
automatically be entered into the register. Also, if selected Notify before
transactions are created can be set to allow the user to confirm creating the
transactions.

» Create in advance, days - The default number of days in advance to create new
Scheduled Transactions.

« Remind in advance, days - The default number of days in advance to remind on
new Scheduled Transactions.

Windows

In Windows, you will see the default settings shown here:
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; “GnuCash preferences web site for additional information. You can open any web site under this window by
Accounts Window Geometry clicking the Open tool bar button and then typing in the URL. Use the Back,

Business digevewindew sk amnd hoziion Forward, Reload, Stop, and Print buttons as you would in a standard browser.

DatefTime Toolbar Style

General ® Use system defaul The GnuCash web site contains helpful information about the program and about any
online sanking = H_.“MM_HMW updates to it. It also contains links to the GnuCash mailing lists for developers and
Ragleag Ieons only users, and you can search the archives of GnuCash mailing lists for discussions on a
Regisiaaials Loy particular topic. If you don't find the answers you are looking for, you can post your
H”””.ws.a — question to the GnuCash user list, and someone on the list will attempt to answer
Schaduiad Tansactions you.

Windows

The most updated GnuCash FAQ is also located on the GnuCash FAQ website, and
contains answers to the popular questions.

Bk | (T Topic Search

The online manual also provides a search function. To search for a particular topic,
click the Search tab at the bottom of the help window and type in your topic in the
field provided. Click the Search button to complete your search. A list of choices

should appear in the box below, clicking a choice will bring up its text on the right.

This image shows The Preferences - Windows

e Save window size and position - If selected, next time GnuCash starts it will
re-use the window size and position of the last run.

« Toolbar Style - you can choose from 5 different styles for the toolbar, Use system Gﬂmmﬁmuﬁa and mmé.mﬂ@ Files
default (default), Text below icons, Text beside icons, Icons only, and Text only.

. If you are using GnuCash for the first time, it will automatically open a new file
OQ—.,—..:H@ mm—_u when you begin. Follow these steps to save the file under a new name:

1. Choose File -> Save As... from the menu bar or select the Save toolbar button.

GnuCash offers help in many ways. We have already covered the Tip of the Day GnuCash will bring up this window:

dialog that gives you helpful hints upon start-up of your GnuCash session. GnuCash

also offers an extensive help manual. e
Help Manual Name: [ _

Save in folder: _Um:r_nmmrﬂ__mm

Ll

Once you have opened GnuCash, you will see the Account Tree window Help menu
heading, which opens the on-line manual. The on-line manual is organized by topic,
and you can expand each topic into its subtopics.

Topics are listed on the left side. To select a topic or subtopic, click on it, and you E E

should see the text for that topic appear on the right. Use the Back and Forward
buttons to navigate through your topic choices, and print any text using the Print This image shows the Save dialog.
button.

[> Browse for other folders

2. In the text box below Selection type your chosen file name (e.g. gcashdata).
Web Access
3. Click the OK button to save the file.

The GnuCash Help window also acts as a simple web browser, so you can pull up a
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If you are keeping track of finances for a single household, you need only one file.
But if you are also tracking business finances or want to keep data separate for
some reason, then you will need more than one file. To create a new file:

1. From the main menu, choose File -> New File.
2. Follow the steps above for saving a file under a new name.

Before ending each GnuCash session, be sure to save your data changes using File
-> Save or the Save toolbar button. In fact, it is a good idea to save your data
changes often, since GnuCash does not permanently record your changes until you
save them. To open an existing file, select File -> Open and choose your file from
the list.

GnuCash is storing its data file without any extension. If you name your GnuCash file
to MyBudget, the actual file name will be MyBudget.

Note

Ensure that you do not specify an extension when you specify the file name.
Per the above example, only specify MyBudget as the filename.

Importing QIF Files

Note

This section tells you how to initially import data from other financial
programs that use QIF (Quicken® Interchange Format).

To import data from Quicken®, MS Money, or other programs that use
QIF(Quicken® Interchange Format), you must first export your data to a QIF file.
One way to do this is to export each account as a separate QIF file. An easier way,
available in Quicken® 98 and beyond, is to export all accounts at once into a single
QIF file. Check your program's manual to determine if this option is available.

Once your data is in QIF form, follow the easy 3-step import process described
below. Before you get started, though, please note that part of the import process
involves checking for duplicate transactions, so it is very important that you load all
of your QIF files before importing. Duplicate transactions result when more than one
account is involved. For example, if one of your transactions transferred money from
savings to checking, you would end up with this same transaction recorded twice -
once in the savings account and once in the checking account.

To import QIF files:
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1. Load all of the QIF files containing data you wish to import.

To do this, select File -> Import -> Import QIF... from the menu. When the QIF
Import dialog box appears, click Next and follow the instructions to guide you
through the process of loading your files.

QIF Import

Import QIF files

GnuCash can import financial data from QIF (Quicken
Interchange Format) files written by Quicken/QuickBooks, MS
Meney, Moneydance, and many other programs.

The import pracess has several steps. Your GnuCash accounts
will net be changed until you click *Apply* at the end of the

process.

Click "Forward" to start loading your QIF data, or *Cancel* to
abort the process,

This image shows the start of the QIF Import Druid.

You will be prompted for a filename to load. Use the Select button to select your
QIF file and click Next to load it. Once the file is loaded, select Load another
file if you have more files to load. When you have loaded all your QIF files, click
Next to continue with the import process.

2. Review the GnuCash accounts to be created.

The importer then matches up your QIF accounts and categories with GnuCash
accounts and gives you a brief description of the matching process. Clicking
Next will bring you to a view comparing your QIF accounts with the
corresponding GnuCash accounts created. To change an account name, select
the row containing that account name and edit the name in the dialog box
provided. Click Next when you have finished making changes, and proceed
through a similar category matching process. QIF income and expense
categories import as GnuCash income and expense accounts (see the section
called “Basic Accounting Concepts” for more on this). Make changes to these
account names if necessary, and click Next to continue.

Note

If you are not sure what changes are needed, it is safe to accept the
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GnuCash account names. It is easy to edit the accounts later if you find
you need to make a change.

From the drop-down list, select a standard currency to be used for imported
accounts and click Next to continue. If you have stocks, mutual funds, or other
securities, you will be prompted for additional information. The importer dialog
will ask for the exchange or listing (i.e. NASDAQ), the security's full name, and
the ticker symbol. If you do not have this information handy, you can edit the
account information later, once the import is complete. Click Next to continue.

3. Tell GnuCash to import the data.

The last step is the import. Once you have verified your account names and
investment information, click Finish in the Update your GnuCash accounts page
to complete the import process. Depending upon the size of your file, the import
might take a few minutes to complete, so a progress bar displays the percentage
finished. When the import process is complete, GnuCash will return you to the
main window, which should now display the names of the accounts you imported.

Backing Up and Recovering Data

GnuCash creates several types of files to help ensure that your data is not lost. You
may see files with the following file extensions: xac, log, LCK, LNK in the same
directory as your primary data file. What each of these files does is presented below.

$ 1s

gcashdata
gcashdata.20060414185747.xac
gcashdata.20060414223248. 109
gcashdata.20060415114340.xac
gcashdata.20060415154508. log
gcashdata.20060415173322.xac
gcashdata.20060415194251.log
gcashdata.7f0982.12093.LNK
gcashdata.LCK

Backup file (.xac)

Each time you save your data file, a backup copy will also be saved with the
extension xac. This backup file is a complete copy of your previous data file, and the
filename format refers to the data file, year, month, day and time of the backup. For
example, the filename gcashdata.20060414185747.xac indicates this is a backup copy
of the file gcashdata saved in the year 2006, April 14, at 6:57:47 p.m.

To restore an old backup file, simply open the .xac file with the date to which you
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wish to return. Be sure and save this file under a different name; do not use a .xac
extension for a regular data file name.

Log file (.log)

Each time you open a file in GnuCash, a .log is created and saved with the same
name format as the .xac backup files. As you make changes to the open data file, the
log file saves only those changes. Log files are not a full backup of your data file -
they simply record changes you have made to the data file in the current GnuCash
session.

In case you exit GnuCash inadvertently, possibly due to a power outage or a system
wide crash, it is possible to recover most of your work since the last time you saved
your GnuCash file using this log file. This is the procedure:

e Open the last saved GnuCash file.

e Go to "File" -> "Import" -> "Replay GnuCash .log file" and select the one .log
file with the same date as the saved file you just opened. Make sure that you
picked the right .log file, or you will possibly wreak havoc in your accounts.

Log replaying will recover any transaction affecting the balance entered since the
last save, including those created from scheduled transactions and business features
(invoices, bills, etc.).

Note

Warning: Changes to the scheduled transactions, invoices or bills
themselves are NOT recovered, and their transactions that were recovered
may not be properly associated with them, and should thus be double-
checked. Especially for business transactions, you may have to delete and
re-create some of them. If you do not, although the balance will be correct,
some reports may not.

Lock files (.LNK and .LCK)

You may occasionally see .LNK and .L.CK files appear. These do not store any data,
but they are created to prevent more than one user from opening the same file at
the same time. These files are automatically created when you open the file, to lock
it so no one else can access it. When you close your GnuCash session or open
another file, GnuCash unlocks the first data file by deleting the LCK and LNK files.

If GnuCash crashes while you have a data file open, the LCK and LNK files are not
deleted. The next time you try to open GnuCash, you will get a warning message
that the file is locked. The warning message appears because the LNK and LCK files
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are still in your directory. It is safe to choose Yes to open the file, but you should
delete the .LNK and .LCK files (using a terminal window or your file manager.) Once
those files are deleted, you will not get the warning message again unless GnuCash
crashes.

File Management

So which files should you keep around? Keep your main data file, of course - data
files do not have an automatic file extension. It's a good idea to keep some of the
more recent .xac files, but you can safely delete the .log files since they are not
complete copies of your data. You should also delete any ..CK and .LNK files that
you see after closing GnuCash. If you decide to back up your data file to another disk
manually, you only need to back up the main data file - not the .xac files.

Note

GnuCash will automatically delete any .xac, .log files that are older than
30 days. You can change this behavior in the GnuCash preferences.

Putting It All Together

Note

This section begins a tutorial that will continue throughout this book. At
the end of each chapter, you will see a Putting It All Together section that
walks you through examples to illustrate concepts discussed in that
section. Each Putting It All Together section builds on the previous one, so
be sure to save your file for easy access.

Let's get started!

1. First, let's create a file to store your real data. Open GnuCash and go through
the New Account Hierarchy Setup dialog. You will create a file and accounts to
be used for your home finances, so choose the accounts that pertain to you. If
you are not sure what accounts you will need, click the Select All option to
create all of the accounts provided. When you have completed the setup, save
this file with a filename you want to use for your home data.

2. Next, create a file to store test data. This is the file that will be used in the
tutorials throughout this manual. Click File -> New to create a new file, and
name it gcashdata 1. Your main window should now look something like this:
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gcashdata 1 - Accounts

Fle Edit Wew Actions Business Reports Tools Windows Help

= 5

Sawve hew
fm Accounts

Account Name ¥  Commodity Total
b i@ Assets us Dellar UsD 0.00
b fm Equity Us Dollar USD 0,00
P @ Expenses Us Dollar UsD 0.00
b @ Income us Dellar UsSD 0.00
b @ Lisbilities us Dollar UsD 0.00

USD, grand total: Assets: USD 0.00 Profits: USD 0.00 -

This image shows the Account Tree window with a set of accounts loaded from
the druid.

3. Now, adjust some preferences in the account tree window. Select Edit ->
Preferences -> Windows and change the toolbar Style so that they display only
text, not icons. The change will take place directly, so look at the tool bar
buttons in the main window. Return to the Preferences dialog and change the
tool bar buttons back to the default setting by clicking Use system default. From
the column header row, select Arrow down and select “Type” (which means view
column "Type"). The main window should now look like this:

gcashdata 1 - Accounts

File Edit Wiew Actions Business Reports Tools Windows Help
= i

Save New

@ Accounts

Account Name ~ | Type Commeodity Total

b fm Assets Asset  US Dollar UsD 0.00

b @ Equity Equity  US Dollar UsSD 0.00

P fmi Expenses Expense US Dollar USD 0.00

P fm Income Income  US Dollar USD 0.00

b @ Liabilities Liability US Dollar UsD 0.00
UsD, grand total: Assets: USD 0.00 Profits: USD 0.00 =

This image shows the effect of changing the display options.
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Save your file.

4. If you plan to import QIF data from another program, let's try a practice file
first. (If not, skip to the next chapter on account setup (Chapter 3, Accounts).)

a.

The main window should now look like this:

f.

First, create a new file called gcashimport. It is up to you if you would like to
specify accounts (like Common Accounts) directly or not. If the QIF importer

does not find an account, it will create it automatically (or allow you to

create it manually)

. From the main menu, select File -> Import -> Import QIF.

import.

. Select the appropriate currency

. Select gnc_Sample QIF.qif as QIF file to load.

Complete the import.

geashdata 1 Accounts

L T

4. grand 1ol assets: $1,90801 profes $0.00

This image shows the Main window after importing the provided QIF sample file.

If after the import the screen is blank, go to File -> New -> New Accounts page

to display a new Accounts tab.

Save your file.
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.. to start the

. In the following dialogs, ensure that each transaction has a valid account, if
in doubt, just use the default ones.

Chapter 3. Accounts

Table of Contents

Basic Accounting Concepts
Balance Sheet Accounts
Income and Expense Accounts

GnuCash Accounts
Balance Sheet Accounts
Income and Expense Accounts

Putting It All Together
Simple Example
The Basic Top Level Accounts
Making Sub-Accounts

This chapter will discuss some useful concepts for organizing your accounts. Since
GnuCash does not impose any specific account tree layout, you are free to design
your account structure in any manner you wish. However, there are a few basic
accounting concepts which you will probably want to follow when designing your
accounts to maximize their utility.

Basic Accounting Concepts

As we saw in the previous chapter, accounting is based on 5 basic account types:
Assets, Liabilities, Equity, Income and Expenses. We will now expand on our
understanding of these account types, and show how they are represented in
GnuCash. But first, let's divide them into 2 groups, the balance sheet accounts and
the income and expense accounts.

Let's have a quick look at the Accounting Equation (Assets - Liabilities = Equity +
(Income - Expenses)) again as a reminder, before we go deeper into each account

type.

Equity
(Assets — Liabilities)
Income Expenses
i m >mwmﬁmw m_._mv___:mmw e

Positive Val Negative Value

A graphical view of the relationship between the 5 basic accounts. Net worth
(equity) increases through income and decreases through expenses. The arrows
represent the movement of value.
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Balance Sheet Accounts

The three so-called Balance Sheet Accounts are Assets, Liabilities, and Equity.
Balance Sheet Accounts are used to track the changes in value of things you own or
owe.

Assets is the group of things that you own. Your assets could include a car, cash, a
house, stocks, or anything else that has convertible value. Convertible value means
that theoretically you could sell the item for cash.

Liabilities is the group of things on which you owe money. Your liabilities could
include a car loan, a student loan, a mortgage, your investment margin account, or
anything else which you must pay back at some time.

Equity is the same as "net worth." It represents what is left over after you subtract
your liabilities from your assets. It can be thought of as the portion of your assets
that you own outright, without any debt.

Income and Expense Accounts

The two Income and Expense Accounts are used to increase or decrease the value of
your accounts. Thus, while the balance sheet accounts simply track the value of the
things you own or owe, income and expense accounts allow you to change the value
of these accounts.

Income is the payment you receive for your time, services you provide, or the use of
your money. When you receive a paycheck, for example, that check is a payment for
labor you provided to an employer. Other examples of income include commissions,
tips, dividend income from stocks, and interest income from bank accounts. Income
will always increase the value of your Assets and thus your Equity.

Expenses refer to money you spend to purchase goods or services provided by
someone else. Examples of expenses are a meal at a restaurant, rent, groceries, gas
for your car, or tickets to see a play. Expenses will always decrease your Equity. If
you pay for the expense immediately, you will decrease your Assets, whereas if you
pay for the expense on credit you increase your Liabilities.

GnuCash Accounts

This section will show how the GnuCash definition of an account fits into the view of
the 5 basic accounting types.

But first, let's begin with a definition of an account in GnuCash. A GnuCash account
is an entity which contains other sub-accounts, or that contains transactions. Since
an account can contain other accounts, you often see account trees in GnuCash, in
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which logically associated accounts reside within a common parent account.

A GnuCash account must have a unique name (that you assign) and one of the
predefined GnuCash "account types". There are a total of 12 account types in
GnuCash. These 12 account types are based on the 5 basic accounting types; the
reason there are more GnuCash account types than basic accounting types is that
this allows GnuCash to perform specialized tracking and handling of certain
accounts. There are 6 asset accounts (Cash, Bank, Stock, Mutual Fund, Accounts
Receivable, and Asset ), 3 liability accounts (Credit Card, Accounts Payable, and
Liability, ), 1 equity account (Equity), 1 income account (Income), and 1 expense
account (Expense).

These GnuCash account types are presented in more detail below.
Balance Sheet Accounts

The first balance sheet account we will examine is Assets, which, as you remember
from the previous section, refers to things you own.

To help you organize your asset accounts and to simplify transaction entry, GnuCash
supports several types of asset accounts:

1. Cash Use this account to track the money you have on hand, in your wallet, in
your piggy bank, under your mattress, or wherever you choose to keep it handy.
This is the most liquid, or easily traded, type of asset.

2. Bank This account is used to track your cash balance that you keep in
institutions such as banks, credit unions, savings and loan, or brokerage firms -
wherever someone else safeguards your money. This is the second most liquid
type of account, because you can easily convert it to cash on hand.

3. Stock Track your individual stocks and bonds using this type of account. The
stock account's register provides extra columns for entering number of shares
and price of your investment. With these types of assets, you may not be able to
easily convert them to cash unless you can find a buyer, and you are not
guaranteed to get the same amount of cash you paid for them.

4. Mutual Fund This is similar to the stock account, except that it is used to track
funds. Its account register provides the same extra columns for entering share
and price information. Funds represent ownership shares of a variety of
investments, and like stocks they do not offer any guaranteed cash value.

5. Accounts Receivable (A/Receivable) This is typically a business use only account
in which you place outstanding debts owed to you. It is considered an asset
because you should be able to count on these funds arriving.
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6. Asset For personal finances, use this type of account to track "big-ticket" item
purchases that significantly impact your net worth. Generally, you can think of
these as things you insure, such as a house, vehicles, jewelry, and other
expensive belongings.

Tip

For all GnuCash asset accounts, a debit (left-column value entry) increases
the account balance and a credit (right-column value entry) decreases the
balance. (See note later in this chapter.)

The second balance sheet account is Liabilities, which as you recall, refers to what
you owe, money you have borrowed and are obligated to pay back some day. These
represent the rights of your lenders to obtain repayment from you. Tracking the
liability balances lets you know how much debt you have at a given point in time.

GnuCash offers three liability account types:

1. Credit Card Use this to track your credit card receipts and reconcile your credit
card statements. Credit cards represent a short-term loan that you are obligated
to repay to the credit card company. This type of account can also be used for
other short-term loans such as a line of credit from your bank.

2. Accounts Payable (A/Payable) This is typically a business use only account in
which you place bills you have yet to pay.

3. Liability Use this type of account for all other loans, generally larger long-term
loans such as a mortgage or vehicle loan. This account can help you keep track
of how much you owe and how much you have already repaid.

Tip

Liabilities in accounting act in an opposite manner from assets: credits
(right-column value entries) increase liability account balances and debits
(left-column value entries) decrease them. (See note later in this chapter)

The final balance sheet account is Equity, which is synonymous with "net worth". It
represents what is left over after you subtract your liabilities from your assets, so it
is the portion of your assets that you own outright, without any debt. In GnuCash,
use this type of account as the source of your opening bank balances, because these
balances represent your beginning net worth.

There is only a single GnuCash equity account, called naturally enough, Equity.

Tip
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In equity accounts, credits increase account balances and debits decrease
them. (See note later in this chapter)

Note

The accounting equation that links balance-sheet accounts is Assets =
Liabilities + Equity or rearranged Assets - Liabilities = Equity. So, in
common terms, the things you own minus the things you owe equals your
net worth.

Income and Expense Accounts

Income is the payment you receive for your time, services you provide, or the use of
your money. In GnuCash, use an Income type account to track these.

Tip

Credits increase income account balances and debits decrease them. As
described in the section called “Accounting Concepts”, credits represent
money transferred from an account. So in these special income accounts,
when you transfer money from (credit) the income account to another
account, the balance of the income account increases. For example, when
you deposit a paycheck and record the transaction as a transfer from an
income account to a bank account, the balances of both accounts increase.

Expenses refer to money you spend to purchase goods or services provided by
someone else. In GnuCash, use an Expense type account to track your expenses.

Tip

Debits increase expense account balances and credits decrease them. (See
note later in this chapter.)

Note

When you subtract total expenses from total income for a time period, you
get net income. This net income is then added to the balance sheet as
retained earnings, which is a type of Equity account.

Below are the standard Income and Expense accounts after selecting Common
Accounts in the Druid for creating a new Account Hierarchy (File -> New -> New
Account Hierarchy).
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gcashdata 1 - Accounts

File Edit Mew Actions Business Reports Tools Windows Help
=] == mh @@
Save Open  Edit MNew Delete
il Accounts
Account Name ¥ Type Commodity Total =]
~ & Income Income  US Dollar USD 0.00
fm Bonus Income S Dollar UsD 0.00
fm Gifts Received Income  US Dollar USD 0.00
~ @ Interest Income Income  US Dollar USD 0.00
fm Checking Interest Income US Dollar USD 0.00
fm Other Interest Income  US Dollar USD 0.00
f® Savings Interest  Income  US Dollar USD 0.00
fm Other Income Income  US Dollar USD 0.00
@ Salary Income  US Dollar USD 0.00 =
K1 I
_Cmc_ grand total:  Assets: USD 0.00  Profits: USD 0.00 s

This image shows the standard income accounts

gcashdata_1 - Accounts

File Edit View Actions Business Reports Tools Windews Help
] = W (@
Save Open  Edit New Delete
@ Accounts
Account Name ¥ Type Commodity Total =]
= f Expenses Expense US Dollar USD 0.00
m Adjustment Expense US Dollar USD 0.00
= fi Auto Expense US Dollar USD 0.00
i Fees Expense US Dollar USD 0.00
fm Gas Expense US Dollar UsD 0.00
fi Parking Expense US Dollar USD 0.00
@ Repair and Mainter Expense US Dollar UsSD 0.00
fmt Bank Service Charge Expense US Dollar USD 0.00
fm Books Expense US Dollar USD 0.00
i Cable Expense US Dollar USD 0.00
fw Charity Expense US Dollar USD 0.00
& Clathes Fvnense 118 Nnllar 1180 0 nn 5
(o] I[»)
_Cmc_ grand total: Assets: USD 0.00 Profits: USD 0.00 s _
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This image shows some standard expense accounts
More on Debits and Credits

Remember the terms debit and credit discussed in the section called
“Accounting Concepts”? Contrary to popular belief and even some
dictionary definitions, accounting debits and credits do not mean decrease
and increase. The only constant definition of debits and credits is that
debits are left-column entries and credits are right-column entries. In fact,
debits and credits each increase certain types of accounts and decrease
others. In asset and expense type accounts, debits increase the balance
and credits decrease the balance. In liability, equity and income type
accounts, credits increase the balance and debits decrease the balance.

For example, debits increase your bank account balance and credits
decrease your bank account balance. Wait a minute, you might say, a debit
card decreases the balance in my checking account, because I take money
out of it. And when the bank gives me money back on something, they
credit my account. So why is this reversed in accounting?

Banks report transactions from their perspective, not yours. Their
perspective is exactly opposite to yours. To you, your bank account
represents an asset, something you own. To the bank, your bank account
represents a loan, or liability, because they owe you that money. As
explained in this chapter, asset and liability accounts are exact opposites
in the way they behave. In a liability account, debits decrease the balance
and credits increase the balance.

When you take money out of your bank account, the balance in your
account decreases. To you, this is a decrease in an asset, so you credit
your bank account. To the bank, this is a decrease in a liability, so they
debit your bank account.

Putting It All Together

Let's go through the process of building a common personal finance chart of
accounts using the information we have learned from this chapter. A chart of
accounts is simply a new GnuCash file in which you group your accounts to track
your finances. In building this chart of accounts, the first task is to divide the items
you want to track into the basic account types of accounting. This is fairly simple,
let's go through an example.

Simple Example
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Let us assume you have a checking and a savings account at a bank, and are
employed and thus receive a paycheck. You have a credit card (Visa), and you pay
monthly utilities in the form of rent, phone, and electricity. Naturally, you also need
to buy groceries. For now, we will not worry about how much money you have in the
bank, how much you owe on the credit card, etc. We want to simply build the
framework for this chart of accounts.

Your assets would be the bank savings and checking account. Your liabilities are the
credit card. Your Equity would be the starting values of your bank accounts and
credit card (we do not have those amounts yet, but we know they exist). You have
income in the form of a salary, and expenses in the form of groceries, rent,
electricity, phone, and taxes (Federal, Social Security, Medicare) on your salary.
Simple, isn't it?

The Basic Top Level Accounts

Now, you must decide how you want to group these accounts. Most likely, you want
your assets grouped together, your liabilities grouped together, your Equity grouped
together, your income grouped together, and your expenses grouped together. This
is the most common way of building a GnuCash chart of accounts, and it is highly
recommended that you always begin this way.

Start with a clean GnuCash file (do not select any predefined accounts) and build
this basic starting account structure (File -> New Account...).

1. Account name Assets (account type Assets, parent account New top level
account)
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New Account - Assets

General | Opening Balance

Identification

Account name: _Pmmmﬂm

Account code: _

|
_
Description: | _
|
_

Security/currency: _CmU (Us Dollar) : select...
Smallest fraction: _ Use Commodity Value &=
Notes:

Tax related [ Hidden

Placeholder

Account Type
Bank E
Cash

cradit card (7]

This image shows the dialog to create an asset account

Parent Account

& New top level account

2. Account name Liabilities (account type Liabilities, parent account New top level
account)

3. Account name Equity (account type Equity, parent account New top level
account)

4. Account name Income (account type Income, parent account New top level
account)

5. Account name Expenses (account type Expenses, parent account New top level
account)

When you have created the top-level accounts, the main Account page in GnuCash
should look like below
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| = <no file> - Accounts

Expenses:Taxes)

File Edit Mew Actions Business Reports Tools Windows Help
@ 12. Account name Medicare (account type Expenses, parent account
= N Expenses:Taxes)
il Accounts | 13. Account name Opening Balance (account type Equity, parent account Equity)
Account Name ¥ Type Commodity Total 3
R e After you have created these additional sub-accounts, the end result should look like
fiw Equity Equity  US Dollar USD 0.00 below
i Expenses Expense US Dollar UsSD 0.00 L L
ff Incorne Income  US Dollar Lzl Bl File Edit View Actions Business Reports Tools Windews Help
i Liabilities Liability US Dollar UsSD 0.00 @.
_CmU\ grand total: Assets: USD 0.00 Profits: USD 0.00 B Save New
r B @ Accounts
Account Name ~ | Type Commodity Total 4
This image shows the basic top-level accounts. A wigat? ‘USBElE  LS30:00
. i Checking Bank US Dollar USD 0.00
Making Sub-Accounts it Savings Bank  USDollar  USD 0.00
. . . . = fm Equity Equity  US Dollar UsSD 0.00
You can now add to this basic top-level tree structure by inserting some real 7 o o GEn T
. . . . N enin alance ur ollar a
transaction-holding sub-accounts. Notice that the tax accounts are placed within a o g mg 4 i e
. . . s =~ i
sub-account named "Taxes". You can make sub-accounts within sub-accounts. This is mmum_amm GEEIEs o__mj
. . . N Electricit E: us D UsSD 0.00
typically done with a group of related accounts (such as tax accounts in this F ol &5
example) fm Groceries Expense US Dollar  USD 0.00
fm Phone Expense US Dollar USD 0,00
1. Account name Checking (account type Bank, parent account Asset) fmt Rent Expense US Dollar  USD 0.00
~ fm Taxes Expense US Dollar UsD 0.00
2. Account name Savings (account type Bank, parent account Asset) i Federal Expense USDellar  USD 0.00
. . ) R i Medicare Expense US Dollar USD 0.00
3. Account name Visa (account type Credit Card, parent account Liabilities) :
fm Social Security Expense US Dollar USD 0.00
4. Account name Salary (account type Income, parent account Income) ¥ & Income Incame: {US Dallar* LISD10:00
m Salary Income  US Dollar USD 0.00
5. Account name Phone (account type Expenses, parent account Expenses) ~ fi Liabilities Liabilty US Dellar ~ USD 0.00
i Visa Credit Ca US Dollar USD 0.00
6. Account name Electricity (account type Expenses, parent account Expenses)
[usD. grand total:  Assets:USD0.00  Profits: USD 000 %
7. Account name Rent (account type Expenses, parent account Expenses) :
8. Account name Groceries (account type Expenses, parent account Expenses - .
( yp p p p ) This image shows a simple chart of accounts.
9. Account name Taxes (account type Expenses, parent account Expenses . .
( yp b p b ) Save this chart of accounts with the name gcashdata 3, as well as
10. Account name Federal (account type Expenses, parent account Expenses:Taxes) gcashdata_3emptyAccts, as we will continue to use them in the later chapters.

11. Account name Social Security (account type Expenses, parent account You have now created a chart of accounts to track a simple household budget. With
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this basic framework in place, we can now begin to populate the accounts with
transactions. The next chapter will cover this subject in greater detail.

Chapter 4. Transactions

Table of Contents

Basic Concepts
The Account Register
Simple Transaction
Split Transaction
Features of the Account Register
Choosing a Register Style
Using Entry Shortcuts
Reconciliation
Reconcile Window
Scheduled Transactions
Creating from the Ledger
Creating from the Editor
Putting It All Together
Open GnuCash file
Opening Balances
Additional Transaction Examples
Save file
Reports

This chapter will give you the basic information you need to understand and use
transactions in GnuCash. Whereas accounts are the framework and structure of a
chart of accounts, transactions are the data which fills each account.

Basic Concepts

A transaction in a double entry accounting system such as GnuCash is an exchange
between at least 2 accounts. Thus, a single transaction must always consist of at
least two parts, a "from" and a "to" account. The "from" account is passing value to
the "to" account. Accountants call these parts of a transaction Ledger Entries. In
GnuCash, they are called Splits.

For example, you receive a paycheck and deposit it into your savings account at the
bank. The transaction that occurs is that your bank savings account (an asset)
received money from your income account. Two accounts are affected, and in this
case there is a net increase in your equity.

Working with transactions in GnuCash is performed using what is known as the
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account register. Every account you create has an account register. It will appear
familiar to you as it looks very similar to the log used to track checkbooks.

The Account Register

The account register is the GnuCash window which allows you to view or edit
preexisting transactions, or add new transactions for a particular account. To enter
the account register, simply highlight the account name in the account tree window
and double-click to open it. You can also click the Open button in the tool bar or use
the right mouse button menu to open the account. GnuCash will display the account
register window.

Simple Transaction

For example, starting with the chart of accounts we created in the previous chapter
gcashdata_3, double click on the checking asset account. Let's add a simple
transaction to the checking account. When you first create your accounts in
GnuCash, it is common to start them off with an initial balance.

In the first transaction row, enter a date (eg: March, 1, 2006), a description (eg:
"Opening Balance"), click on the Transfer pop-up menu and select Equity:Opening
Balances, add a deposit value of $1000, and press the Enter key. The account
register should now appear similar to this figure:

geashdata 3 - Checking

fle Edt Miew Tapsaction Actions Business Beports bals Windows Help

B *» @® g + x 2 0 e

sava  Cclose Erter  cancal glank Spit Jump  Scheduls

8 Accounts| 8 C
[ate [Hum [ Description [wanster [" [Deposit [withdrawal [Balance [~
L0308 | | Opening Balance | EqueyOpening Balance | n | 1,000.00| | 100000

[osrous [ | n] , _

I
1.00008 Claarad:USD 0.00_Aconciled USD 000 Projacted Mismum:LISD 1.000.00

This image shows Assets:Checking - Register after inserting a starting value
transaction.

Setting the starting balances of an account is an example of a simple two account
transaction. In this case, affecting the Assets:Checking and the Equity:Opening
Balances accounts.

As another example of a simple 2 account transaction, add another transaction to
describe the purchase of $45.21 worth of groceries. From within the Assets:Checking
account, you would set Transfer to Expenses:Groceries. The account register should
now appear:
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fle Edt View Tapsaction Actions Husiness Beports Bals Windows Help
B * ®™m @ + x & = ® e .
Save  Clasa  Ouplicate  Delate Erter  Cancel slank spit  Jump  Scheduls

8 Accounts| @ Checking
Description Transier @ [Deposit | withdrawal |salance ||~
Opening Balance | Equty:Dpening Balance | n | 1000.00 | | 180000]]|
Expenses:Groceries | n | 4521] 95479

|

0 Projacted Minimum: LSD 954,75

Gracery Store

This image shows Assets:Checking - Register after adding a transaction for
groceries.

Split Transaction

The need for 3 or more account transactions occurs when you need to split either
the "from" or the "to" account in a transaction into multiple accounts. The classic
example of this is when you receive a paycheck. Your take home pay from a
paycheck will typically be less than your net pay, with the difference being due to
taxes, retirement account payments, and/or other items. Thus, the single transaction
of you receiving a paycheck involves other accounts besides simply Assets:Checking
and Income:Salary.

To add a paycheck transaction from the Assets:Checking account register window,
click on a new transaction line, and click on Split. First enter the description of this
transaction on the first line (eg: "Employers R Us"). In the "split" line below this,
enter the deposit into Assets:Checking (eg:$670) (This is due to a current bug, that
demands the first line in a split is the actual account). Follow this with the various
tax deposits (Assets:Checking (eg: $670), Expenses:Taxes:Federal (eg: $180),
Expenses:Taxes:Medicare (eg: $90), and Expenses:Taxes:Social Security (eg: $60))
and lastly the gross total of your paycheck (eg: $1000) as a withdrawal transfer from
Income:Salary. The final split should look like this:

Gcashdata 3 - Checking.

Gle Edt View Tapsaction Actions Gusiness Beports Bals Mindows Help

B x D o + x 3 _ 0| = e 5
Save Close Ouplicate  Delata Emer  Cancel alank | Spit Jump  Schedue

8 Accounts| @l Checking
[Bate [Hum [ Description T [Tot epos [ ot Withdra | Balance [ |~/

Expenses:Groceries | n | 35475 |

670.00 |
670.00
180.00
80.00
60.00

1,000.00

Assets:Checking

I
Frojacted Mirmum:LISD 1,624.79

This image shows Assets:Checking - Register after adding a split transaction for
salary.
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Features of the Account Register

The title bar of the account register displays the account name, which in this case is
Assets:Checking. Below the title bar, the menu bar displays the menu items
available within the account register, and the tool bar contains handy buttons that
help you work with the account register.

Although each transaction has at least two splits, all you see in the basic register is
a summary of the splits affecting the current account. In the Transfer column, you
can see the other account from which money is transferred into or out of this
account. If the transaction affects more than two accounts, GnuCash displays -- Split
Transaction -- to show it is a multiple-split transaction. You can see the individual
splits of each transaction by clicking the Split button in the tool bar while selecting
the appropriate transaction.

For split transactions, the first line of the transaction is the transaction line. It
contains a Date, optional Num (such as a check number), transaction Description,
total amount affecting the current account (Tot Deposit here), and updated account
Balance after the current transaction. Note that in the expanded view, the Transfer
column heading disappears, and there is no account name listed in that field. This
line shows you only a summary of the transaction's effect on the current account. For
more detailed information, you need to look at the individual splits that make up the
transaction.

The partial lines below the transaction line are the split lines, and they are
separated by gray lines. As you highlight one of the split lines, the column headings
change to show the split-related fields:

Gcashdata 3 - Checking.

53 Beports Bols Windows Help

g + x 3 Lo

Delota Erter  Cancal slank _ Spitt Jump  Scheduls

fle Edt Wiew Tapsaction Actions

=] x

sava clase

& Accounts| 1 Cher

JAccount ®_[Deposit | withdrawal |

Expenses Groceries
|

| Asseth Checking

452

05/03/06
1410308

670.00 |
670.00
1E0.00
s0.00
60.00

Expenses Toes:
Income Salary

1,000.00
I
S0 1.634.78_Future:USD 1,624 75 Claared:USD 8,00 Asconciled: USD 006 Projacted Minimum: USD 1.624.75

This image shows how split headings change.

Each split contains an optional Action, or type of split, which you can either type in
or choose from a pull-down list. The split also contains an optional Memo which
describes the split. Each split affects an Account, which can be selected from a
pull-down list of your accounts. The R field indicates whether the split has been
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reconciled. The last two columns show the amount of the split and whether money is
coming into or going out of the account.

As we discussed in the section called “Accounting Concepts”, total debits (left-column
entries) must equal total credits (right-column entries) for each transaction. In the
example shown above, the total debits equal the total credits, so this transaction is
balanced. If you notice, the transaction line contains the same debit amount as the
Checking split line. Why is this shown twice? Because the transaction line is merely
a summary of the transaction's effect on the current account. The same transaction
in a different account will have a different transaction line, one that shows the effect
on that particular account. You can see this by highlighting another split line and
clicking the Jump button on the tool bar.

In this example, if you jump to the Income:Salary account, GnuCash brings up the
same transaction in the Income:Salary - Register:

geashdata_3 - salary

fle Edt View Tansaction Actions Business Bepoms Bols windows Help

B *x - g + x =z |EBH| o e .

Save Close Ouplicate  Dalate Erter  Cancal alank Split Jump  Scheduls

@ Accounts @ Checking @ Salary

[Eats [Hum [Description T [et charg [t income [ Salance |~
JErmcioyare o] | I | roo00a] 1.000.00]
Aker T ‘Assets:Chacking 670.00

180.00

80.00

60.00

[ am3me]

Federal Tx Expenses Taes:Federal
Medicare

Secial Security i
Before Tax Income Salary

alzlalz]=

1,000.00

ol Tls
;
:USD 0.00 Aeconciled:USD 0.00  Projcted Minimum: USD 1,000.00

This image shows a jump to the Income:Salary account.

Note that the transaction line total now summarizes the effect on the Income:Salary
account instead of the Checking Account, because you are looking at the
Income:Salary account register. The splits are exactly the same, but the transaction
line now reflects the credit to the Income:Salary account.

At the bottom left of the register window, GnuCash displays helpful messages as you
move about the register. To the right, you can see the current account balance and
the total of cleared splits.

Choosing a Register Style

GnuCash offers several options for viewing your registers. The default style is Basic
Ledger mode, which displays only the summary of splits affecting the current
account. This is the style that most closely resembles other popular personal
financial packages.
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You can choose a different register style by selecting View -> Auto-Split Ledger style
expands the current transaction automatically. As you highlight a new transaction in
the register, the transaction automatically expands to show all splits. The View ->
Transaction Journal style is more like an accounting journal, in which all splits are
shown for all transactions.

All styles permit you to view your data in either single-line or double-line format.
Select View -> Double Line, and you will see your transaction line expand to two
register lines.

Let's have a closer look at how the Basic Ledger and Transaction Journal view
differs.

For this example, let's assume that you have a checking account with $10,000, and
have decided to really splurge by purchasing 3 pair of Jeans for $1,000. Now, you
can either record this as one simple transaction and move $1,000 to
Expenses:Clothes. Or, you can record a split transaction, and record each Jeans
individually.

Technically they are the same, but from an accounting point of view, when you
record each Jeans purchase separately, the Expenses:Clothes account will record
three different transactions.

The below screenshots will illustrate this a bit better

First let's purchase the Jeans from your checking account

=no file= - Checking Account

Fle Edit Wiew Tapsaction Actions Busness Beports Tooks windows Help

+ x

Enter  Cancel

X
Save  Close

= %
Spit | jump  Schedule

S Actounts| @ Checking Accoun
[ JActior [Mema [Aeceunt [ [oepos [t 1 -
2008-01-15 |Buying Clothes | |

|1sans RUs Expenses:Clothes n
|aans R U= ExpensesiCiother m

5,000.00 |

|eans RUs

n
Assets:Currant Assets-Chacking | n

0
edUSD 000 Asconciled USD 0.00_Frojected Minimurm: USD 8,000 00

This image shows one split transaction with 3 Jeans purchases

The we open the Expenses:Clothes account, and look at it from the default Basic
Ledger view. As you can see, we have three entries here, but there were only one
entry in the checking account. If you look carefully, you will see that each row have
a different amount, $200, $300, and $500. Each row's transaction line reflects a one
split row
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fle Edit Wiew Tagsaction Actions Business faports Tools Windows Help

= x D 8 + X F3 ¥

sava  Closa  Duplicata Dalste Entar  Cancal Blank split Jump.

@ Accounts | @ Checking Account | Bt Clathes

[pate Num | Description Transfer R [Expense [rebate Balance [ |+
2006-01-15 Buying Clathes - Splt ransaction -- |n | 200.00 | 20000
2006-01-15 Buying Clothes -~ Split Tansa n| 300.00 500,00
2006-01-15 Buying Clathes - Splt Transaction - [n | 500.00 00000 | [
=

80,00 Clears: 9.00 Asconciled: USD 0.00 Propected Minmum: USD 1,000.00

This image shows Expenses:Clothes account in Basic Ledger mode.

If we view the Expenses:Clothes account in Transaction Journal mode, you will
again, only see the original split transaction.

Clothes

fila Edit View Tansaction Actions Business Raports Tols Windows Help

=] x n g + X k4 T & -
Save  Closs  Duplicate  Delste Enter  Cancsl slank Jump  Scheduls
@ Accounts | @ Checking Account @ Clathes
[Date [ Mur [ Desergtion [ [Tot Exper [Tot Rebate [Balance [~
2006-01-18]  |Buying clathes [ [ro000a] | 1.000.00]

Jeans ALUS Expanzas:Clathes 500.00

n
Joans ALUs Expanses:Clothes n| 30000
Jeans R Us Expansas:Clothes n| 20000
Assats:Current Assets:Checking Account | n 1.000.00 =

v
USD 1.000.00 _Clearsd:USD 0.00 Reconciled: SO 0.00 _Projected Minimwm: LUSD 1,000.00

Presant:LISE 00 Fut
Enter

This image shows Expenses:Clothes account in Transaction Journal mode.

Using Entry Shortcuts

GnuCash provides several time-saving shortcuts for entering your data. When you
type the first few characters of a description that you have used before, the QuickFill
feature automatically fills in the rest of the transaction as you last entered it. When
you type in the first characters of an account name in either the Transfer field of the
transaction line or the Account field of the split line, QuickFill will automatically
complete the name from your account list. It also helps you with entering
sub-accounts in these fields: simply type the first characters of the parent account
name followed by a colon and the first characters of the sub-account name. For
example, to enter Assets:Checking, you might type A:C and let GnuCash fill in the
rest.

Register keyboard shortcuts also save you time, and GnuCash provides several of
them. In the date field, you can type:

e + or = to increment the date and - or _ to decrement the date
e ] or } to increment the month and [ or { to decrement the month

¢ M or m to enter the first date of the month
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« H or h to enter the last date of the month
* Y or y to enter the first date of the year

e R or r to enter the last date of the year

« T or t to enter today's date

In the Num field of the transaction line, you can type + to increment the transaction
number from the last one you typed in. Typing - will decrement the number. This
will also work in the Action field of the split line, if you choose to enter split
numbers there. The Action field also supports QuickFill - if you type the first
characters of a common action (such as Deposit), GnuCash will fill in the rest.

The Transfer field supports QuickFill of account names. You can start typing an
account name and GnuCash will fill in the remaining part of the name. Typing the
separator character at any time will complete the current level of the account name,
leaving the cursor positioned to start the next level of account name. For example,
typing "A:C" with the standard set of account names will complete to the
"Assets:Checking" account. You can also type the Menu or Ctrl-Down keys in this
field to pop up a list of all account names.

In any of the amount fields, you can use a built-in calculator. Simply type in the first
value, followed by +, -, *, or /, then type in the second value. GnuCash will perform
the calculation and return the resulting value to the amount field when you press the
Tab key.

All of the menu items have access keys defined, and these are marked by underlined
characters in the menu names. Press Alt + [underlined character] to bring up the
menu, then select an item by typing its underlined character. For example, typing
Alt+T brings up the Transaction menu, then typing S will split the transaction. A few
of the menu items also have shortcut keys that immediately invoke the command
(typically using the Ctrl key). These shortcuts are listed next to the item.

To move around the register, use these keys to save time:
o Tab to move to the next field, Shift+Tab to move to the previous field
e Home to move to the beginning of the field, End to move to the end of the field

o Enter or | to move to the next transaction, T to move to the previous
transaction

+ Page Up to move up one screen, Page Down to move down one screen

« Shift+Page Up to go to the first transaction, Shift+Page Down to go to the last
transaction
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In the Reconcile window you can use these keyboard shortcuts:
« Tab moves to the next box and Shift-Tab moves to the previous box
e Space bar toggles the status between reconciled and not reconciled

« T and ! navigate through the entries within the current box

Reconciliation

Transactions are typically checked against bank statements - a process known as
"reconciliation". GnuCash keeps track of the reconciliation status of each
transaction.

The reconciliation status of a transaction is shown by the reconciliation (R) field. 'y’
indicates that a transaction has been reconciled, 'n' indicates that it has not, and 'c'
indicates that it has been cleared, but not reconciled. You can toggle the
reconciliation status between 'n' and 'c' by clicking in the (R) field; you can set it to
'y' by using the Reconciliation Window.

At the bottom of the account window, there are two running totals: 'Balance’, and
'‘Cleared'. 'Cleared' should correspond to how much money the bank thinks you have
in your account, while 'Balance' includes outstanding transactions.

Reconcile Window

The Reconciliation Window is used to reconcile a GnuCash account with a statement
that a bank or other institution has sent you. Reconciliation is useful not only to
double-check your records against those of your bank, but also to get a better idea
of outstanding transactions, e.g. uncashed checks.

At the bottom of the account window, there are two running balances: the "cleared
and reconciled" balance, and the "total" balance. The "cleared and reconciled"
balance should correspond to how much money the bank thinks you have in your
account, and the "total" balance includes outstanding transactions.

For example, when you write a check for something, you should enter the
transaction into GnuCash. The reconciliation (R) field of the transaction will initially
contain n (new). Your new entry will contribute to the "total" balance, but not to the
"cleared and reconciled" balance. Later, if you think that the check has been cashed,
you might click on the transaction's R field to change it to ¢ (cleared). When you do
this, the "cleared and reconciled" balance will change to include this amount. When
the bank statement arrives, you can then compare it to what you've recorded in
GnuCash in the Reconciliation window. There, you will be able to change the R field
to y (reconciled). You cannot reconcile in the register window, you must use the
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reconciliation window. Once a transaction has been marked "reconciled", it can no
longer be easily changed.

To use the Reconciliation Windows, select an account from the account tree and
click on Actions -> Reconcile. A window will appear in which you can enter the
reconcile information.

Assets:Checking - Reconcile

Reconcile Information

Statement Date: | 18/04/08 hd
Starting Balance: USD 0.00

Ending Balance: |MEELNE

Include subaccounts

Enter Interest Payment...

M Cancel E

The initial reconcile window.

e Reconcile Info: Statement Date - this is the date of the statement you will be
reconciling against.

e Reconcile Info: Starting Balance - this is a non-editable item which displays the
balance from the previous reconciliation. It should match the starting balance in
your statement.

e Reconcile Info: Ending Balance - this is the ending balance as it appears in the
statement.

e Reconcile Info: Include Sub-accounts - select this if you want to include the
sub-accounts of the currently selected account in this reconciliation.

o Enter Interest Payment - click here to enter an interest transaction to the
account to be reconciled.

Click on the Ok button, and you will see the transactions listing reconcile window:
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Assets:Checking - Reconcile

Beconcile Account Tansaction Help

D B @ = @« X

New Edit Delete open Postpone  Cancel

Funds In Funds Out

= Date ~ | Num | Descriptic Ameunt R |

Date ¥ Num Description Ameunt R

Opening Bal  1,000.00 -
Employers R 670.00

Total: USD 1,000.00 Total: USD 45.21

Starting Balance:  USD 0.00
Ending Balance: USD 1.624.79
Reconciled Balance: USD 954.79
Difference: USD 670.00

The transactions listing in the reconcile window.

The two lists called Funds In and Funds Out lists all the unreconciled transactions.
The 'R' columns show whether the transactions have been cleared or reconciled.

Now, examine each item on the bank statement, and look for the matching item in
the Reconcile window.

If you cannot find one, then perhaps you forgot to enter a transaction, or did not
know that the transaction had happened. You can use the New button on the tool
bar, or the New menu item in the Transaction menu, to open a register window and
enter the missing transaction. The new item will appear in the Reconcile window
when you press enter after entering the transaction.

When you find the item in the Reconcile window, compare the amount in the item to
the amount on the statement. If they disagree, you may have made an error when
you entered the transaction in GnuCash. You can use the Edit button on the tool bar,
or the Edit menu item in the Transaction menu, to open a register window and
correct the transaction.

If the amounts agree, click on the item in the Reconcile window. The 'R' column will
change to 'y' (reconciled) from 'n' or 'c'. You may also use the up/down arrow keys to
scroll to the item and then press the space key. This will also change the 'R' column
to show the item as reconciled.

You then repeat this for each item that appears on the bank statement, verifying
that the amounts match with the amounts in GnuCash, and marking off transactions
in GnuCash as they are reconciled.

At the bottom of the "Reconcile" window is a "Difference" field, which should show
$0.00 when you are done reconciling. If it shows some other value, then either you
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have missed transactions, or some amounts may be incorrect in GnuCash. (Or, less
likely, the bank may have made an error.)

When you have marked off all the items on the bank statement, and when the
difference is $0.00, press the Finish button on the tool bar or select Finish from the
Reconcile menu. The Reconcile window will close. In the Register window, the R
field of the reconciled transactions will change to 'y'.

In this case, we have not received all the information yet, so we simply press the
Postpone, so we can continue at a later stage. Observe that the 'R' column indicates
we cleared ('c') two transactions. They have not been reconciled yet, but we have
verified these two transactions so they have been marked as cleared. If you look at
the status bar at the bottom of the account register, you will see a summary of what
has been reconciled and what has been cleared (Cleared:USD 954.79
Reconciled:USD 0.00)

geashdata 3 - Checking
m_Fm%s?EEmSu:m:_oﬁwcriz@ue:wao_wﬁig,.un_c

= [~ + X 2 H o ¢ .
Sawe  Closa  Duplicats Delsta Entsr  Cancel Blank  Spit  Jump  Schedus

it Accounts |@ Checking | Salary

Date Num | Description Transfer R |Depost |Withdrawal[Balance [«
C1/03/06 Opening Bslanca EquityOpaning Balance | « | 1.000.00 1.000.00

(e Grocery Shop Exppnzas os [ 1] < as21| 9sa79
1410306 Employers & Us n | &7000 162879
O5M03M06. n =l

Ex) roceries

The Checking account after postponed the reconciliation.

Scheduled Transactions

Scheduled transactions are made to help entering repetitive money operations, like
subscriptions, insurances or taxes. By using scheduled transactions, you only have to
enter the concerned transaction once, set a few parameters like start date,
frequency and a little description, and then GnuCash will tell you whenever a
scheduled transaction is ready to create, and create it for you.

In this howto, we'll take a monthly Internet subscription of 20 USD as example,
which is taken on the 28th of each month.

In GnuCash, there are two ways of creating scheduled transactions, from the ledger
or from the scheduled transactions editor.

Creating from the Ledger

Enter the first occurrence of your to-schedule transaction in the ledger.
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Geashdata 3 - Checking

Ble Edt Wiew Tapsaction Actions @usiness Beports Tols  Windows Help
[= D = + X 2 B = e e
Save Clase Duplicate  Deleta Enter cancel Blank split Jump Schedule

| Accounts |l Checking |G Salary |

01/03/05 Opaning Balance Balancs | n | 1,000.00 1.000.00
510306 [ 101_| Grocery Stare Expenses:Groceries | n 4521] 95479
14/03/06 Employars R Us -- Splt Fransaction - | n | 670.00 162479 |
2810306 Intemet Subscription Expensesinternat | n 2000 | 1.504.78 _
[2zio5i0- 10 n Z -

I ” w— [
Present; USD 160479 Future:USD 1.504.79 Cleared:USD 0.00 Aeconciled:USD 0.00 _Projacted Minimum: USD 1,604.78
Tuesday 28 March 2006

Step one creating scheduled transaction from the ledger

Note

Since we did not create the Expence:Internet account, GnuCash will

prompt us to create it.

Then you right click on your transaction and select "Schedule..."

WL Ly olins | LApS 2Ty

-- Split Transac

Employers R Us
Internet Slibscr

Sort By...
Elter By...
160479 FutureiUs|  papame page
duled Transaction with

B8 Duplicate Transaction
@ Delete Transaction
Mw Remove Transaction Splits

nau Enter Transaction

X Cancel Transaction

& Blank Transaction

Split Transaction
Edit Exchange Rate
¢ Schedule...

5 Jump

Step two creating scheduled transaction from the ledger

A window like this will appear:
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Make Scheduled Transaction

_ Su Mo Tu be Tt

Name: ___.:m-:m" Subscription 11
718

e
o]

»
=
=
]

_#mn:mjnwL Daily <]
Start Date: |29/03/06 |~
End

=

&

#® Never End
© End Date:[18/0406 | v | g
*) Number of Occurrences:| [w W_

)ncm_._nmn_:,_ | X cancel [ _ Pok

il
=

B
[EEER]

Step three creating scheduled transaction from the ledger

Let's fill the values, we know that the subscription is taken on the 28th each month,
and the next one is for next month (since we entered the one for this month
manually) :

Make Scheduled Transaction

Su Mo Tu We Th Fr

Mame: Internet Subscription

Frequency:| Monthly - %WW%
Start Date: [28/04/05 [~ .ﬁ%w v

»

B

M

=

-

o

<

EESERIAEEEEI

21
£ 1415 me_ww 18]13
® Never End
© End Date:[18/04/06 | v | 23
“) Number of Occurrences:| 2 ,m.
Y 48 =
1]

X Cancel __ GDR |

Advanced.., _

Filling in data to a scheduled transaction
Click the OK button, and the transaction will be scheduled. GnuCash now has

memorized this scheduled transaction and on the 28th of next month, it will pop up a
window asking if it should create it (see far below for a screenshot of this window).

Creating from the Editor

Another way of entering a scheduled transaction is from the Scheduled Transaction
Editor, it may be faster if we have several scheduled transactions to create at once.
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From the main accounts windows, go in the Actions menu, select Scheduled
Transactions, a submenu will open in which you'll click Scheduled transaction
Editor.

gcashdata_3 - Checking

ion RAS{EREN Business Reports Dools Windows Help

Scheduled Transactions | Scheduled Transaction Editor

Close Books Since Last Run...

Mortgage & Loan Repayment.
ME ¥ Transfer.., ctri+T = 9ag pay

[ Reconcile... i

72 _Umnnu_» TS:,

Step one creating scheduled transaction from the editor

A window like this will pop up :

Scheduled Transactions

Transactions

Freguency | MNext Occurrence D

Upcoming

Su Mo Tu We Th Frr 5a Su Mo Tu We Th Fr 5a Su Mo Tu We Th Fr Sa
i 1[2]3]4]5 172
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16
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m&mmmmom»»mm i 2
11
13
28
i
g
16
22
20

Aug
D

=
Jeo)
=
=]
=
=
=
=
=
i
Sep
Jex
=]
=
=
-
=

lay
Tan

det
=
=
=
=
=
=
=
I~
=
%

Jun

10 14]
ilz] e B i R ila] =3 el D ] e s
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Step two creating scheduled transaction from the editor

This window contains a list, now empty, of all the scheduled transactions. Let's

create a new one by clicking on the "New" button, another window will pop up :
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Edit Scheduled Transaction

Name Recurrence Frequency

Frequency: | Manthly

<o

Start Date: | 18/04/06
Options
Create automatically Every 1| months.
oOnthe| 18th =

Create in advance: days

Remind in advance: days

Occurrences
Last Occurred: (never)
Repeats:
® Forever

Unil

For: oCcumences

remaining

Template Transaction
Edit Tansaction Wew Actions

[T | L] X 3 ¥
Duplicate  Delete Enter cancel Blank Transfer
_unw' _zEs _Un-naﬁss _ _! Funds In =]
| Scheduled|[[ | | [ 1 |
n
. n =]
Enter the transaction number, such as the cheque number
e | | 2 cancel | | @Pox

Step three creating scheduled transaction from the editor

This window may seem complicated but it's fairly easy to understand. First, let's
enter a name for this new scheduled transaction, this name will only identify it in the
Scheduled Transaction Editor, it will never appear in the ledger.

Then we'll enter the transaction's parameters. We know that the subscription is
taken on the 28th each month, so the start date will be Nov 1, 2003 (assuming
November is the next month), the frequency will be "Monthly", it will be taken every
month on the 28th.

In the "Options" tab you have three options :

« "Create automatically" will insert this transaction in the ledger without asking
you before (see below)

« "Create n days in advance" is explicit

¢ "Remind me n days in advance" is explicit and used for example when you have
to pay something by check, GnuCash can remind you one week before so you
send your check before the deadline.
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The End tab allows you to tell GnuCash that this scheduled transaction won't last for
ever, for example if you are repaying a loan, you can enter the loan end date.

Since in our example the internet subscription is automatically taken from the
account, we have no need to create it in advance, nor give an end date.

Finally, enter your transaction in the lower part as you would do in the ledger, with
the only difference of having no date.

Note

Warning: don't use the ENTER key like in the ledger, as it will activate the
default button of the whole window : Cancel. Instead, use TAB to go to the
next field, and when you have finished entering your transaction, click on
the "Enter" button to validate it.

Now, you should have a window like this:

Edit Scheduled Transaction
Name Recurrence Frequency

My Internet Subscription Frequency: | Manthly =

Start Date; | 28/04/06 ~|
Options
Create autornatically Every 1= months.

Create in advance: days  Onthe| 28th :

Remind in advance: days

Occurrences
Last Occurred: (never)
Repeats:
® Forever

SuMoTuMe ThFr Sa  Su Mo Tu e ThFr Sa

Until

For: GECUIENCES

remaining

Template Transaction
Edit Transaction Miew Actions

| + X 4 v
Duplicate  Delete Enter cancel Blank Transfer
_unoo _zEs __unpna!.as _
Scheduled |

[Tot Funds in [Tt Fands Out |~

| internst Subscription | || | |
Assets:checking | n 20
Expensesinternet | n | 20

Scheduled | 1] | [ ] | [

n

£l ID
Enter a description of the transaction

() selo X cancel | | Pox

Validate a scheduled transaction from the editor

Remember to click on the Enter icon, to validate and enter the transaction.
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Now click OK, it takes you to the previous window, now with one item in the list :

Scheduled Transactions:

Transactions

Name Frequency | Next Occurrence

My Internet Subscription Monthly: 28 28/04/06 (Friday)

Upcoming
Su Mo Tu be Th Fr Sa Su Mo Tu ble Th Fr Sa Su Mo Tu We Th Fr Sa
i, 1/2]3[415 112
glelalalole/7]8) P(e]rfa|afi0l11012) 2|34 /616|718 [3
T8 [M0[IT[12 112 (14 [15] (1214 [15[TE[17[18]15] =[10[11 121214 [15[1F
TE[17 18 [15]20 21 [22 20[21 22 (2224 [PR 26 17 [1aT19[20 121 [22]72
2224 (2R [2E (27128123 27128128 301=111 T2 24 2R 12627 (28|25 [20
[172[s5141h Date 28/04/06 2[4[6[6
7189 1011 [1F 10 [11[12]12]
=415 1617 1A 18 s [17 118115 [20]
21 (2222124 (IR 2% Name Fregquency 3[24[26]2F [27]
28[3T=0(=1]1 12 . E[I]2]=
s[4 [h 67 [a]49 My Internet Subscription Monthly: 28 7 [5]3[10
bt i e e T e Y W - A e P W o i e B e G
18[19 120 [21 [ 123124 22[22 124 [PR 2B [27 28 1819120 [21 (272574
il A el R EEL R AAlZ0=1[1[2[2T4 pelal A el O
=S[2[2T48[E[7[8] z[lE[71a[3[10[11] s[4 [ [E[7F &[T [10
S8 M0 [12 112 [14[15] = [12[15]14 [TR[16[17[18] = [11[12 [12[14 [T5[1E[17
IE[17 18 [15]20 21 [32 1812021 [Z2]22 [24 |25 1819120 21 (272224
WM mu Zh 277128123 2R[27 1282930 28 (PR [27 2812930 31

X Close

Validate a scheduled transaction from the editor

If you click in the calendar part on the first day of one month, a small window,
following your mouse, will show you what is planned for this day. To make the small
window dissapear again, just click in it one more time.

You can now close the Scheduled Transaction Editor window, and save your work.
Note

What comes below is just an illustration, and is not meant to be entered
into the GnuCash database at this stage. As per this example, the below
dialogs will appear when the scheduled transaction is supposed to run.

From now on, on each first day of month (or the next time you launch GnuCash after
this day) a windows will pop up to remind you to create this transaction :
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Mame State

& My Internet Subseription
28/04/06 :

Template Transaction (Read-Only)

| Assets:Checking | n |
met n 20

Dispostion? | 2|

variables
vanable Value

Value:

Scheduled [ [oescr ]

e nl
C1}

[ 2 cancel _

4 Back _ & Forward #

Scheduled transaction popup reminder

You can click on the list entry to see the detailed transaction in the lower part, then

just click on Forward to advance.

When you click Forward, a window summarizing all transactions to be created will

appear :

Since Last Run

Created Transaction Review

Edit Tansaction Mew Actions

B o + X i

Duplicate  Delete Enter cancel EBlank

2B/04/05 Internet Subscription

Jump  Schedule

0 4

| Expensesintemet | n
Assets:Checking  n

10.00 |

I _ _

IG

| et 5 S

Iv]

Enter a description of the transaction

[ % cancel |

4 Back & Forward

Scheduled transaction summary

In this window you can adjust the transactions that will be created. For example
month my ISP made a special offer and my subscription only costed 10EUR, so I just

modified the amount from 20 to 10.
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When you have finished with this window, just click Forward and on the next window
click Apply. The window will disappear and the transactions will be created.

Then if you take a look in your bank account, you'll see the transaction has been
created :

le gdit View Tapsaction Actions Business Beports Bols Windows Help

= B W + X : H = @ =

Save Clase Duplicste  Delete Erter  Cancel alank Split Jump  Schedule
f@ Accounts | fl Checking @ Salary

1410306 Employers RUs -- Splt Fansaction - | n | 670.00 1624.78
28/03/05 Intermet Subscription| Expensesintemst | n 20.00 | 1.604.79
28/00/06 |imemet Subscription Expensesantemet [ n w00 159475] [

4l
Prasent;USD 160479 Future:USD 1,504.7% Cleared:USD 0.00 Aeconciled:USD 0,00 Projacted Minimum: LSD 1,564.78

Employers A Us

Scheduled transaction created transaction
Note
If you entered the transaction for 28 of April at this stage, then please

revert back to the last saved GnuCash file. File -> Open and choose
gcashdata_3

Putting It All Together

In the previous sections of this chapter the concepts and mechanics of working with
transactions in GnuCash have been discussed. This section will expand upon the
chart of accounts initially built in the previous chapter, by setting some opening
balances, adding transactions and a scheduled transaction.

Open GnuCash file

Start with opening the previous datafile we stored, gcashdata 3emptyAccts, and store
it as gcashdata_4 directly. The main window should look something like this:
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= m

Save MNew

i Accounts

Account Name ¥ Type Commodity Total 3
P fm Assets Asset Us Dollar UsD 0.00

b fm Equity Equity  US Dollar USD 0.00

I @ Expenses Expense US Dollar USD 0.00

P fm Income Income  US Dollar USD 0.00

b fm Liabilities Liability US Dollar USD 0.00

USD, grand total: Assets: USD 0.00 Profits: USD 0.00 -

This image shows the starting point for this section.
Opening Balances

As shown earlier with the Assets:Checking account, the starting balances in an
account are typically assigned to a special account called Equity:Opening Balance.
To start filling in this chart of account, begin by setting the starting balances for the
accounts. Assume that there is $1000 in the savings account and $500 charged on
the credit card.

1. Open the Assets:Savings account register. Select View from the menu and check
to make sure you are in Basic Ledger style. You will view your transactions in
the other modes later, but for now let's enter a basic transaction using the basic
default style.

2. From the Asset:Savings account register window, enter a basic 2 account
transaction to set your starting balance to $1000, transferred from
Equity:Opening Balance. Remember, basic transactions transfer money from a
source account to a destination account. Record the transaction (press the
‘enter' key, or click on the 'enter' icon).

3. From the Assets:Checking account register window, enter a basic 2 account
transaction to set your starting balance to $1000, transferred from
Equity:Opening Balance.

4. From the Liabilities:Visa account register window, enter a basic 2 account
transaction to set your starting balance to $500, transferred from
Equity:Opening Balance. This is done by entering the $500 as a "charge" in the
Visa account (or "decrease" in the Opening Balance account), since it is money
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you borrowed. Record the transaction (press the 'enter' key, or click on the
'‘enter' icon).

You should now have 3 accounts with opening balances set. Assets:Checking,
Assets:Savings, and Liabilities:Visa.

gcashdata 4 - Accounts
File Edit View Actions Business Reports Tools Windews Help

= W

MNew Delete

Edit

Save Open

@ Accounts

Account Name v  Type Commadity Total 3 [=]
|- & Assets US Dollar USD 2,000.00
@ Checking  Bank US Dollar USD 1,000.00
i Savings Bank us Dollar UsD 1,000.00
D fm Equity Equity US Dollar USD 1,500.00
b % Expenses Expense LS Dollar UsD 0.00
P fm Income Income us Dollar USD 0.00
= g Liabilities Liability US Dollar USD 500.00
i Visa Credit Card US Dollar LSD 500.00 _W_
~ .

USD, grand total:  Assets: USD 1,500.00  Profits: USD 0.00 o_

This image shows the opening balances.
Additional Transaction Examples

Now add some more transactions to simulate a month's expenses. During the month,
$78 is spent on electricity, $45 on phone, and $350 on rent. All paid by check.We
also spend $45.21 on groceries, receive $670 as salary, and paids our Internet bill
this month, Finally, let's move $100 from the savings account to the checking
account.

1. Open the Expenses:Electricity account register and enter a simple 2 account
transaction to pay the $78 electrical bill at the end of the current month (eg:
March 28, 2006). Enter a description (eg: Light Company) and the check number
(eg: 102). The Transfer account should be Assets:Checking.

2. Open the Assets:Checking account register and enter a simple 2 account
transaction to pay the $45 phone bill at the end of the current month (eg: March
28, 2006). Enter a description (eg: Phone Company Name) and the check
number (eg: 103). The Transfer account should be Expenses:Phone. Notice that
you can enter expense transactions from either the credit side (the expense
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accounts) or the debit side (the asset account).

. Open the Expenses:Rent account register and enter a simple 2 account
transaction to pay the $350 in rent at the end of the current month (eg: March
28, 2006). Enter a description (eg: April Rent) and the check number (eg: 104).
The Transfer account should be Assets:Checking.

. Duplicate this transaction using the Duplicate button in the tool bar. Start by
clicking on the current rent transaction, and click on the Duplicate icon. Enter
the transaction date a month out in the future (eg: April 28, 2006), and notice
the blue line separator that GnuCash uses to separate future transactions from
current ones. In this way, you can enter transactions before they occur.

You could also set up a scheduled transaction to pay your rent, since the value of
the rent is likely to be constant for the foreseeable future.

o Start by clicking on the current (April 28) rent transaction, and click on the
Schedule icon

« Change to Monthly, change description if needed and press OK

. To transfer money from your savings account to your checking account, open the
Assets:Savings account register, add a new transaction setting the Transfer to
Assets:Checking in the amount of $100 (date 6 March, 2006).

. As another example of a simple 2 account transaction, add another transaction
to describe the purchase of $45.21 worth of groceries on 5 of March. From
within the Assets:Checking account, you would set Transfer to
Expenses:Groceries. The account register should now appear:

. To add a paycheck transaction from the Assets:Checking account register
window, click on a new transaction line, and click on Split. First enter the
description of this transaction on the first line (eg: "Employers R Us"), as well as
the date (14 March). In the "split" line below this, enter the deposit into
Assets:Checking (eg:$670) (This is due to a current bug, that demands the first
line in a split is the actual account). Follow this with the various tax deposits
(Assets:Checking (eg: $670), Expenses:Taxes:Federal (eg: $180),
Expenses:Taxes:Medicare (eg: $90), and Expenses:Taxes:Social Security (eg:
$60)) and lastly the gross total of your paycheck (eg: $1000) as a withdrawal
transfer from Income:Salary.

. You also need to pay for your Internet subscription of 20 USD on the 28th.
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gcashdata 4 - Accounts

File Edit Mew Actions Business Reports Tools Windows Help
= (] i )
Save Open  Edit MNew Delete
il Accounts
Account Name ¥  Type Commeadity Total | [=]
= | Assets US Dollar UsD 1,781.79
fm Checking  Bank US Dollar UsD 881.79
i Savings Bank US Dollar UsD 900.00
P fm Equity Equity Us Dollar USD 1,500.00
= f Expenses Expense  US Dollar UsD 1,218.21
i Electricity Expense  US Dallar UsD 78.00
i Groceries Expense  US Dollar uUsD 45.21
f® Internet Expense LS Dollar USD 20.00
fm Phone Expense S Dollar USD 45.00
fiw Rent Expense  US Dollar UsD 700.00
- 3 Taxes Expense LS Dollar UsD 320.00
fm Federal Expense  US Dollar UsSD 180.00
fi Medicare Expense  US Dollar USD 90.00
i Social Se Expense  US Dollar USD 60.00
P fm Income Income us Dollar UsD 1,000.00
I fm Liabilities Liability US Dollar UsSD 500.00 @
_CmU\ grand total: Assets:USD 1,281.79 Profits: -USD 218.21 =+

This image shows the ending balances after Chapter 4, Transactions.
Save file
Before we go to the report section, let's save the GnuCash data file (gcashdata_4).
Reports
But only having data available on the computer screen will not make your
accountant happy, therefore GnuCash comes with a large number of highly
customizable reports.

Note

More details on the reports will be in the Report chapter

Let's have a look at a Cash Flow, and a Transaction Report.
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1. First let's have a look at the Cash Flow report for the month of March. Transaction Report
From 01/03/06 To 31/03/06

Select the cash flow report from Reports -> Income & Expense -> Cash Flow Date Num Description  Transfer fromfto  Amount
Checking
Cash Flow - 01/03/06 to 31/03/06 for 05/03/06 Groceries Groceries -UsSD 45.21
Selected Accounts 06/03/06 Transfer Savings USD 100.00
@ Assets 14/03/06 Employers R Us Split UsD £70.00
@ Assets:Checking 28/03/06 Internet subscription Internet -USD 20,00
@ Assets:Savings 28/03/06 102 Light Company Electricity -USD 78.00
28/03/06 103 Phone Company Phone -UsD 45.00
Money into selected accounts comes from 28/03/06 104 April Rent Rent -WJSD 350.00
Income:Sala USD 1,000.00 Total For Checking UsD 231.79
Money In USD 1,000.00
Grand Total USD 231.79
Money out of selected accounts goes to
Expenses:Electricit UsD 78.00 This image shows the Transaction Report for the Checking account during
Expenses.Groceries UsD 45.21
March.
Expensestinternet USD 20.00
Expenses:Phone USD 45.00 ' . .
% anses e 3. Now let's change the transaction report to only show the various Expenses
Expenses Taxes:Federal UsSD 180.00 accounts.
Expenses Taxes:Medicare USD 20.00 .
Expenses Taxes:Social Security UsD 60.00 Transaction Report
Money Out USD 868.21 From 01/03/06 To 31/03/06
- Date Num Description Transfer fromfto  Amount
Difference uUsD 131.79 P
05/03/06 Groceries Checking USD 45.21
This image shows the Cash Flow report after Chapter 4, Transactions. 14/03/06 EmployersRUs  Split USD 180.00
14/03/08 Employers R Us Split UsSD 90.00
To get this customized report, right click in the report and choose Report 14/03/06 mago%mamcm mng . USD 60.00
K : : . : : 28/03/06 Internet iption Checki USD 20.00
Options. Then set the time period, and specify which accounts you want in the /03] nternet subseription thecng =22
28/03/06 102 Light Company Checking UsD 78.00
report 28/03/06 103 Phone Company Checking USD 45.00
A . . 2B/03/06 104  April Rent Checking USD 350.00
2. Now let's have a look at corresponding transaction report for the Checking Total For March 2006 USD 868.21
account.
Grand Total USD 868.21

Select the transaction report from Reports -> Transaction Report
This image shows the Transaction Report for the various Expense accounts
during March.

Chapter 5. Checkbook

Table of Contents

Setting up Accounts

Entering Deposits

Entering Withdrawals
ATM/Cash Withdrawals
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Reconciling Your Accounts
Putting It All Together
Opening Balances
Add some transactions
Opening Balances
Save file
Reports

This chapter will give you all the specific information you need to manage your
checkbook with GnuCash. Managing your checkbook register is the first step of
tracking your finances, and GnuCash makes it much easier to manage than the
traditional paper register does.

For one thing, as discussed in Chapter 4, Transactions, data entry of common
transactions is practically done for you in GnuCash, because of its auto-completion
feature. GnuCash keeps a running balance of each account, and it makes reconciling
these accounts easy. And the double-entry method helps you account for your
spending by requiring a transfer account for withdrawals, so you can easily find out
how much money you spend in different areas.

Once you are comfortable with using GnuCash for your checking and other bank
accounts, you may wish to continue on with tracking other financial accounts.
Chapters 6 through 9 examine methods to manage your other accounts.

Setting up Accounts

The first step in managing your checkbook is to set up the necessary accounts. You
can either use the default GnuCash accounts or set up your own. For more detail on
how to set up a new account, refer to the section called “The Basic Top Level
Accounts”. For instructions on importing your accounts from another program, refer
to the section called “Importing QIF Files”.

Let's start with the bank accounts you'll need. You need one GnuCash bank type
account for each physical bank account you wish to track. If you are setting up your
own accounts or using the default GnuCash accounts, make sure that you have an
opening balance transaction for each bank account you own. The easiest way to get
this number is to use the balance from your last bank statement as your opening
balance. You can enter this in the account information window automatically as part
of the New Account Hierarchy Setup druid, or you can enter a manual transaction
directly in the account. To enter the transaction manually, enter a transfer from an
Opening Balances account (type equity) to the bank account.

The typical bank accounts you might track include:

e Checking - any institutional account that provides check-writing privileges.

93 de 273

e Savings - an interest-bearing institutional account usually used to hold money for
a longer term than checking accounts.

Common transactions that affect these bank accounts are payments and deposits.
Payments are transfers of money out of the bank account, usually to an expense
account. Deposits are transfers of money into the bank account, usually from an
income account. You will need to set up income and expense accounts to track
where that money comes from and where it goes. Remember that a balanced
transaction requires a transfer of an equal sum of money from at least one account
to at least one other account. So if you deposit money in your checking account, you
must also enter the account that money comes from. If you pay a bill from your
checking account, you must also enter the account where that money goes.

Entering Deposits

Most deposit transactions are entered as a transfer from an income account to a
bank account. Income may come from many sources, and it's a good idea to set up a
separate income type account for each different source. For example, your income
may come mainly from your paychecks, but you may also receive interest on your
savings. In this case, you should have one income account for salary and another
income account for interest income.

Tip

Be sure to check the Tax-Related box and assign an appropriate tax
category in the Income Tax Information Dialog (Edit -> Income Tax
Options) when you set up taxable income accounts. Some types of income,
such as gift income, may not be considered taxable, so check the
appropriate tax rules to determine what is taxable. For ways to track
capital gains income, refer to Chapter 9, Capital Gains.

Before you start entering paycheck deposits, decide how much detail you want to
track. The basic level of detail is to enter your net pay, just like you would in your
paper register. This is easiest, but you can get even more information out of
GnuCash if you enter your gross pay with deductions. It takes a bit more effort to
enter the deductions, but entering your tax withholding information throughout the
year allows you to run useful tax status reports in GnuCash at any time. These
reports can help you determine whether you are withholding enough tax, and they
can help you estimate your tax bill ahead of time. If you are unsure about the level
of detail, start by entering net pay. You can always go back and edit your
transactions later if you decide you want more detail.

Entering Withdrawals
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When you withdraw money from your bank account, for whatever reason, you are
transferring money from your bank account to some other location. In GnuCash, this
other location is tracked as an account. The more detailed accounts you create and
use for your spending, the more information you will get about where your money
goes.

Withdrawals take many forms. ATM withdrawals are one of the most common
transactions. Writing checks is one way to withdraw money to pay bills, to buy
purchases, or to give to charity. Depending on your bank, you might also have
service charges, where the bank withdraws the money from your account. Transfers
of money out to another account are also withdrawals. We will take a look at each of
these types of withdrawals and how to record them in GnuCash.

ATM/Cash Withdrawals

Cash withdrawals are handled as a transfer from a bank account to a cash account.
GnuCash provides special Cash type accounts for tracking your cash purchases, so
you should set up a cash account to record your ATM and other cash withdrawals.

Cash accounts can be used for different levels of detail. On a basic level of detail,
you simply transfer money to it from your checking account. That tells you how much
money you took out of checking on a given day, but it doesn't tell you where that
cash was spent. With a little more effort, you can use the cash account to record
your cash purchases as well, so that you can see where that cash went. You record
these purchases as a transfer from the cash account to expense accounts.

Some people record every cash purchase, but this takes a lot of work. An easier way
is to record the purchases for which you have receipts, but then adjust the balance of
the account to match what is in your wallet.

It's a good idea to at least set up a cash account for your withdrawals. Then if you
decide to track where your cash goes, you can enter transactions for the money you
spend. You determine what level of detail you want to use.

Reconciling Your Accounts

GnuCash makes reconciliation of your bank account with your monthly bank
statement much easier. the section called “Reconciliation” gives instructions on how
to reconcile your transactions with the monthly bank statement. This is the main
reconciliation task that should be done every month.

But what about all those other accounts you created? Should those be reconciled
too? If you receive a statement for the account, then you should consider reconciling
that account. Examples include the checking account statement, the savings account
statement, and the credit card statement. Credit card statements and credit card
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transactions are covered in the Chapter 6, Credit Cards, so if you are interested in
tracking your credit cards in GnuCash, take a look at the instructions provided
there.

Income and expense accounts are usually not reconciled, because there is no
statement to check them against. You also don't need to reconcile cash accounts, for
the same reason. With a cash account, though, you might want to adjust the balance
every once in a while, so that your actual cash on hand matches the balance in your
cash account. Adjusting balances is covered in the next section.

Putting It All Together

In Chapter 4, Transactions, you entered some transactions in your checking account.
In this chapter, we will add more transactions and then reconcile them.

Opening Balances

So, let's get started by opening the gcashdata file you saved in the last chapter
(gcashdata_4). Your chart of accounts should look like this:

gcashdata_4 - Accounts

File Edit \iew Actions Business Reports Tols Wndows Help
= i
Save New
@ Accounts
Account Name ¥  Type Commodity Total &
- @ Assets Asset US Dollar UsSD 1,781.79
fm Checking Bank US Dollar UsD 881.79
m Savings Bank Us Dollar UsD 900.00
b @ Equity Equity Us Dollar USD 1.500.00
= @ Expenses Expense Us Dollar uUsD 1.218.21
i Clothes Expense US Dollar USD 0.00
m Electricity Expense US Dollar UsD 78.00
fm Groceries Expense US Dollar USD 45.21
fm Internet Expense US Dollar USD 20.00
& Phone Expense US Dollar USD 45.00
fm Rent Expense US Dollar USD 700,00
D Taxes Expense Us Dollar UsD 330.00
P @ income Income uUs Dollar UsD 1,000.00
b g Liabilities Liability USs Dollar USD 500.00
$. grand total: Assets: $0.00 Profits: $0.00 N
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This image shows the Checking Account Register after registering some more
checks.

This image shows the Chart of Accounts.

Add some transactions

3. Suppose you now need to withdraw some money. You don't have a cash account
set up in your chart of accounts, so you will need to create one. Create the
account as Cash as a top-level account of type Asset. From your Checking
account register, enter an ATM type withdrawal to transfer $100 from Checking
to Cash on the 25 of March.

1. Now open the Checking account from the main window. In the last chapter, you
entered some paycheck transactions as deposits into Checking. Now we will
enter another kind of deposit - a transfer of money from Savings into Checking.
On a blank line, enter a transaction to transfer $500 from Savings to Checking
(In this case, the last transaction date was March 28, but this transfer
transaction took place on the March 24). Your Transfer account will be Savings,

) grashdata 4 - Checking
m__wm%53:359??5:.m_._m_i:mnna:.wﬁE:%...u%

i i i i @ *x © @ + x 3 H = @ -
since you are in the Checking account. Your Checking account should now look 2 L. e e XlE H o= e
: | Accounts| @ Checking |t cash
like this: & & cheding|@
rfer Honey ST [ .
clmddiide ) i) 2510306 ATM withdrawa| AssetsCash | n 10000 1.989.79
Ele Edit View Trapsaction Actions Business Qeports Bols Windews Help ZB{OIOE Intermet Subscnption Expensesintemet | n 0 00 —hua‘._.al,
. 20306 [ 102 | Light Company n 7e00| 185179
B x fn} + X 2 H w0 ¢ 2
Save Close. Duplicate Uamﬂo Enter Cancel Blank split Jump  Schedule v BN [ R [ERESNERETE [ B L FORTH
P 280306 [ 104 | April Rent ExpensesRent | n 350.00 | 1.456.79
|k Accounts| @ Checking 80406 My Rent Expenses:Rent | n 35000 | 110679
Data rum [De: 3 FUNOE n =)

_[withdrawal [Galance |1 )
00 172479 Fresent: USD 145675 Future:USD 1,106.76 _Cleared-USD 554.79 _Pecanciled:USD 0.00 _Projected Mnimum USD 1.106.79

T Employers R Us -- Spit Transaction - n | &
24/D3/06 Transfer Money Asselssavings | n | 500.00 ol | 222879 L ATH Withdrawal
2006 Internet Subscnption n 20.00| 220479
#ay6306 (102 |Light Compary Expenses Blectricty | n re.00| 212678
e Db T This image shows the Checking Account Register with an ATM withdrawal.
280406 May Rent n 350,00 | 1.381.79
17/04j06 n

Opening Balances

. - m - o)
Present:USD L.731.78 Future:USD 1,381,79 _Cleared:USD 654,79 Pecanciled:USD 0.00 _Projected Mnimum; USD 1.391.79
Transfer Maney

This image shows the Checking Account Register. Now we are ready to reconcile this Checking account, using this sample bank

statement:
2. Now let's write some checks on this account. First, write a check to HomeTown bate Descrini - -
. N N ) escription Decreasing Increasing Balance
Grocery for $75 (5 of March). Your transfer account is Groceries, since all of this — — —
. . . . e X
money is going to buy groceries. Next, write a check to ABC Hardware for $100 510372006 Check 101 Gracery Store ’ e 475
(6 of March), and split this amount between two expenses: Household $50 and 6032008 Transfer 0000 1pse7e
. BM320086 Check:106:ABC Hardware 10000 954.79
Tools $50. You will need to create an expense type account for each of these, 14/03/2006 Salery 67000 152479
then enter splits for them. Your checking account should now look like this; e L == R R
25/032006 ATM 100.00 194979
a 28/03/2006 Chack: 102 Light Company 78.00 1871.79
Fle Edit Wiew Tansaction Actions Business Beports Bols ‘Windows Help 23/03/2006 Check: 103 Phone Company 4500 182679
=1 Apartment 4 Rent 350,00 147679
I N . O P B 14570
R 31/03/2006 Service Charge 500 145179
|t Accounts @ Checking | X
i v 31032008 Ending Balance 1,451.79
0L/0306 Opening Balance Balance | ¢ | 1.000.00 1,000.00
OS/0H06 | 101 | Graeery Stare 2 4521 95479 ..
5103005 105 | vameToun Gracery n Tso0| s7ae This image shows a sample Bank Statement.
ss1o3108 o loaow I
[ oaiozoe|108 w000 arers
[ 70 .08 549, 7 1 M 1 1
2o [rans ey D e 1. Select Actions -> Reconcile from the menu, and fill in the Closing balance as
A R | R =k “ T LR $1451.79. Click OK to begin reconciling the account. Check off the entries as
28/0306 | 102 | Light Company n 78.00| 185179
25103105 [163_|hone Company Expenses share | n sso0] 150872 they appear on the sample statement. When you have checked off all your
28/03/06 [104_| Apol Rent n 350.00 | 155679 | — . ) o . A
_saouce] [y et Expansesfont| 0 zso00] 120678 o) entries, the reconcile window should look like this:
Present: USD 1.556.79 Fulure:USD 1,206.78 Cleared:USD 854,78 Reconciled: USD 0.00 g_mnﬁmalzﬁzuclﬁwnuu:—..
ABC Hardware
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Beconcile Account Tansaction Help

0O B @ o « X

New Edit Delste Open Postpone  Cancel

Funds In Funds Cut

Date ¥ Num  Description Amount R [ Dste ¥ Num  Description Amount R ||

0103706 Opening Balance  1,000.00 - 050306 101 Grocery Stors 4521 -

D306 Wansfere Money  100.00 - 05/03(06 105 HomeTown Grace  75.00

14/03/06 EmployersRUs 67000 ~ OB/0I06 106 ABC Hardwara  100.00 +

2403106 Tansfar Monay 50000 - 25/03/08 ATM Withdrawal  100.00
28/03/08 2000 -+
280306 102 7R.00
280306 103 4500 -
280306 104 3000 ~
28/02/08 May Rent 350,00

Totak USD 2.270.00 Total; USD 813.21

Starting Balance:  USD 0.00
Ending Balance: USD 1,451.7%
Reconelled Balance: USD 1.456.78
Difference: -USD 5.00

This image shows the reconcile window with a $5 difference.

Notice that your reconciled balance differs from your ending balance by $5.00. If
you look at the sample bank statement, you will see there is a $5.00 service
charge that has not been added to your Checking account.

2. So click on the Checking register and add the $5.00 service charge to your
Checking account. On a blank line of the Checking register, enter a transaction
to transfer $5.00 from Checking to a Service Charges account. (You will need to
create the Service Charges account as type expense.) Use the transaction date
printed on the sample statement as the date you enter for this transaction. Your
Checking account should now look like this:

3 geachdata 4 - Checking

EBle Edit View Tapsaction Actions Business Beports Dol Windows Help
B x o @ + X 2 B = ¢ -
swe  Closa  Duplicats  Oalata Emter  Cancel Blank spit  ump  Schoduls

|f Accounts @ Checking |§ Cash

280306 [ 102 |Light Company n 7800| 185179
28/D306 103 _|Phone Campary Expenseshone | n 4500| 180678
ZB/D306 | 104_| Apeil Rent Expenses:Rent | n 350.00| 1.456.73
310306 Senvice Chargd Expanzesiserice Chargs | n 00| Las179
28/04/06 May Rent n 350.00| 110179
31/03(06 n -

Present USD 45179 FuureiUSD 110175 _Clearsd:USD 054,79 Peconclled:USD 0.00_Projested Mnimum USD 1.
Sanvica Charge

This image shows the Checking Account Register with service charge added.

3. Click back on the Reconcile window, and you should see the service charge now
under Funds Out. Click on it to mark it as reconciled, and note that the
difference amount below now becomes 0.00. Click the Finish button on the tool
bar to complete the reconciliation. The Reconcile R column in your Checking
register should now show y for each transaction you just reconciled. Also observe
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the bottom status row that now indicates "Reconciled: USD 1451.79"

] gcashdats 4 -
m,am!s!#u:&osm?.amcuzu:was:?_uu_;&iu%

B * B @ + x 2 BH ® ¢ & .

Save  Close  Duplcate Delete Enter  Cancel Blark  splt  ump  Schedule  Tansfer

& Accounts| @ Checking |@ cash|

61,9306 Opening Belance ¥ | 1000 00
©5/03/06 | 101_| Grocery Store ¥ 521

050306 [ 105 _|HomeTown Grocery. ¥ 75.00 l
05103108 Tramsfars Maney v | 10000

D5/03/06 | 106 | ABC Hardwars ¥ 100 00 |
1410306 Errgloyars A Us y | 67000 154879
240308 Transfer Money ¥ | sooo0 204878 |
=306 AT withdrawal Assatecash | y 1000| 184679
BT Crer : = a0 Lezeaa]
78,0305 | 102_|Light Company Expensas Elestricity | y 7800 185179
28/03/06 [ 103_[Phane Company Expersesshone [ v 4500 I
28,0306 | 104_| Agril Fent Expensesfent | v 350.00

310306 Senice Charge| charge 500 1
28104106 May Rent Expensesert | n 350.00 =

5
78 Future:USD 110176 Cleared:USD 145179 Reconciled USD 145175 Projected Miimum; USD 110178

This image shows the reconciled Checking Account Register.

Save file

Go back to the main window and save your file with the new gcashdata 5 name. Your
chart of accounts is steadily growing, and it should now look like this:
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gcashdata 5 - Accounts Cash Flow - 01/03/06 to 31/03/06 for

File Edit Mew Actions Business Reports Tools Windows Help Selected Accounts
@ Assets:Cash
@ @ @ @ Assets:Checking
Open MNew Delete @ Assets:Savings
& Accounts |
7 Money into selected accounts comes from
PR G > | Bpe Commedity Total & Equity:Opening Balance USD 2,000.00
~ @}mmmﬁm Asset Us Dollar usD 1,601.79 Income:Sala USD 1,000.00
i cash US Dollar USD 100.00 Lloneyiln ZERT Zh el
ffi Checking Bank Us Dollar LSRRI 29 Money out of selected accounts goes to
fm Savings Bank Us Dollar UsSD 400.00 Expenses:Electricit USD 78.00
Db Equity Equity Us Dollar USD 1,500.00 Expenses:Groceries UsDh 120.21
~ fm Expenses Expense Us Dollar USD 1,398.21 Expenses:Household USD 50.00
Expenses:nternet UsD 20,00
fim Clothes Expense s Dollar UsD 0.00 ExpensesPhone USD 45.00
i Electricity Expense US Dollar UsD 78.00 Expenses:Rent USD 350.00
fm Groceries Expense us Dollar uUsD 120.21 Expenses:Service Charge UsD 5.00
E Taxes:Federal UsD 180,00
fm Household Expense uUs Dollar USD 50.00 e m._.m
Expenses Taxes:Medicare USD 90.00
@ Internet Expense US Dollar usD 20.00 Expenses:Taxes:Social Securit UsSD 80.00
fm Phone Expense Us Dollar USD 45.00 ExpensesiTools USD 50.00
fi Rent Expense Us Dollar UsD 700.00 Money Out USD 1,048.21
i Service Charge  Expense Us Dollar UsD 5.00 Difference USD 1,951.79
P fm Taxes Expense us Dollar UsD 330.00
f52 Tools Egmmsn WS ek e ER This image shows the Cash Flow report after Chapter 5, Checkbook.
fm Imbalance-UsSD Bank us Dollar UsD 0.00
b Income Incorne US Dollar USD 1,000.00 2. Now let's have a look at corresponding transaction report for the various Asset
I fm Liabilities Liability US Dollar UsSD 500.00 accounts.
fm Orphan-USD Bank Us Daollar UsD 0.00 ) .
Select the transaction report from Reports -> Transaction Report
[usp: Assets: USD 1,101,79 Profits: -USD 398.21 ]
(I

This image shows the Chart of Accounts.
Reports

As we did in the previous chapter, let's have a look at a Cash Flow, and a
Transaction Report.

1. First let's have a look at the Cash Flow report for the month of March.

Select the cash flow report from Reports -> Income & Expense -> Cash Flow
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Transaction Report

From 01/03/06 To 31/03/06

Date Num
Cash
25/03/08
Total For Cash
Checking
01/03/08
05/03/06 101
05/03/06 105
06/03/08
06/03/06 106
14/03/06
24/03/08
25/03/08
28/03/06 102
28/03/06 104
28/03/08
28/03/06 103
31/03/086

Description Transfer fromjto

ATM Withdrawal Checking
Opening Balance Opening Balance
Grocery Store Groceries
HomeTown Grocery Groceries
Transfere Money Savings

ABC Hardware Split
Employers R Us Split

Transfer Money Savings

ATM Withdrawal Cash

Light Company Electricity

April Rent Rent

Internet Subscription Internet

Phone Company Phane

Service Charge Senvice Charge

Total For Checking

Savings

01/03/06
06/03/06
24/03/08

Opening Balance Opening Balance
Transfere Money Checking
Transfer Money Checking

Total For Savings

Amount

UsD 100.00
USD 100.00

UsD 1,000.00
-JsD 45.21
-UsD 75.00
UsD 100.00

-UsD 100.00
USD 670.00
UsSD 500.00
-UsD 100.00
-JsD 78.00
-UsD 350.00
-UsD 20.00
-UJsD 45.00
-USD 5.00

usD 1,451.79

USD 1,000.00
-USD 100.00
-UsD 500.00

USD 400.00

Grand Total

This image shows the Transaction Report for the Assets accounts during March.

3. Now let's change the transaction report to only show the various Expenses

account.

Transaction Report

From 01/03/06 To 31/03/06

uUsD 1,951.79

Date Num Description Account Amount
05/03/06 101 Grocery Store Groceries UsD 4521
05/03/06 105 HomeTown Grocery Groceries USD 75.00
06/03/06 106 ABC Hardware Househaold USD 50.00
06/03/06 106 ABC Hardware Tools USD 50,00
14/03/06 Employers R Us Federal USD 180.00
14/03j08 Employers R Us Social Security UsD £0.00
14/03/06 Employers R Us Medicare USD 90.00
28/03/06 Internet Subscription Internet UsD 20.00
28/03/06 104 April Rent Rent USD 350.00
28/03/06 102 Light Company Electricity UsD 78.00
28/03/06 103 Pheone Company Phane USD 45.00
31/03/06 Senvice Charge Service Charge USD 5.00
Grand Total UsSD 1,048.21
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This image shows the Transaction Report for the various Expense accounts
during March.

Notice that you have not yet used one of the accounts listed in your chart, the Credit
Card account. Now that you know how to keep track of your bank and cash accounts
in GnuCash, you may want to start tracking your credit cards as well. GnuCash
provides a special type of account for credit cards, and this is discussed in the next
chapter.

Chapter 6. Credit Cards

Table of Contents

Concepts
Setting Up Accounts
Simple Setup
Complete Setup
Entering Charges
Entering Payments
Putting It All Together
Open GnuCash file
Purchases
Refund
Interest Charge
Reconciliation
Payment
Save file
Reports

This chapter will show you how to manage your credit cards using GnuCash.

Concepts

Since you probably write a check or make an electronic payment to the credit card
company each month, you may think of your credit card bill as an expense - but it
really is not an expense. Why? A credit card account is a short-term loan - you buy
things on that loan account, and then you eventually have to pay back the money,
often with interest (your finance charge). The purchases you make with that credit
card are your expenses.

You have a couple of options when entering credit card transactions, so choose the
one that fits your desired level of detail. The simplest method is to simply track
monthly payments to the credit card company. From your bank account, you enter a
transfer of money each month to the credit card expense account. This will show you
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the amount of money you are paying each month to the credit card company, but it
won't show you any information about your credit card balance or credit card
purchases.

A more complete way to track your credit card in GnuCash is to enter each purchase
and payment as a separate transaction. Using the credit card account register, you
enter your receipts throughout the month. When your credit card statement arrives,
you reconcile the credit card account to the statement, and you enter your payment
as a transfer of money from your checking account to your credit card account. This
method gives you more information about your balance during the month and points
out any discrepancies during reconciliation, but you will have to do more data entry.

Setting Up Accounts

To begin managing your credit cards in GnuCash, you should set up a "Liability" top
level account and under this parent account create credit card type accounts for
each credit card you use. If you are tracking only the payments you make to the
credit card company, then all you need is a bank account and a credit card account
to enter your transactions.

The charges you make on your credit card are expenses, so you will have to set up
these accounts under the top-level account called "Expenses". If you decide to keep
a more detailed records of your purchases, you will need to create expense accounts
for each kind of purchase you make. Since you will also be reconciling the balance
to your credit card statements, you should also enter an opening balance in each
credit card account. The easiest way to do this is to use your last statement balance
as the opening balance.

Simple Setup

If you do not want to track each expense made on the credit card, you can set up a
simple account hierarchy like this:

-Assets
-Bank
-Liabilities
-Credit Card
-Expenses
-Credit Card

In this example, if you enter your total amount charged per month as a transaction
between “Liabilities:Credit Card” and “Expenses:Credit Card”. When you make a
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payment, you would enter a transaction between “Assets:Bank” and
“Liabilities:Credit Card”.

The obvious limitation of this simple credit card setup is that you cannot see where
your money is going. All your credit card expenses are being entered in the Credit
Card expense account. This is, however, very simple to set up and maintain.

Complete Setup

If you want to track your expenses more completely, you should set up multiple
expense accounts named for the various kinds of expenses you have. Each charge on
your credit card is then entered as a separate transaction between your Credit Card
liability account and a specific expense account. Below is an example of an account
hierarchy for this:

-Assets
-Bank
-Liabilities
-Credit Card
-Expenses
-Food
-Car
-Clothes
-Entertainment
-Interest
-Service

Clearly, you should enter specific expense accounts which fit your spending habits.
The only difference with this setup as compared to the simple setup is that the
expenses have been subdivided by groups. Also notice that there is an "Interest"
expense, this is used for when your credit card charges interest on your monthly
unpaid balance. The "Service" expense account is used to track service expenses
associated with the credit card, such as the yearly usage fee if it exists. With this
setup, you will be able to see where your money goes every month, grouped
according to the expense accounts.

The rest of this chapter will assume you are using the complete setup.

Entering Charges

Entering your charges provides you with a more complete picture of your spending
habits. Charges on a credit card are tracked as a transaction between the credit
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card liability account and the appropriate expense account.

When you swipe that credit card through the machine at a store, you are
transferring money from your credit card company to that merchant. This
transaction increases the amount of money you owe the credit card company. If you
keep track of these types of transactions, you can reconcile your credit card account
with your monthly statement, and you should quickly spot any transactions that look
suspicious. So how should you account for charges to your credit card?

One way is to manually enter all your receipts, either throughout the month or all at
once. This can be time-consuming, but it is probably the best way to make sure that
all of your charges are authorized. If you consistently enter all your receipts, you
can quickly catch any errors or unauthorized transactions during your monthly
reconciliation.

Another way is to import a credit card statement directly into your account. If your
credit card company supports a QIF file format for its statements, you have the
option of directly importing the statement. This type of import is covered in the the
section called “Importing QIF Files”, and it is a convenient way to track your
purchases without having to manually enter all your receipts.

Entering Payments

Most payments to your credit card bill are entered as transfers from a bank account
(asset) to the credit card account (liability). When you pay the monthly bill, you are
withdrawing money from a bank account to pay down the credit card balance. This
transaction decreases both your bank account balance and the amount of credit card
debt you owe.

When you return a purchase, you receive a refund on your credit card. This is

another type of payment in that it decreases the amount of credit card debt you owe.

If you recorded the original purchase transaction as a transfer from the credit card
account to the expense, you now simply reverse that transaction: transfer the money
back from the expense to the credit card account. This transaction decreases both
the expense account balance and the credit card account balance. For example, if
you originally recorded a credit card purchase of clothing, the transaction is a
transfer from the credit card account to the clothing expense account. If you then
return that clothing for a refund, you simply transfer the money back from the
clothing expense account to the credit card account.

Note

A common mistake is to enter a refund as income. It is not income, but
rather a "negative expense". That is why you must transfer money from the
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expense account to your credit card when you receive a refund.

To clarify this, let's run through an example. You bought some jeans for $74.99 on
your VISA card, but realized one day later that they are too big and want to return
them. The shop gracefully agrees, and refunds your credit card.

1. Start with opening the previous datafile we stored (gcashdata_5), and store it as
gcashdata_6.

2. Open the Liabilities:Visa account register and enter a simple 2 account
transaction to pay the $74.99 jeans purchase. The Transfer account should be
Expenses:Clothes and you Charge your Visa account with the $74.99.

Note

Since we had not created the Expense:Clothes account previously,
GnuCash will prompt us to create it. Just remember to create it as an
Expense account

3. Enter the refund in one of the following way.

e Enter the same transaction as the purchase transaction, but instead of a
"Charge" amount, use a "Payment" amount in the Credit Card account
register.

o Select the purchase transaction you want to refund (that is the Jeans
transaction in our case), and selecting Transaction -> Add Reversing
Transaction. Modify the date as needed.

After reversing the transaction, your credit card account should look something

like this
B geashdata_6 - visa SEE]
Eile Edt \ew TWapsaction Actions Husiness Beports Dbols Windows Help
B x B & + X F EH @ =
Save  Close  Duplicate Delete Erter  Cancel alank Spit Jump
@ Accounts| @ visa
[Bate [Nur [Descrption Transfer R |Payment |Charge  |Balance | *
010306 | Opening Balance Equity-Opening Balance | n s00.00]  500.00
03/04/06 Jeans R Us Expenses:Clathes | n 74.89| 57438
05/04/06 | Jeans R Us Expenses:Clathes | n 74.9% 500.00
H - - - - - = L=
Prasent: USD 500.00 Future-USD 500.00 Cleared:USD 0.00 Reconcied-USD 0.00 Projected Minimum: USD 500.00
Monday 17 April 2006

This image shows Liability:Credit Card - Register after reversing a purchase
transaction.

and the Expenses:Clothes register should look something like this
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& geashdata 6 - Clothes —lax
Fle Edt \dew Wapsaction Actions Business Beports bols Windows Help

B *x ®H g <+ x 3 H © v

Save close  Duplicate  Delete Enter  Cancel Blank spit Jump

[ Accounts | @ Visa| @ Clothas

Date Nurr [Description’ Tanster
03/04/06 jeans A Us
05/04/06 Jesns R Us

[(a7maios [

Expense ate B
7459 74.99
74.59 0.00

Lisbities visa
Lisbilties:visa

s[> [z |3

™
USD 0,00 Projected Minmum;LUSD 0.00

)
Prasent;USD 0,00 Future;USD 0.00 Cleared:USD 0.00 Recar
Enter a description of the transaction

This image shows Expenses:Clothes register after reversing a purchase
transaction.

4. Save the GnuCash data file.

Putting It All Together

Now that we have covered the basic ideas behind the various transactions you must

make to successfully track your credit card in GnuCash, let's go through an example.

In this example, we will make credit card purchases, refund two of the purchases,
get charged interest on the unpaid balance, reconcile the credit card account, and
finally make a partial payoff of the credit card.

Open GnuCash file

Start with opening the previous datafile we stored, gcashdata 5, and store it as
gcashdata_6 directly. The main window should look something like this:
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mnmm‘:m_mwm\m - Accounts

File Edit Mew Actions Business Reports Tools Windows Help

B @ W @

Save Open  Edit MNew Delete
il Accounts
Account Name v | Type Commodity Total 3

|- #Assets Us Dollar  USD 1,601.79

fm Cash Cash uUs Dollar UsD 100,00

i Checking Bank UsS Dollar ~ USD 1,101.79

fm Savings Bank Us Dallar USD 400.00

Db Equity Equity US Dollar  USD 1,500.00

~ fm Expenses Expense US Dollar  USD 1.388.21

fim Clothes Expense uUs Dollar UsD 0.00

i Electricity Expense US Dollar UsD 78.00

fm Groceries Expense Us Dollar uUsD 120.21

fm Household Expense uUs Dollar USD 50,00

& Internet Expense US Dollar UsD 20.00

fm Phone Expense Us Dallar USD 45.00

fi Rent Expense  US Dollar USD 700.00

i Service Charge Expense US Dollar UsD 5.00

P fm Taxes Expense Us Dollar USD 330.00

@ Tools Expense US Dollar UsSD 50.00

P fm Income Income US Dollar  USD 1,000.00

= fm Liabilities Liability Us Dollar USD 500.00

i Visa Credit Card US Dollar USD 500.00

UsD: Assets: USD 1,101.79 Profits: -USD 398.21 H

| |
[

Starting account structure for tracking a credit card in the putting it all together
example.

Purchases

Let's make some purchases on our visa card. Start by buying $25 worth of food from
the Greasy Spoon Cafe, $100 worth of clothing from Faux Pas Fashions, $25 worth of
gasoline from Premium Gasoline, $125 worth of groceries and household items from
Groceries R Us (split between $85 in groceries and $40 in household items) and
finally, $60 worth of household items from CheapMart.

We also redo the exercise in previous chapter, with purchasing a pair of Jeans for
$74.99 on April 3, and refund them two days later.
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The register window for the credit card liability should look like this:

1 geashdata_6 - Visa
m_mna.ﬁmxvn_uanna:baaim:!;a:mquﬁUq,aE:uqfwuw,v

= h & + X - 3

Save Clase Duplicate  Delete Enter  Cancel Blank

| it Accounts| @ visa

01/03/06 Opening Balance

Spit

L)

Jumg

500,00
03/04/06 Jeans R Us n 74,00 574.9%9
05/04106 Jeans R Us n| 74se 500,00
10/04/06 Greasy Spoon Cafe Expenses:Food | n 25.00 525.00
11/04/06 Faux Pas Fashion Expenses:Clathes | n 100.00 625.00
12/04/06 Premiurm Gasobn Expenses:Car | n 25.00 650.00
13/04/06 Grocenas R Us -- Split Transaction -- | n 125.00 775.00
13104106 CheapMart Expenses:Household | n 6000] 83500 =

e

Thursday 13 April 2006

Present:USD 835.00 Future:USD 835.00 Clearsd:USD 0,00 Reconcied:USD 0.00 Projectad Minimum: USD 835.00

Initial credit card purchases.

Refund

Now suppose that on April 15th you return the clothes you bought on April 11th from
Faux Pas Fashions and they give you credit back on your credit card. Enter a
transaction for the credit card refund for the full $100 amount. Remember to use the
same transfer account you used for the original purchase, and enter the amount
under the Payment column. GnuCash will automatically complete the name and
transfer account for you, but it will also automatically enter the $100 in the Charge
column. You will need to reenter the amount in the Payment column. The

transaction looks like this:

gcashdata_6 - Visa
Ele Edt Mew Wapsaction Actions Business Reports Tols Windows Help

=] x mH g + X 2

Save Close Duplicate  Delete Enter  Cancel Blank

]
|8 Accounts @t visa

A Pas Fashion

=

Spit

Jump

Premiurm Gassin

25.00

Grocenies A Us

125 00

775.00

CheapMart ExpensesHousehald

60,00

835.00

n
n
n
n
n

FaLix Pas Fashion - Refund Expenses:Clothes
I

100.00

735.00

Enter & description of the transaction

Ol
35.00 Future:USD 735.00 Clearsd:USD 0.00 Reconciled:USD 0.00 Projectad Minimum: USD 735.00

Returning clothes to Faux Pas Fashions, refund to credit card.

Interest Charge

After the month of spending, unfortunately, the credit card bill arrives in the mail or
you access it on-line through the internet. You have been charged $20 in interest on
the last day of April because of the balance you carried from the previous month.
This gets entered into the credit card account as an expense.
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File Edt Mew Wapsaction Actions Business Reports Hols Windows Help

[ o~ | +* X 2 B @ .

Save Close  Duplicate  Delete Enter  Cancel Blank Spit Jumg

Faix Pas Fashion - Refund
30/04/01 Intarest Expensesinterest | n 2000 755.00
= i =
l. 0]
Presant:USD 735.00 Future USD 755,00 Cleared USD 0,00 Reconcled:USD 0.0 Projected Minimurm: USD 755.00
Sunday 30 April 2006

Interest charge.

Reconciliation

When your credit card bill arrives you should reconcile your credit card account to
this document. This is done using GnuCash's built-in reconciliation application.
Highlight the credit card account and click on Actions -> Reconcile.... This
reconciliation procedure is described in detail in the the section called
“Reconciliation”, but we will step through the process here as well. For this
example, let's assume that the credit card statement is dated May 1st, with a final
balance of $455. Enter these values in to the initial Reconcile window as shown

here.

Liabilities:Visa - Reconcile

Reconcile Information

Statement Date: |01/04/06 .

Starting Balance: USD 0.00

Ending Balance: |455.00

Enter Interest Charge...

Initial account reconciliation window.

During the reconciliation process, you check off each transaction in the account as
you confirm that the transaction appears in both your GnuCash account and the
credit card statement. For this example, as shown in the figure below, there is a
$300 difference between your GnuCash accounts and the credit card statement.
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bl il Account register after account reconciliation and payment.
Beconcile Account Transaction Help
%0 @« X N
m m_ﬂ UW; i gl o Go back to the main window and save your file (gcashdata 6). Your chart of accounts
CbE e is steadily growing, and it should now look like this:
Date | Description Amount B[ Date | M Description Amount R[S
05/04/ |eans RUs 7499 ~ 0Lj03) Opening Balance 50000 ~
1504/ Faux Pas Fashion - Ref. 10000 - 03/04; |jeansRUs 7499
10/04;  Greasy Spoon Cafe 2500 - Business PReports Tools Windows Help
1104) Faux Pas Fashion 100.00 -
12104/ Premium Gaselin 25,00 ~ @
13/04) Groceries RUs 125.00 ~ by
13/04)  CheapMart 60.00 - Save New
[Zo/ma;  interest 2000 -
=] |GI D] fl Accounts
i bl bt bade, Account Name v | Type Commodity Total| | &
e LoD 0D v R Assets Asset US Dollar  USD 1,001.79
Ending Balance: USD 455.00
Reconciled Balance: LUSD 755,00 fm Cash Cash us Dollar USD 100,00
Difference: -USD 300.00
i Checking Bank Us Dollar UsD 501.79
fil Savings Bank us Dollar USD 400.00
. a1 . . . . [ Equit Equit; Us Doll USsD 1,500.00
Main account reconciliation window, demonstrating a discrepancy of $300. 8 Equity LY orar
< i Expenses Expense US Dollar  USD 1.,653.21
Some investigation uncovers that you forgot to record a payment you made on fi Car Expense  US Dollar UsD 25.00
March 5th to the credit card company for $300, you must enter this payment fi@ Clothes Expense  US Dollar USD 0.00
transaction from your bank account to the credit card. Now the credit card it Electricity Expense  US Dollar UsD 78.00
statement and your GnuCash account can be reconciled, with a balance of $455. i Food Expense  US Dollar USD 25.00
fm Groceries Expense Us Dollar USD 205.21
HVD.EQSH fm Household Expense  US Dollar UsD 150,00
i Interest Expense US Dollar UsD 20.00
Assuming you have completed reconciliation of your credit card account, you need to 3 Internet Expense  US Dollar USD 20.00
make a payment to the credit card company. In this example, we owe $455 but will @ Phone Expense  US Dollar USD 45.00
make a partial payment of $300 again this month. To do so, enter a transaction from & Rent Experse  USDollar  USD 70000
your bank account to the credit card account for $300, which should reduce your Eernteeeioel experse LS Dollar USD =00
credit card balance to $155. Your credit card account register should now appear B s Epmen  UEoHbE  LEDEENGE
like this: fmt Tools Expense Us Dollar USD 50.00
? TS e P f® Income Income Us Dollar  USD 1.000.00
Gle Edit iew Tapsaction Actions Business Beports Bols Windows Help - @_Lm_u___?mm _Lm_u___S.. US Dollar USD 155.00
= x ] ] 4+ X z H = @ = :
Save  cClose  Duplicate Delats Enter  Cancel Black  Spit  Jump  Schedule o Visa Credit Card US Dollar USD 155.00
| Accounts S Visa . n
- [usp: Assets: LUSD 846.79 Profits: -USD 653.21 2
Openng Balance Balance | y - —
05/0306 Partial Payment AssetsChecking | y | 300.00
03)04/08 jeans R Us ExpensesClothes | y 74,99
05/04/08 jeans R Lis Expenses:Clathes [ y 7499
T T e e GnuCash Chart of Accounts after account reconciliation and payment.
12/308 | Prermium Gasolin ExpensesiCar | y 25.00
13/04/06 | Groceries R Us Splt Fransaction | y 135,00
CheapMart Expenses:Household
I:x“n..mu.r,uz Rafund T “ mm.d\o m—.@
interest ¥
Partial Payment of Visa n

Last, save the GnuCash data file (gcashdata 6).

Friday 05 May 2006

113 de 273 114 de 273



HWOUOHHW Transaction Report
From 01/03/06 To 30/04/06

As we did in the UHQ/\AOSM OUWUﬁOHm\ let's have a look at a Cash wu,_OS\w and a Date Num Description Transfer fromjfto  Amount
Transaction Report. Visa
March 2006
1. First let's have a look at the Cash Flow report for the liability account Visa 01/03/06 Opening Balance Opening Balance ~ USD 500.00
during the month of March. 05/03/06 Partial Payment Checking -UsD 300.00
g Total For March 2006 USD 200.00
April 2006
Select the cash flow report from Reports -> Income & Expense -> Cash Flow 03/04/06  Jeans R Us Ciothas WE5iaiog
05/04/06 Jeans RUs Clothes -USD 74.99
Cash Flow - 01/03/06 to 30/04/06 for 10/04/06 Greasy Spoon Cafe Food USD 25.00
Selected Accounts 11/04/06 Faux Pas Fashion Clothes USD 100.00
@ Lishilitiesivisa 12/04/06 Premium Gasolin Car USD 25.00
13/04/06 Groceries R Us split USD 125.00
to selected accounts comes from 13/04/06 CheapMart Household LUSD 60.00
AssetsiChecking USD 300.00 15/04/06 FalbcEas Festiinny; clothes -USD 100.00
Expenses:Clothes USD 174.99 Refund
T UL 5 e e 30/04/06 Interest Interest USD 20.00
Total For April 2006 USD 255.00
Money out of selected accounts goes to Total For Visa USD 455.00
Equity:0pening Balance UsD 500.00
S — USD 25.00 Grand Total USD 455.00
Expenses:Clothes UsSD 174.99
Expenses:Food USD 25.00 This image shows the Transaction Report for the Visa account during
Expenses:Groceries UsD 85.00 gmﬁnﬁ\>ﬁﬁﬁ.
Expenses:Househald UsD 100.00
B e USD.26.06 3. Now let's change the transaction report to only show the various Expenses
Money Cut UsSD 929.99
accounts.
Difference -USD 455.00

This image shows the Cash Flow report after Chapter 6, Credit Cards.
2. Now let's have a look at corresponding transaction report for the Visa account.

Select the transaction report from Reports -> Transaction Report
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Transaction Report Accounts for the loan

From 01/04/06 To 30/04/06 Lending the money
Date Num Description Account  Amount Receiving first payment
= _ Receiving second payment
12/04/08 P G Ei USD 25.00 .
ikl remium Basoin ar ek Automobile Loan (How-To)
Total For Car USD 25.00 . i
e Reconciling with the Loan Statements (How-To)
03/04/06 Jeans R Us Clothes USD 74.99 Selling a house or a car (How-To)
05/04/06 Jeans R Us Clothes -USD 74.99 m:dgm Transaction
11/04/06 Faux Pas Fashion Clothes UsSD 100.00 A More OOBU_QN Transaction
1sjoajos [ Pas Fashion - Clothes  -USD 100.00 Missing Loan Documentation
Total For Clothes USD 0.00 . . .
o This chapter explains how to manage your loans with GnuCash.
10/04/08 Greasy Spoon Cafe Food UsD 25.00
Total For Food UsD 25.00 0
el Basic Concepts
13/04/06 Groceries R Us Groceries USD 85.00
Total For Groceries USD 85.00 A loan is defined as a financial transaction in which someone pays for the use of
EECEE : someone else's money. There are many familiar examples of loans: credits cards,
13/04/06 Groceries R Us Househaold USD 40.00 1 h busi 1
13/04/05 CheapMart e I —— auto loans, house mortgages, or a business loan.
Total For Househeld UsD 100.00
Interest Terminology
30/04/06 Interest Interest USD 20.00
wsﬁ_ Fentanest U5D;20.00 Before discussing tracking loan in GnuCash specifically, it will be helpful to present
e . .
28104105 May Rent Rent LUSD 350.00 a glossary of 85::05@%. The Sz.b.m Emmm:ﬁm.a below represent some o.m the basic
e USD 350.00 concepts found concerning loans. It is a good idea to become familiar with these
terms, or at least, refer back to this list if you encounter an unfamiliar word in the
Grand Total USD 605.00

This image shows the Transaction Report for the various Expense accounts

during April.

later sections.

e Amortization - the repayment plan which will insure that a loan is eventually
paid off, typically utilizing equal valued monthly payments. These payments are

usually split into principal and interest, where the amount of principal per
payment increases (and interest decreases) as the amortization period elapses.

Chapter 7. Loans

e Borrower - the person or company that receives the money from a loan.
Table of Contents

e Default - when a borrower fails to repay a loan according to the terms agreed

Basic Concepts upon with the lender.

Terminology
Setting Up Accounts « Deferment - a temporary delay in the repayment of a loan.
Calculations

Example: Monthly Payments

Example: Length of Loan
Advanced: Calculation Details e Disbursement - amount of the loan paid to the borrower. Some loans have

House Mortgage (How-To) multiple disbursements, meaning the borrower does not receive the full amount
A Personal Loan to a friend (How-To) of the loan at one time.
Loan Specifications

e Delinquency - is the term that refers to late payments.
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o Interest - the expense charged by the lender to the borrower for the use of the
money loaned. This is typically expressed in terms of a yearly percentage
charged on the principal borrowed, known as the Annual Percentage Rate or
APR.

e Lender - the company or person who lends money to a borrower.

e Loan Fee - a processing fee removed from the principal at the time the borrower
receives a loan.

e Principal - the original amount of the loan, or the amount of the original loan
that is still owed. When you make a monthly payment on a loan, part of the
money pays the interest, and part pays the principal.

e Promissory Note - the legal agreement between the borrower and lender
concerning the loan.

Setting Up Accounts

When a borrower obtains a loan, it is usually with the intention to make a purchase
of something of value. In fact, most loans require the borrower to buy some
predetermined asset, such as a house. This asset is insurance against the borrower
defaulting on the loan. There are, of course, examples of loans which do not
necessarily have an associated high value asset, such as educational loans.

For the account structure presented here, we will assume the loan was used to
purchase a compensating asset.

Aloan is a liability, the interest you accrue on the loan is an on-going expense, and
any administrative fees you may have to pay would be another expense. The thing
purchased with the money from a loan is an asset. With these parameters, we can
now present a basic loan account structure:

Basic Loan Account Structure

-Asset
-Current Assets
-Savings Account
-Fixed Assets
-Asset Purchased
-Liability
-Loans
-Mortgage Loan
-Expenses
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-Interest
-Mortgage Interest
-Mortgage Adm Fees

GnuCash has a number of predefined loan account hierarchies available, including
Car Loans and Home Mortgage Loans. To access these predefined account
structures, click on File - New Account Hierarchy and select the loan types in which
you are interested.

Calculations

Determining loan amortization schedules, periodic payment amounts, total payment
value, or interest rates can be somewhat complex. To help facilitate these kinds of
calculations, GnuCash has a built-in Financial Calculator. To access the calculator,
go to Tools = Financial Calculator.

Financial Calculator

Calculations Payment Options
Compounding:
360 [YgClear|  TvPe:

Fraquency: Monthly E

Payment periods

® Discrete Continuous

Interest rate

4.00 _wm,mml Period:
When paid:
Frequency: Monthly =

Present value Beginning @ End
100,000.00| | % Clear|

Periodic payment
-477.42| | Ygiclear |

Future value
0.00] | Y clear|

Payment Total: -171,871.20

X cClose

The GnuCash Financial Calculator.

The Financial Calculator can be used to calculate any one of the parameters:
Payment Periods, Interest Rate, Present Value, Periodic Payment, or Future Value
given that the other 4 have been defined. You will also need to specify the
compounding and payment methods.

e Payment Periods - the number of payment periods.

o Interest Rate - the nominal interest rate of the loan, ie: the yearly interest rate.
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e Present Value - the present value of the loan, ie: current amount owed on the
loan.

e Periodic Payment - the amount to pay per period.

e Future Value - the future value of the loan, ie: the amount owed after all
payment periods are over.

e Compounding - two interest compounding methods exist, discrete or continuous.
For discrete compounding select the compounding frequency from the popup
menu with a range from yearly to daily.

e Payments - the popup menu allows you to select the payment frequency with a
range from yearly to daily. You can also select whether your payments occur at
the beginning or end of the period. Payments made at the beginning of the
payment period have interest applied to the payment as well as any previous
money paid or money still owed.

Example: Monthly Payments

What is your monthly payment on a $100000 30 year loan at a fixed rate of 4%
compounded monthly?

This scenario is shown in the example image above. To perform this calculation, set
Payment Periods to 360 (12 months x 30 years), Interest Rate to 4, Present Value to
100000, leave Periodic Payment empty and set Future Value to 0 (you do not want to
owe anything at the end of the loan). Compounding is Monthly, Payments are
Monthly, assume End of Period Payments, and Discrete Compounding. Now, click on
the Calculate button next to the Periodic Payment area. You should see $-477.42.

Answer: You must make monthly payments of 477.42.
Example: Length of Loan

How long will you be paying back a $20000 loan at 10% fixed rate interest
compounded monthly if you pay $500 per month?

To perform this calculation, leave Payment Periods empty, set Interest Rate to 10,
Present Value to 20000, Periodic Payment is -500, and set Future Value is 0 (you do
not want to owe anything at the end of the loan). Compounding is Monthly,
Payments are Monthly, assume End of Period Payments, and Discrete Compounding.
Now, click on the Calculate button next to the Payment Periods area. You should see
48.

Answer: You will pay off the loan in 4 years (48 months).
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Advanced: Calculation Details

In order to discuss the mathematical formulas used by the Financial Calculator, we
first must define some variables.

n == number of payment periods

%i == nominal interest rate, NAR, charged
PV == Present Value

PMT == Periodic Payment

FV == Future Value

= Compounding Frequency per year

= Payment Frequency per year

N

F =
F =

Normal values for CF and PF are:
1 == annual
2 == semi-annual
3 == tri-annual
4 == quaterly
6 == bi-monthly
12 == monthly
24 == semi-monthly
26 == bi-weekly
52 == weekly
360 == daily
365 == daily

Converting between nominal and effective interest rate

When a solution for n, PV, PMT or FV is required, the nominal interest rate (i) must
first be converted to the effective interest rate per payment period (ieff). This rate,
ieff, is then used to compute the selected variable. When a solution for i is required,
the computation produces the effective interest rate (ieff). Thus, we need functions
which convert from i to ieff, and from ieff to i.

To convert from i to ieff, the following expressions are used:
Discrete Interest: ieff = (1 + i/CF)"~(CF/PF) - 1
Continuous Interest: ieff = e ~(i/PF) - 1 = exp(i/PF) - 1

To convert from ieff to i, the following expressions are used:

Discrete Interst: i = CF*(1+ieff) ~(PF/CF) - 1]
Continuous Interest: i = In[(1+ieff) "PF]
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Note

NOTE: in the equations below for the financial transaction, all interest
rates are the effective interest rate, ieff. For the sake of brevity, the
symbol will be shortened to just 'i'.

The basic financial equation

One equation fundamentally links all the 5 variables. This is known as the
fundamental financial equation:

PV¥(1 +1i)"n + PMT*(1 + iX)*[(1+i)"n- 1]/i + FV =0

Where: X = 0 for end of period payments, and
X =1 for beginning of period payments

From this equation, functions which solve for the individual variables can be derived.

For a detailed explanation of the derivation of this equation, see the comments in
the file src/calculation/fin.c from the GnuCash source code. The A, B, and C
variables are defined first, to make the later equations simpler to read.

=(1+i)"n-1
(1 + iX)/i
PMT*B

A
B
C

n = In[(C - FV)/(C + PV)}/In((1 + i)
PV = -[FV + A*CJ/(A + 1)

PMT = -[FV + PV¥A + 1)]/[A*B]
FV = -[PV + AXPV + C)]

The solution for interest is broken into two cases.
The simple case for when PMT == 0 gives the solution:
i =[FV/PV]~(1/n) - 1

The case where PMT != 0 is fairly complex and will not be presented here. Rather
than involving an exactly solvable function, determining the interest rate when PMT

1=0 involves an iterative process. Please see the src/calculation/fin.c source file for a

detailed explanation.
Example: Monthly Payments
Let's recalculate the section called “Example: Monthly Payments”, this time using
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the mathematical formulas rather than the Financial Calculator. What is your
monthly payment on a $100000 30 year loan at a fixed rate of 4% compounded
monthly?

m:,mr_mﬁ_wmmm:m;md\mimgmm”nuHwo*vameo\m<uHooooo\w?ﬁuczwzos\?
FV=0,1i=4%=4/100=0.04, CF = PF = 12, X = 0 (end of payment periods).

The second step is to convert the nominal interest rate (i) to the effective interest
rate (ieff). Since the interest rate is compounded monthly, it is discrete, and we use:
ieff = (1 + i/CF)"~(CF/PF) - 1, which gives ieff = (1 + 0.04/12)"~(12/12) - 1, thus ieff =
1/300 = 0.0033333.

Now we can calculate Aand B.A=(1+i)"n-1=(1+ 1/300)"360 -1 = 2.313498.
B =(1+iX)/i = (1 + (1/300)*0)/(1/300) = 300.

With A and B, we can calculate PMT. PMT
100000%(2.313498 + 1)] /[2.313498 * 300]
-477.42.

-[FV + PV¥(A + 1)]/[A*B] = -[0 +
-331349.8 / 694.0494 = -477.415296 =

Answer: You must make monthly payments of 477.42.

House Mortgage (How-To)

A house mortgage can be setup using the account structure present in the section
called “Setting Up Accounts”.

As an example, assume you have $60k in you bank account, and you buy a $150k
house. The mortgage is charging 6% APR, and has administrative fees (closing costs,
etc) of 3%. You decide to put $50k down, and thus will need to borrow $103k, which
will give you $100 after the closing costs are paid (3% of $100k).

Your accounts before borrowing the money:
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=no file= - Accounts
gGle Edit Mdew Tapsaction Actions Business Beports Dols Wndows Help

File Edit Wew Actions Business Reports Tools Windows Help =] x B & + X 3 = ® ] 4 -
Save Close Duplcate  Delete Enter Cancel Blark _ Spht ai Jump Schedule Transfer
i B
= di A Tt increne [ ot Decreas [Balance ||+
Save MNew % M. _‘.‘wn“uﬂmmr.r..irw ‘.”._{mum
Total valus of house Asset Foed Assets House. n_ 150,000 00 |
Clesing cests aes n 3,000.00
@ AR nzaiﬂiz. osets :Savings Account | n 50.000.00
Dy - Total a3 ”E.;n_s,_d cesty Lisbilfizs Loans:Mortgage Loan In 103.000.00 | to
= @) ” LSO 60700000 _vw.mo.a..ﬁmu._mu D00.00_Fifure:USD 150.000.00 Cleared-USD D0 Reconciled: IS0 0.0 Project tinimum: USD 150.000.00
5s5ets i i Buy hause
e @ Current Assets UsD 60,000,00
% Savings Account USD 60,000.00 Mortgage Split Transaction
= fm Fixed Assets USD 0.00 . . . . .
e R Which will give a Chart of Accounts like this:
ouse Al
= fm Equity USD 60,000.00 e <no file> - Accounts
@ Opening Balances USD 60,000.00 file Edit \Mew Actions Business Reports Dbols Windows Help
- @ Expenses USD 0.00 @
~ fm Interest USD 0.00 Pl e
fi Mortgage Interest USD 0.00 a
% Mortgage Adm Fees uUsD 0.00
= fm Liabilities USD 0.00 Account Name v 5 *
= @ FEr USD 0.00 e @)mmmﬁm UsD 160,000,00
@Znnmmmm Loan USD 0.00 - @n::,ml Assets USD 10,000.00
@ Savings Account USD 10,000.00
USD, grand total: Assets: USD 60,000,00 Profits: USD 0.00 % ¥ i Fixed Assets ki) BTl
: i House USD 150,000.00
|
L = W Equity USD 60,000.00
Accounts Before Receiving Loan o B Halerea L5B60:000:00
= i Expenses USD 3,000.00
The purchase of the house is recorded with a split transaction in the Asset:House = f Interest USD 0.00
account, with $50k coming from the bank (IE: your down payment), and $100k fit Mortgage Interest UsD 0.00
coming from the Mortgage. You can place the $3k closing costs in the same split, it Mortgage Adm Fees USD 3,000.00
and we increase the house loan to $103k to include the closing costs as well. < g Liabilities USD 103,000.00
= fm Loans USD 103,000.00
Table 7.1. Buying a House Split Transaction A e e e
_»u»oooﬁiﬂﬁ _Hbowmmmm _Umoiwmmm USD, grand total: Assets: USD 57,000.00 Profits: -USD 3,000.00 u_
[Assets:Fixed Assets:House [$150,000 f
sets:Current Assets:Bank 50,000
ou
_>m _ _w Mortgage Account
[Liabilities:Loans:Mortgage Loan| [$103,000
(]
[Expenses:Mortgage Adm Fees [$3000 | A Personal Loan to a friend (How-To)

It is not always you are borrowing money from the bank, sometimes you borrow

The split will look like this in the Assets:Fixed Assets:House Account: money from your family, or perhaps even lend money to a friend. This How-To
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chapter will describe one way to handle lending money to a friend.

We are basing this How-To on the following generic account structure.

-Asset
-Bank
-Bank Account
-Money owed to you
-Person
-Income
-Interest Income
-Person

This example will show how to track a personal loan of 2,000 USD (default currency)
to your friend Peter

Loan Specifications

Peter wants to borrow $2,000 dollars from you and plans to pay you back montly for
the next 18 months. Since he is your friend, (but not that close) you both agree on a
yearly interest rate of 5%

In summary we have the below details. Peter's loan details:
¢ Pinciple Amount - $2,000
e Term - 18 months with 12 payments per year
e Annual Percentage Rate: 5%
e Monthly Payment : ??
So how do you caculate the Montly Payment?

You have a number of different options, like paper and pen, Linux Calculator, Open
Office's Calc module, but the easiest is to use GnuCash Financial Calculater. This
gives you that the Monthly Payment should be 115.56%.

But you need to know how much of this is Interest and how much is Principal to be

able to do a proper bookkeeping. For this you need a more powerful tool, something
like the Calc module in Open Office, and in particular the PMT function.
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Start End
Amount Interest Principal Amount

Jan 2,000.00 8.33 1892.77

Loan Amount §2000.00) Feb 189277 7.89 1,785.10
Number of months 18| Mar 178510 7.4 1 676.97
Payments per year 12| Apr 1 E76.57 6.59 1.568.40
Interest per year 5%| May 1568.40 6.54 1489 37
Monthly payment $115.56] Jun 145937 6.08 134989
Jul 1,319.89 562 1,239.96

Aug 1,239.96 BT 1,129.56

Monithly Payment=PMT(CB/C7 C6,-C5,0) Sep 1,129.56 471 101871
Oct 1,018.71 4.24 907.39

Interest=(BCIBIFCHT)F4 Mov  907.39 3.78 795.61
Dec 79561 332 B83.37

Principal=3C38-G4 Jan 68337 285 570.65
Feb  570.ES 2.38 457 AT

End Amourt=F4-Hd Mar 457 47 1.91 343.81
Apr 34381 1.43 22369

May 22989 0.36 115.08

Jun 11508 0.48 -0.00

Total $80.10 $2,000.00

Detailed view over the private loan to Peter
Accounts for the loan

Let's start with the following acccounts (all accounts have the same currency, in this
case USD)

Assets:Bank:USD

Assets:Money owed to you:Peter
Income:Interest Income:Peter
Equity:Opening Balances:USD

Lending the money

When you have lended money to your friend, you have in fact moved money from an
Asset account (like Bank, Checking or similar) to your Asset account "Money owed
to you". To record this you enter the following transaction into the Assets:Money
owed to you:Friend account.

Table 7.2. Personal loan to a Friend

_>ooocbﬁ _Eowmmmm _Umonmmwm
[Assets:Money owed to you:Friend [$2,000 |
[Assets:Bank:USD _ [$2,000
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=no file= - Accounts

File Edit Mew Actions Business Reports Tools Windows Help

x = W @

Save Open Edit MNew Delete
it Accounts
Account Name Ls Total =
= fm Assets USD 2,000.00
< fm Bank UsD 0.00
i USD USD 0.00
~ fm Money owed to you USD 2,000.00
T PEter UsD 2,000.00
~ @ Equity UsD 2,000.00 =
USD, grand total:  Assets: USD 2,000.00  Profits: USD 0.00 % _

[ —

Chart of Accounts after lending money

Receiving first payment

When the first payment ($115.56) is received, you will need to determine how much
is for the principal loan, and how much is for the loan interest.

e Outstanding loan amount this period = $2,000
o Payment per month = $115.56

o Payment breakdown

* 5%/12 * $2,000 = $8.33 Interest

e $115.56 - $8.33 = $107.23 Principle

This can be translated to the following GnuCash entry

fle Edt View Tapsaction Actions Business Beports Tols Windows Help

= B @ + X 3 ® B e
save clase Duplicate  Delete Erter  Cancal alank Jump  Schedule
_D __5233 B Petar

2.000,00 2.000.00
_ Assats:Monay owad to youPeter 0 | 2.000.00
150

010108 | [Loan to Pater

n 2.000.00
I |H| [ 1w723]188277
Bank:USD n. 11556
Manay owed to youPster  n 10723
nl 833

0110206 [Frst payment

[
) T

&l

Prasent;USD 1.892.77 Future:USD 1,892.77 Clearsd:USD 2.00 Reconciled:US0 0.00 _Projacted Minimurm: LISD 1,892

Enter a descriptian of t
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Detailed view over first payment

The balance on Peters loan is now $2,000 - $107.23 = $1,892.77

Receiving second payment

When the second payment ($115.56) is received, you will again need to determine
how much is for the principal loan, and how much is for the loan interest.

e Outstanding loan amount this period = $1,892.77
« Payment per month = $115.56

« Payment breakdown

e 5%/12 * $1,892.77 = $7.89 Interest

¢ $115.56 - $7.89 = $107.67 Principle

This can be translated to the following GnuCash entry

<no file= = Pater

Ble Edit Wiew Tapsaction Actions @usiness Beports Tols Windows Help

E o ox B @ +* X b 4 ¥ o =
Save  Close  Duplicats  Delets Erter  Cancal  Blank Jump  Schedule
& r:u:::, B Peter

010108 |Laan to Patar
0102108 | | Frst paymere 1 - 5 Fanvusti <]
015308 || | Sacond paymant 1 L1
Assats:BankUsD n

[ Principal " AssatsMoney owed to youiPeter  n |
| Interest |Incomadirterest ncome Pater n |

£ Ir
nimirumu-.umu.unE:«-"Cmn_.umu.—sn_-iutmnﬁ.uo?nu:n_,lm_;mUubnvﬂ_.nntﬁ,a-..ch_.:"EMUu«mu.wu

Second payment

Detailed view over the second payment
The balance on Peters loan is now $1,892.77 - $107.67 = $1,785.10

The Chart of accounts looks now like this
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Lloan_Peter - Accounts

File Edit Mew Actions Business Reports Tools Windows Help
= @
Save Mew
fm Accounts
Account Name v Total 3
= fm Assets USD 2,016.22
= fm Bank UsSD 231.12
i USD uUsD 231.12
< fm Money owed to you USD 1,785.10
i Peter UsD 1,785.10
I @ Equity USD 2,000.00
= fm Incorne UsD 16.22
— @ Interest Income UsD 16.22
i Peter UsD 16.22
_Cmc_ grand total:  Assets: USD 2,016.22  Profits; USD 1622 =

Chart of Accounts after second payment

As you can see, the interest varies for every month, as well as the principal amount.
So for every payment you receive you need to calculate the proper amounts for your
various split entries.

The interest amount will be less and less for every payment (since it is calculated on
a smaller loan amount all the time), until the last payment where it is more or less
0. Please review the Figure of Detailed view over private loan to Peter for more
details

Automobile Loan (How-To)

The Automobile Loan, or in common terms, Car Loan, is treated more or less
exactly as the House loan. The only difference is different accounts, and different
interest rates.

Basic Car Loan Account Structure

-Asset
-Current Assets
-Savings Account
-Fixed Assets
-Car
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-Liability
-Loans
-Car Loan
-Expenses
-Interest
-Car Loan Interest
-Car Loan Adm Fees

For more information, please check the section called “House Mortgage (How-To)”

Reconciling with the Loan Statements (How-To)

Reconciling a loan statement is no different from reconciling a bank or credit card
statement.

During the period you should have recorded all the various loan related
transactions, and every one of them are touching the Libility:Loans:<Loan> account.
For instance, paying of a bit of the loan, decreases your Bank Account, and increases
the Loan account, Loan Interest as well as perhaps Loan administration fee.

With the loan statement in your hands, open the Loan account, start the reconcile
druid, and tick of all the various transaction you have recorded. When you have
finished, the reconciling difference should be 0, and if it is not, then you will have to
go through the account and compare it with the loan statement to find the
difference. When you have reached a 0 in difference, then your loan account is
reconciled and you can finish the Reconcile druid.

For more information on how to Reconcile, please check the section called
“Reconciliation”

Selling a house or a car (How-To)

When you will record the selling of your house in GnuCash you have some different
options. Here we will go through two of them, one in which you only recorded the
purchase amount, and now the selling amount. The other where you have followed
the ups and downs on the property market and registered various Unrealized gains
over the time.

Simple Transaction

In this way you only record the proper sale amount.

Let's work through two samples of selling a house, one with a profit, and one with a
loss. If you want to sell a car instead, just substitute the house accounts with a car
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account.

-Assets
-Fixed Assets
-House
-Current Assets
-Saving
-Income
-Capital Gains Long
-House

e You bought a house for $300,000 once upon a time, and now managed to sell it
for $600,000. How do you record this?

To record this you need to increase our bank account with the $600k, and
decrease some other accounts with $600k. The house account only contains
$300k which is what you bought it for, so you move this amount to your bank
account. That means you are lacking #300k. This amount you fetch from the
Income:Captial Gains Long:House account. The split transaction you enter into
your bank account (Assets:Fixed Assets:Saving) should look like this.

Table 7.3. Selling an asset (house) with a profit

[Account [[ncrease [Decrease
[Assets:Current Assets:Saving [$600,000 |

[Assets:Fixed Assets:House | [$300,000
[[ncome:Capital Gains Long:House | [$300,000

You bought a house for $300,000 once upon a time, but due to a newly created
airport, could only sell it for $230,000. How do you record this?

To record this you need to increase your bank account with the $230k, and
decrease some other accounts with $230k. The house account contains $300k
which is more than what you sold it for. So let's move $230k of it to your bank
account. After this you have $70k remaining in your house account which needs
to be removed. You move it to our Income:Capital Gains Long:House account,
which will indicate a loss. The split transaction you enter into your house
account (Assets:Fixed Assets:House) should look like this.

Table 7.4. Selling an asset (house) with a loss
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[Account [ncrease [Decrease
[Assets:Fixed Assets:House | [$300,000
[Assets:Current Assets:Saving [$230,000 |
[[ncome:Capital Gains Long:House [$70,000 |

A More Complex Transaction

In this example we will touch a little on some more complicated accounting
principles. For more details on this subject please check Chapter 9, Capital Gains

Here we will only touch on the case when you have accurately estimated the current
value of your house. For the other cases (over-, and under-estimated), please check
Chapter 9, Capital Gains.

-Assets
-Fixed Assets
-House
-Cost
-Unrealized Gain
-Current Assets
-Saving
-Income
-Realized Gain
-House
-Unrealized Gain
-House

You bought a house for $300,000 once upon a time, and over the years kept a close
look on the market and updated your records with the estimated current value of
your house. At the time you want to sell it, you have determined that the current
market value is $600,000.

The difference between $600,000 (estimated market value), and $300,000 (purchase
value) is the current Unrealized Gain value. Therefore you have a total of $300,000
in your Assets:Fixed Assets:House:Unrealized Gain account

How do you record this sell transaction?
To record this you need to increase your bank account with the $600k, and decrease

some other accounts with $600k. You must first change from unrealized gain to
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realized gain for your Income accounts. Lastly you need to transfer the full amounts
from the "Assets:Fixed Assets:House" sub-accounts.

The transaction you enter into your Income:Realized Gain:House account should
look like this.

Table 7.5. Selling an asset (house) with a profit

_>oooc3 _H:onmmmm _Umoammm
[[ncome:Realized Gain:House [$300,000 |
[[ncome:Unrealized Gain:House | [$300,000

The transaction you enter into your Assets:Current Assets:Saving account should
look like this.

Table 7.6. Selling an asset (house) with a profit 2

_>ooocbﬁ _EQ,mmmm _Umgmmmm
[Assets:Current Assets:Saving [$600,000 |

[Assets:Fixed Assets:House:Cost | [$300,000
[Assets:Fixed Assets:House:Unrealized Gain | [$300,000

After having recorded these transactions you see that your House Asset have a value
of 0, your Savings account have increased with $600,000, and lastly, the
Income:Realized Gain have increased to $300,000.

Missing Loan Documentation

-Entering a Payment Schedule
-Monthly Payments (How-To)
---See the Mortgage druid
----ARM 10/1 means 10 year fixed interest rate, then changes every year
----ARM 10/3 means 10 year fixed interest rate, then changes every third year
-Final Payment (How-To)
---Same as a normal payment, but you get the figures from the bank
---How to fix 10 amortization and then a final bulk payment setup?

-Putting It All Together
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Chapter 8. Investments

Table of Contents

Basic Concepts
Terminology
Types of Investments
Setting Up Accounts
Predefined Accounts
Custom Accounts Example
Interest Bearing Accounts
Account Setup
Example
Setup Investment Portfolio
Setup Accounts for Stocks and Mutual Funds
Example Stock Account
Buying Shares
Entering Preexisting Shares
Buying New Shares
Setting Share Price
Initial Price Editor Setup
Setting Stock Price Manually
Configuring for Automatic Retrieval of Quotes
Displaying Share Value
Selecting "Price Source" in Stock Value Reports
Selling Shares
Example - Sale of stock with profit
Example - Sale of stock with loss
Dividends
Dividends in Cash
Dividends Re-Invested
Splits and Mergers
Simple Stock Split
Moderately Complex Stock Merger

This chapter explains how to manage your investments with GnuCash. Most people
have an investment plan, whether its just putting money into a CD account, investing
through a company sponsored plan at your workplace or buying and selling stocks
and bonds through a brokerage. GnuCash gives you tools to help you manage these
investments such as the Price Editor which allows you to record changes in the
prices of stocks you own.
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Basic Concepts

An investment is something that you purchase in the hopes of generating income, or
that you hope to sell in the future for more than you paid. Using this simple
definition, many things could be considered investments: the house you live in, a
valuable painting, stocks in publicly traded companies, your savings account at the
bank, or a certificate of deposit. These many types of investments will be discussed
in this chapter in terms of how to track them using GnuCash.

Terminology

Before discussing investments specifically, it will be helpful to present a glossary of
investment terminology. The terms presented below represent some of the basic
concepts of investing. It is a good idea to become familiar with these terms, or at
least, refer back to this list if you encounter an unfamiliar word in the later sections.

e Capital gains is the difference between the purchase and selling prices of an
investment. If the selling price is lower than the purchase price, this is called a
capital loss. Also known as realized gain/loss.

Commission is the fee you pay to a broker to buy or sell securities.

Common stock is a security that represents a certain fractional ownership of a
company. This is what you buy when you "buy stock" in a company on the open
market. This is also sometimes known as capital stock.

Compounding is the concept that the reinvested interest can later earn interest
of its own (interest on interest). This is often referred to as compound interest.

Dividends are cash payments a company makes to shareholders. The amount of
this payment is usually determined as some amount of the profits of the
company. Note that not all common stocks give dividends.

Equities are investments in which the investor becomes part (or whole) owner in
something. This includes common stock in a company, or real estate.

Interest is what a borrower pays a lender for the use of their money. Normally,
this is expressed in terms of a percentage of the principal per year. For
example, a savings account with 1% interest (you are the lender, the bank is the
borrower) will pay you $1 for every $100 you keep there per year.

Liquidity is a measure of how easily convertible an investment is to cash. Money
in a savings account is very liquid, while money invested in a house has low
liquidity because it takes time to sell a house.
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e Principal is the original amount of money invested or borrowed.

e Realized vs Unrealized Gain/Loss, unrealized gain or loss occurs when you've
got a change in price of an asset. You realize the gain/loss when you actually sell
the asset. See also capital gain/loss.

e Return is the total income plus capital gains or losses of an investment. See also
Yield.

o Risk is the probability that the return on investment is different from what was
expected. Investments are often grouped on a scale from low risk (savings
account, government bonds) to high risk (common stock, junk bonds). As a
general rule of thumb, the higher the risk the higher the possible return.

e Shareholder is a person who holds common stock in a company.

e Stock split occurs when a company offers to issue some additional multiple of
shares for each existing stock. For example, a "2 for 1" stock split means that if
you own 100 shares of a stock, you will receive an additional 100 at no cost to
you. The unit price of the shares will be adjusted so there is no net change in the
value, so in this example the price per share will be halved.

e Valuation is the process of determining the market value or the price the
investment would sell at in a “reasonable time frame”.

e Yield is a measure of the amount of money you earn from an investment (IE:
how much income you receive from the investment). Typically this is reported as
a percentage of the principal amount. Yield does not include capital gains or
loses (see Return). Eg: A stock sells for $100 and gives $2 in dividends per year
has a yield of 2%.

Types of Investments

Below is presented some of the broad types of investments available, and examples
of each type.

o Interest-bearing account or instrument

This type of investment usually allows you immediate access to your money, and
will typically pay you interest every month based on the amount of money you
have deposited. Examples are bank savings accounts (and some interest bearing
checking accounts) and cash accounts at your brokerage. This is a very low risk
investment, in the US these accounts are often insured against loss, to a
specified limit.

Sometimes an interest bearing investment is time-locked. This type of
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investment requires you to commit your money to be invested for a given period
of time for which you receive a set rate of return. Usually, the longer you
commit the higher the interest rates. If you withdraw your money before the
maturity date, you will usually have to pay an early withdrawal penalty. This is a
relatively lower risk investment. Examples are certificates of deposit or some
government bonds. Other types of Bonds may have higher yields based on the
higher risks from the quality of the issuer's “credit rating”.

Stocks and Mutual Funds

This is an investment you make in a company, in which you effectively become a
part owner. There is usually no time lock on publicly traded stock, however
there may be changes in the tax rates you pay on capital gains depending on
how long you hold the stock. Thus, stocks are typically quite liquid, you can
access your money relatively quickly. This investment is a higher risk, as you
have no guarantee on the future price of a stock.

A mutual fund is a group investment mechanism in which you can buy into many
stocks simultaneously. For example, a "S&P 500 index fund" is a fund which
purchases all 500 stocks listed in the Standard and Poor's index. When you buy a
share of this fund, you are really buying a small amount of each of the 500 stocks
contained within the fund. Mutual funds are treated exactly like a single stock,
both for tax purposes and in accounting.

Fixed Assets

Assets that increase in value over time are another form of investment.
Examples include a house, a plot of land, or a valuable painting. This type of
investment is very difficult to determine the value of until you sell it. The tax
implications of selling these items is varied, depending on the item. For
example, you may have tax relief from selling a house if it is your primary
residence, but may would not receive this tax break on an expensive painting.

Fixed asset investments are discussed in the chapter on "Depreciation and
Capital Gains". Typically, there is not much to do in terms of accounting for
fixed asset investments except recording the buying and selling transactions.

Setting Up Accounts

To setup investment accounts in GnuCash you can either use the predefined
investment account hierarchy or create your own. The minimum you need to do to
track investments is to setup an asset account for each type of investment you own.
However, as we have seen in previous chapters, it is usually more logical to create a
structured account hierarchy, grouping related investments together. For example,
you may want to group all your publicly traded stocks under a parent account named
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after the brokerage firm you used to buy the stocks.

Regardless of how you setup your account hierarchy, remember that you can always
move accounts around later (without losing the work you've put into them), so your
initial account hierarchy does not have to be perfect.

Predefined Accounts

To use the predefined investment account hierarchy, you must create a new
GnuCash file. This will run the New Account Hierarchy Setup druid. After choosing
the default currency to use, you will be asked to Choose accounts to create. At this
point, choose the "Investment Accounts" option (along with any others you are
interested in). Assuming only “Investment Accounts” were selected, this will create
an account hierarchy as shown below.

usiness Repens Tods Windows Help

]

Edt | New Delowe

= | Description Tatal o

@ Investments Investy

~ i Buokerage Account  Brokerage Account 50.00

it Bond Bond 50.00

i Market Index Market Index $0.00

i Mutual Fund Mutual Fund $0.00

2 Stock Stock $0.00

= & Expenses Expenses 50.00
i Commissions Commissicns 50.00

= i Income
& Drvidend Income
= 2 Inarest Income

2 Bond Intesest

5. grand tatal Assets: $0.00 Profits: $0.00

This is an screen image of the "Accounts" tab after creating a new file and selecting
only the default investment accounts.

You will probably at least want to add a Bank account to the Assets and probably an
Equity:Opening Balance account, as we have done in previous chapters. Don't forget
to save your new account file with a relevant name!

Custom Accounts Example

You can also manually setup your own investment account hierarchy. The following
is a somewhat more complicated example of setting up GnuCash to track your
investments, which has the advantage that it groups each different investment under
the brokerage that deals with the investments. This way it is easier to compare the
statements you get from your brokerage with the accounts you have in GnuCash and
spot where GnuCash differs from the statement.

140 de 273



Assets
Investments
Brokerage Accounts
I*Trade
Stocks
ACME Corp
Money Market Funds
I*Trade Municipal Fund
Cash
My Stockbroker
Money Market Funds
Active Assets Fund
Government Securities
Treas Bond xxx
Treas Note yyy
Mutual Funds

Fund A
Fund B
Cash
Income
Investments

Brokerage Accounts
Capital Gains
I*Trade
My Stockbroker
Dividends
I*Trade
Taxable
Non-taxable
My Stockbroker
Taxable
Non-taxable
Interest Income
I*Trade
Taxable
Non-taxable
My Stockbroker
Taxable
Non-taxable
Expenses
Investment Expenses
Commissions
I*Trade

141 de 273

My Stockbroker
Management Fees

I*Trade

My Stockbroker

There really is no unique way to set up your investment account hierarchy. Play
around, try different layouts until you find something which divides your investment
accounts into logical groups which make sense to you.

Interest Bearing Accounts

Investments which have a fixed or variable rate of interest are one of the simplest
and most common form of investments available. Interest bearing investments
include your bank account, a certificate of deposit, or any other kind of investment
in which you receive interest from the principal. This section will describe how to
handle these kinds of investments in GnuCash.

Account Setup

When you purchase the interest bearing investment, you must create an asset
account to record the purchase of the investment, an income account to record
earnings from interest, and an expense account to record bank charges. Below is an
account layout example, in which you have an interest bearing savings account and a
certificate of deposit at your bank.

Assets
Bank ABC
CD
Savings
Expenses
Bank ABC
Charges
Income
Bank ABC
Interest

As usual, this account hierarchy is simply presented as an example, you should
create your accounts in a form which best matches your actual situation.

Example
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Now let's populate these accounts with real numbers. Let's assume that you start
with $10000 in your bank account, which pays 1% interest and you buy a $5000
certificate of deposit with a 6 month maturity date and a 2% yield. Clearly, it is
much better to keep your money in the CD than in the savings account. After the
initial purchase, your accounts should look something like this:

GUTH PRSI RATTpIE ~ ACEOURES
Ble Edt View Acions Business Repots Tools Windows Help

O x &S @ &8 @

Save Open  Edt  New Delate
[& Accouns [ co|
Account Name = | Description Tanal e
= @ Assets Assets 510,000.00
{2 Bank ABC 510,000.00

& month CD @ 2%

i Savings. Savings @ 1% §5,000.00
= f@ Investmeris Investments. $0.00
b it Brokerage Account  Brokerage Account $0.00
= @ Equity $10,000.00
2 Staring $10.000.00
| @ Expenses Expenses $0.00
i Bank ABC soeo
i Charges Bank ABC service charges s0.00
fa Commissions Commissions s0.00
= @ Income Income $0.00
2 Dividend Income Dividend Income 50.00
@ Interest Income Interest Income s0.00
£ Bood laterest Bond Interast 50.00
®CD & month €0 intesest 50.00 A
ik Savings Interest on Savings - Bank ABC $0.00 S
| 5. grand tatat Assets: $10,000.00 Profits: $0.00 3]

| |

This is an image of the account register after the creation and investing in a CD
investment.

Now, during the course of the next 6 month, you receive monthly bank statements
which describe the activity of your account. In our fictional example, we do nothing
with the money at this bank, so the only activity is income from interest and bank
charges. The monthly bank charges are $2. After 6 months, the register window for
the CD should look like this:

=] x 1) L] L] X

Sme  Close  Duglicaste  Delete Enter  Cancel Blck  Spit  Jump  Schede  Teawster Reconcle

Income C0 | n 535
Income: Interest Income £ | n &35
income-C0 | n B3
Incomeatesest Income C0 | n 839
Income: nterest Income-C0 | n Bap

-

+ e = e [+
Presant $5,050.21 _Futie: 35,050.21 _Cloared: 50.00 S0.00_Propected Mesmum: §5,050.21
Thurscday 30 June 2005 |

This is an image of the register of the CD account after 6 months.
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And this is the main GnuCash window:

@ x = @ L]

Save Open  Edt  New

3 - Description Total 3

Assers

6 month CD @ 2%
& Savings Savings & 1%
= i Ineestments Investments
b Beckerage Accounl  Brokerage Account
= By

i Staning
= G Exponses Expenses
por P
= & Bank ABC
& Charges. Bank ABC senvice charges

& Commissicns Commissions
= i Income: Income
& Dividend Income
= i Inverest Income
5 Bon leaesest
1<
& Savings. Interest on Savings - Bank ABC.

2

This a screen capture of the accounts after 6 months.

From the above image of the main GnuCash account window you see a nice
summary of what happened to these investments over the 6 months. While the yield
on the CD is double that of the savings account, the return on the CD was $50.21
versus $13.03 for the savings account, or almost 4 times more. Why? Because of the
pesky $2 bank charges that hit the savings account (which counted for $12 over 6
months).

After this 6 month period, the CD has reached maturity which means you may sell it
with no early withdrawal penalty. To do so, simply transfer the $5050.21 from the
CD account into the savings account.

Setup Investment Portfolio

Now that you have built an account hierarchy in the previous section, this section
will show you how to create and populate the accounts with your investment
portfolio. After this initial setup of your portfolio, you may have shares of stock
purchased from before you started using GnuCash. For these stocks, follow the
instructions in the Entering Preexisting Shares section below. If your have just
purchased your stocks, then use the Buying New Shares section.

Setup Accounts for Stocks and Mutual Funds

This section will show you how to add stocks and mutual fund accounts to GnuCash.
In this section, we will assume you are using the basic account setup introduced in
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the previous section, but the principles can be applied to any account hierarchy.

You should have within the top level Asset account, a few levels down, an account
entitled Stock. Open the account tree to this level by clicking on the “right facing
triangle marker” signs next to the account names until the tree is opened to the
depth of the new account. You will need to create a sub-account (of type stock)
under the Stock account for every stock you own. Every stock is a separate account.
The naming of these stock accounts is usually done using the stock ticker
abbreviation, though account names may be anything that is clear to you and other
users. So, for example, you could name your accounts AMZN, IBM and NST for your
Amazon, IBM and NSTAR stocks respectively. Below is a schematic model of the
layout (only showing the Assets sub-accounts).

Assets
Investments
Brokerage Accounts
Bond
Mutual Funds
Market Index
Stock
AMZN
IBM
NST

Note

If you want to track income (dividends/interest/capital gains) on a
per-stock or fund basis, you will need to create an
Income:Dividends:STOCKSYMBOL, Income:Cap Gain
(Long):STOCKSYMBOL, Income:Cap Gain (Short):STOCKSYMBOL and
Income:Interest: STOCKSYMBOL account for each stock you own that pays
dividends or interest.

Example Stock Account
As an example, let's assume that you currently own 100 shares of Amazon stock.
First, create the stock account AMZN by selecting the Stock account and click on

the menu File -> New Account. The New Account dialog will appear, follow the
steps, in the sequence below to setup your new stock account.
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General | Opening Balance
Identification
Account name AMZN
Account code:
Description Amazon.com
Security/cumency: Select...
Smallest fraction Use Commodity Value
Notes:
Tax related Hidden
Placeholder
Account Type Parent Account
Mutual Fund | b i Enity |
MCE b @ Expenses
Expense [ b Income -
& Help Mcacel | | Jox |

New Account Window

1.
2.

Account Name - Usually, use the stock ticker abbreviation, IE: “AMZN"”

Account Code - Optional field, use CUSIP, the newspaper listing symbol, mutual
fund family ID or code of your own choosing.

. Description - Optional field for detailed description of the commodity/stock.

Note this field by default is displayed in the Account tab tree.

. Account Type - Select the type of account you are creating from the lower

left-hand list.

. Parent Account - Select the parent account for the new account from the right

hand listing. Expand list of accounts if necessary.

. Create the New Security - To use a new stock, you must create the stock as a

new commodity

o Select Security/Currency - Click on the “Select ...” button next to the
security/currency line. We must change the security from the default (your
default currency) to this specific stock. This will bring up the “Select
Security” dialog.

o Type - Change the type from current to the exchange where the
security/commodity is traded (in this example NASDAQ).
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Select the “New” Button to open the “New Security” window.

Type:  |NASDAQ

Security:

| Btew || cance | | ok |

Select Security Window

o Create the Security - Click on the New... button and enter the appropriate
information for this stock on the new form New Security.

o The Full name: is “Amazon.com Inc”.

o The Symbol/abbreviation: is “AMZN". The symbol is the stock ticket used
in your quote source several lines down on the form. Note that different
symbols will be utilized on different price sources for the same stock, an
example is Ericsson on the Stockholm Exchange is ERIC-B while on
Yahoo it is ERRICB.ST

o The Type: should already be “NASDAQ”.

o The CUSIP or other code is where you can enter some other coding
number or text (leave it blank in this example).

o The Fraction traded should be adjusted to the smallest fraction of this
security which can be traded, usually 1/100 or 1/10000.

o The box “Get On-line Quotes” and the quote source and the timezone
should be selected to define the sources for updating prices on-line. See
Also “Setting Stock Price Automatically”.

If the “Get On-Line Quotes” is not highlighted, and it is not tickable,
then the Finance::Quote package is not installed. See the section on
“Installing Finance::Quote”.

Below is what this window should look like when finished:
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11.

12.

Security Information

Full name Amazon.com
Symbalfabbreviation: | AMZN
Type: [nasDag -

CUSIP or other code:

o)

Fraction traded: 1/

Quote Source Information
| Get Online Quotes.
Type of quote source:
= Singhe: Yahoo
Multiple:

Timezone Use local time

BHep | | gancel | [ Pox .;

New Security Window

o Save Security - Click on the OK button to save this new security, this will
close the “New Security” window and return to the “New Account”
window.

. Select the Security - you should now see the newly created security available in

the pull down menu for Security/Currency. Select it (it is probably already
selected) and click on OK.

. Smallest Fraction - Specify the smallest fraction of the security/commodity that

is traded.

. Notes - Enter any notes or messages related to this security/commodity.

. Tax Related - Go to Edit -> Income Tax Options to check this box if this

account's transactions will relate to Income Taxes.

Placeholder - Check box if this account is a “Placeholder”, that is it will contain
no transactions.

Finished - You should now have been automatically returned to the New Account
dialog, with the symbol/abbreviation: line set to “AMZN (Amazon.com Inc)”.
Click on OK to save this new stock account.

You have now created the Amazon stock account, your main account should look
something like this (notice that there are a few extra accounts here, a bank account,
and an equity account):
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This image is after the creation of the first stock account (AMZN)

Open the account register window for this AMZN stock account (double click on it).
Here you see the Portfolio view. This gives you an overview of your stock portfolio
including the number of shares bought and sold. Obviously, we have not bought or
sold any stocks yet, so the Portfolio view should not contain any transactions.

Buying Shares

Entering Preexisting Shares

To register the initial 100 shares of this stock that you purchased previously, on the
first transaction line, enter the date of the purchase (eg: Jan. 1 2001), a description
(eg: Initial Purchase), transfer from Equity: Opening Balances, Shares (eg: 100), and
Price (eg: $20). You do not need to fill in the Buy column, as it will be calculated for
you. This example assumed there was no commission on this transaction to simplify
the example. Your AMZN Portfolio view should now appear like this:

He Edt Wiew Trapsaction Actons Besiness Repons JToos Windows Help
=] x B 8 *@ X 2 H| =@ e ‘\
Save Clase Duplicate  Delete Enter Cancel Blank Splin Jump  Schedue Transfer
= Accounts | AMZN
| [T ] | I
Assets:Investments:Brokerage Az 0 100 0 2,000.00
Equity-Starting n 2,000.00
(W= : J
L
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This image is of the transaction register of the AMZN account after the first stock
account “purchase”.

Notice that the Balance is in the units of the commodity (AMZN shares) not in
currency units. Thus, the balance is 100 (AMZN units) rather than $2000. This is how
it should be.

Buying New Shares

The only difference between setting up a new stock purchase versus the setup for
preexisting stocks as described in the previous section is that instead of transferring
the money used to purchase the stock from the Equity:Opening Balance account, you
use your Assets:Bank ABC account.

Now you will purchase $5000 of IBM stock, with a commission of $100. First step
will be to create the stock account for IBM. The existing Expense:Commission
account will be used. If you wish to track commissions to the individual stock an
additional sub-account would be necessary.

Now for the transaction, on the first transaction line, enter the date of the purchase
(eg: Jan. 3 2005), a description (eg: Initial Purchase), Shares will be skipped (to be
calculated), Price (eg: $96.60), and Buy ($5000). You do not need to fill in the Share
column, as it will be calculated for you. The next line in the split transaction will be
“Expense:Commission” and fill in Buy ($100). The third line will be to transfer from
Assets:Bank ABC:Saving, $5100 to balance the transaction. Your IBM Portfolio view
should now appear like this:

-, GuideinyestEsample - (M
_.._.:fi-s:ixm:a.:.s._qsiu,_sfa_m_..uj

[= D @ * X E 3 ) ¥ @

T g o 3
Sawe  Close  Dupikste Dete  Eroer  Cascol  Biank pmp  Schedue | Tansfer Reconcle

Ei:w..za‘}_.sr:ﬁzg
il 1 ™y

This image is of the transaction register of the IBM account after the first stock
account “purchase” with a commission.

Setting Share Price

The value of a commodity, such as a stock, must be explicitly set. The stock accounts
track the quantity of stocks you own, but the value of the stock is stored in the Price
Editor. The values set in the Price Editor can be updated manually or automatically.
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Initial Price Editor Setup

To use the Price Editor to track a stock value, you must initially insert the stock. To
do so, open the Price Editor (Tools -> Price Editor) and click on Add button. The
first time a Commodity/Stock is entered this window will be blank except for the
control buttons on the bottom. Select the appropriate Commodity you want to insert
into the Price Editor. At this point, you can input the price of the commodity
manually. There are 5 fields in the New Commodity window:

e Commodity - the name of the commodity, must be chosen from the Select... list
e Currency - the currency in which the Price is expressed.
e Date - date that the price is valid

e Type - one of: Bid (the market buying price), Ask (the market selling price), Last
(the last transaction price), Net Asset Value (mutual fund price per share), or
Unknown. Stocks and currencies will usually give their quotes as one of bid, ask
or last. Mutual funds are often given as net asset value. For other commodities,
simply choose "Unknown". This option is for informational purposes only, it is
not used by GnuCash.

o Price - the price of one unit of this commodity.

As an example of adding the AMZN commodity to the price editor, with an initial
value of $40.50 per share.

Security: _ AMZN (Amazon.com)

|| Select... |

Curency: | USD (US Dollan A

Date  [08/1202003 (-]
Type: _ Last . _
Pice:  [40.54 _

¥ Cancel _ 7 & ok

Adding the AMZN commodity to the price editor, with an initial value of $40.50 per
share.

Click OK when finished. Once you have performed this initial placement of the
commodity into the Price Editor, you will not have to do it again, even if you use the
same commodity in another account.

Setting Stock Price Manually
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If the value of the commodity (stock) changes, you can adjust the value by entering
the Price Editor, selecting the commodity, clicking on edit and entering the new
price.

Secuity Cusrency Date Source Type Price | =
< NASDAQ
= AMZN (Amazon.com)
AMZN (Amazon.com)  USD (US Dolla)  O3/DG2006  userprice-edior last  36.220000
AMIN (Amazoncom)  USD (US Dolla) 022772006  userprice-editor  la 37.210000
AMZN (Amazon.com)  USD (US Dolla)  02/2L2006  user price-edior 38350000
AMZN (Amazon.com) USD (US Dallar) 02132006  user pice-editor  la 39.190000
AMZN (Amazoncom)  USD (US Dalla) 0262006  userprice-edior  last 38.520000
AMZN (Amazoncom)  USD (US Dollan)  OL/302005  userprice-edior  last 38330000
AMZN (Amazoncom)  USD (US Dolla)  OL23/2006  userpice-edtor last 45220000
AMZN (Amazoncom)  USD (US Dalla)  OL17/2006  userpriceedior last  43.920000
AMZN (Amazoncom)  USD (US Dalla)  OLO92006  userpriceedior last 44400000
AMZN (Amazoncom)  USD (US Dolla)  OL/03/2005  userpriceedior last  47.870000
AMZN (Amazoncom)  USD (US Dolla)  06/12/2003  userprce-edior last  40.500000 -
& Add = Remave | £ Edit = Remove Old ) Get Quotes
® Close

The main price editor window, showing the list of all known commodities.
Configuring for Automatic Retrieval of Quotes

If you have more than a couple of commodities, you will tire of having to update
their prices constantly. GnuCash has the ability to automatically download the most
recent price for your commodities using the Internet. This is accomplished through
the Perl module Finance::Quote, which must be installed in order to activate this
feature.

To determine if the Perl module Finance::Quote is already installed on your system,
type “perldoc Finance::Quote” in a terminal window and check to see if there is any
documentation available. If you see the documentation, then the module is installed,
if you do not see the documentation, then it has not been installed.

Installing Finance::Quote

To install Finance::Quote begin by first closing any GnuCash applications you have
running. Second, locate the folder where GnuCash is installed by searching for
“gnc-fgq-update” (without the quotes). Change to that directory, open a root shell and
run the command “gnc-fq-update” (without the quotation marks). This will launch a
Perl CPAN update session that will go out onto the Internet and install the
Finance::Quote module on your system. The gnc-fg-update program is interactive,
however, with most systems you should be able to answer “no” to the first question:
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“Are you ready for manual configuration? [yes]” and the update will continue
automatically from that point.

After installation is complete, you should run the “gnc-fq-dump” test program, in the
same directory, distributed with GnuCash to test if Finance::Quote is installed and
working properly.

Note

If you feel uncomfortable about performing any of these steps, please
either email the GnuCash-user mailing list (<gnucash-user@gnucash.org>)
for help or come to the GnuCash IRC channel on irc.gnome.org. You can
also leave out this step and manually update your stock prices.

Configuring Securities for Online Quotes

With Finance::Quote installed and functioning correctly, you must configure your
GnuCash securities to use this feature to obtain updated price information
automatically. Whether creating new securities or modifying securities that have
already been setup, use the Tools -> Security Editor, to edit the security and check
the Get Online Quotes box. You will now be able to modify the radio buttons for
Type of quote source, the pull-down menus to specify the specific source(s) and The
timezone for these quotes. When finished editing, Close the Security Editor to return
to the Price Editor and click on the Get Quotes button to update your stock prices on
the Internet.

The command “gnucash --add-price-quotes $HOME/gnucash-filename” can be used to
fetch the current prices of your stocks. The file specified “$HOME/gnucash-filename”
will depend on the name and location of your data file. This can be determined by
the name displayed in the top frame of the GnuCash window, before the “-”. The file
name can also be found “File ->” “pull down list”, the first item, numbered 1, is the
name of the currently open file.

This can be automated by creating a crontab entry. For example, to update your file
every Friday evening (16:00) after the relevant exchange markets close (modify the
time accordingly for your time zone), you could add the following to your personal
crontab:

0 16 * * 5 gnucash --add-price-quotes $HOME/gnucash-filename > /dev/null 2>&1

Remember that Mutual Fund “prices” are really “Net Asset Value” and require
several hours after the exchange closes before being available. If NAVs are
downloaded before the current days NAVs are determined, yesterday's NAVs are
retrieved.
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Displaying Share Value

The main account window, by default, only shows the quantity of each commodity
that you own, under the column heading Total. In the case of stocks, this commodity
is the number of shares. Often, however, you will want to see the value of your
stocks expressed in terms of some monetary unit. This is easily accomplished by
entering the main window, selecting the “Accounts” tab, by clicking on the title bar
Options button (the small down pointing arrow on the right side of the main account
window titles bar), and selecting the option to display the account total field “Total
(USD)”. You will see a new column in the main window entitled Total (USD) that will
express the value of all commodities in the report currency.

" = R
J» Edn View Acions Guseess Repots Toos Wiedows Help
Sl -
e Accoures | AMZN
Account Name - Descrigtion ol Tousl (USD) + H
i Bond Bond 00 5000
5 Markes ledex Market Index 5000 50.00
8 Mutual Fund Mutual Fund 50.00 50.00
= ffil Stack Stock 3,580.00 $3,500.00
* AMIN Amazon.com 100 AMEN $3,590.00
= @ Equity
& Starting
= fit Expenses Expenses
< @ Bank ABC
& Charges Bark ABC service chisges

@ Commissicns
= it Income
2 Dividensd Income:
= g Imerest Income
8 Bond Interest
&0
o Savings
£ Orphan-USD

3, grand rotal Assats:

Profis: $0.00

Viewing the value of a stock commodity in the main window using the Total in
Report Currency option.

Selecting "Price Source" in Stock Value Reports

Most GnuCash Asset reports have options to set/modify a number of parameters for
the report. The Options windows is displayed by selecting the report tab then
clicking on either the Options icon in the menu bar or selecting Edit -> Report
Options. The tab "General" in the resulting window contains various parameters for
the report. One of these is "Price Source" which of offers three alternatives to
determine stock prices in reports:
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Accounts | Display General

Report name; _ 3

Stylesheet: | Default :

From: C @ | Curment Year Start =

To: O 3 | End of previous quarter | &

Step Size: | 2Week |+
B Weighted Average

Report's currei an H
Maost recent —

Defaults _

7 ¥ Cancel _

Bhep |

Determining the value of a stock commodity in a report by setting the Price Source
option.

» Weighted Average - gives you a graph of the weighted price of all transactions.
It will not take into account prices defined in the price editor.

e Most recent - displays the changing value of your stocks based solely on the most
recent price available from the price editor. The price figuring in your stock
transactions is not considered.

« Nearest in time - the graph is exclusively based on the prices available from the
price editor. The value of your stock at each step and point in time is calculated
based on the nearest available price in the price editor.
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Tracking what value your stocks would've had on the stock exchanges.

Selling Shares

Entering an investment you are selling is done in the same way as buying one except
the total cost of the transaction is entered in the Sell column and the Shares column
is entered as a negative amount. The net proceeds from the sale should be
transferred from the stock account to your bank or brokerage account.

The proper recording of the stock sale *must* be done using a split transaction. In
the split transaction, you must account for the profit (or loss) as coming from an
Income:Capital Gains account (or Expense:Capital Loss). To balance this income,
you will need to enter the stock asset twice in the split. Once to record the actual
sale (using the correct number of shares and correct price per share) and once to
balance the income profit (setting the number of shares to 0 and price per share to
0).

In the split transaction scheme presented below, the symbol NUM SHARES is the
number of shares you are selling, SELL PRICE is the price for which you sold the
shares, GROSS SALE is the total price for which you sold shares, equal to

NUM SHARES*SELL PRICE. PROFIT is the amount of money you made on the sale.
COMMISSIONS are the brokerage commissions. NET SALE is the net amount of
money received from the sale, equal to GROSS SALE - COMMISSIONS.
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Table 8.1. Selling Stock using Split Transaction Scheme

\Account W.% mber of T&mwm Price |Total Buy Total Sell
ares

[Assets:Bank | | [NET SALE |

[Assets:Stock:SYMBOL [NUM SHARES |[SELL PRICE| [GROSS SALE

[Assets:Stock:SYMBOL [0 [0 [PROFIT [(Loss)

_500390&95_ Gains _ _ _QLOwwv _wNOmEJ

_mxvm:wmm“OoBmemmozw_ _ _OO?:(:mmHOZ_

If you will be recording the sale of the stock as a capital gain (or loss), please see
the chapter “Depreciation and Capital Gains” for more information on this topic.

Example - Sale of stock with profit

As an example, assume you bought 100 shares of a stock for $20 per share, then
later sell them all for $36 per share. In the split transaction scheme above,
PRICEBUY is $20 (the original buying price), NUM SHARES is 100, TOTALBUY is
$2000 (the original buying cost), GROSS SALE is $3600, and finally PROFIT is $1525
(GROSS SALE-TOTALBUY-COMMISSION).

Table 8.2. Selling Stock Split Transaction Scheme

An example of selling stock for gain. You bought 100 shares of AMZN for $20 per
share, and sold for $36.

Fe Edi Wi Atsons Busmess Bepots Jods Windows Hep

7] [— - T ]

Swe Omn Edi  New Do
i Accoun i AMEN
Accounn Name

- Descrgtion Tetal  Tewal (USD) L=

i Bond Bond $0.00 $0.00
it Market Index Markat index 0.00 S000
8t Mutual Fund Mutual Fund

i Seeck Sinck

= Bty
it Staring
@ G Expenses Expenses
~ it Bank ABC

Bark ABC semvice chinges

Cammissions

Income

Interest an Savings - Bark ABE

Assers: $13.58.M4 Profis: §1,525.00

An image of the account tree after the example of selling stock for gain.
Example - Sale of stock with loss

As an example, assume you bought 100 shares of a stock for $100 per share, then
later sell them all for $50 per share. In the split transaction scheme below,
PRICEBUY is $100 (the original buying price), NUM_SHARES is 100, TOTAL BUY is
$10,000 (the original buying price), (Loss) is $5000, and finally GROSS SALE is

$5000. Assume the commission was $100.00.

Table 8.3. Selling Shares at loss Split Transaction Scheme

_booo::a _.wbmwmm_wz.om _mE\ _,wm:
[Assets:Bank _ | [3525.00|
|Assets:Stock:SYMBOL |-100 [36.00 3600.00
|Assets:Stock:SYMBOL (0 0 1600.00
Income:Capital Gains 1600.00
Expenses:Commissions 75.00
mwmman Mn:ga_”_w-”:qnw.m“s!g “.'_nnq.i_- AMHMm Eia“_w“uiu _w mn“;n ?:“‘qnq nun_“m:_n
@ Accoums @ AMZN
(e [Num [Bescopvan [ToBoy  [VotSel [Balnce -
o= ) o
vypio s T M-
_ : —
R
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[Account [Shares|Price [Buy [Sell
[Assets:Bank _ _ [4900.00
[Assets:Stock:SYMBOL [100 [50.00| [5000.00
[Assets:Stock:SYMBOL [0 o | [5000.00
[[ncome:Capital Gains | | [5000. o
[Expenses:Commissions | | [100 |

Note: You may either enter the loss as a positive number in the “buy” column or as a
negative number in the “sell” column, GnuCash will move the “negative profit” to

the other column.
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Above is a screenshot of the example of selling stock. You bought 100 shares for
$100.00 per share, and sold for $50.

GurdelnvestErample - Accounts

Fle Edt View Actons Business Repots ITools Windows Help

W ox B @ W @
Open

Save Edt | Mew Deleie
& Accounts g3 SRWR

Account Name = Description Total Total (USD) +
= & Assets Assets $18488.24 S1B488.24
b @ Bank ABC SI0063.24 1006324
= i Investments Investments $B425.00 $BA25.00
= gt Brokerage Account  Brokerage Account $8,425.00 $8425.00
1 Bond Band 50.00 50.00
8 Market Index Market Index $0.00 50,00
1 Mutusal Fund Mutual Fund 50,00 50,00
= g Stock Stock $0.00 $0.00

1 AMZN Amazon.com 0 AMZN $0.00
Slide Rule & Widget Refurbishing Corp

~ i Equity $22,000.00 $22,000.00
2 Staing $22,000.00  $22,000.00
= g Expenses Expenses $167.00 S187.00
~ g Bank ABC $12.00 $12.00

81 Charges. Bank ABC service charges $12.00 512,00 L |
£ Commissions Commissions. $175.00 $175.00
= & Income Incame $3,324.76 $3,324.76
= @ Cap Gain (Long) $3,400.00 -§3,400.00
i AMZN $1.600.00 §1.600.00

5 SRWR Cap Gain off Slide Rule & Widget Refur $5,000.00 §5,000,00 &

5, grand total Assets: 518,488 24 Prolits: -§3,575.00 |

[ |

An image of the account tree after the example of selling stock for loss.

Dividends

Some companies or mutual funds pay periodic dividends to shareholders. Dividends
are typically given in one of two ways, either they are automatically reinvested into
the commodity or they are given as cash. Mutual funds are often setup to

automatically reinvest the dividend, while common stock dividends usually pay cash.

Dividends in Cash
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If the dividend is presented as cash, you should record the transaction directly in the
asset account that received the money, as income from “Income::Dividends” with a
note mentioning from which commodity it was derived. There is no simple way to
show this transaction from within the stock or mutual fund account itself.

As an example consider the following; a purchase of IBM stock with the dividends
deposited as cash into the Broker Account.

Ble E&t View Trgacton Actions Business Repons Tools Windows Help

-ﬂ_ x 5 ® & X 3 3 =

=
Save Close Duplicate  Delere Enter Cancel Blank Spin Jump  Schedule

DR0B2005 JBM cash dividend ivil 932 n

| 0562005 1BM cash dividend ome: Brokerage Account Dividends 10.35 19.67
|__DBEZ00S 1BM cash dividend me Beokerage Account Dividends 1035 3002

110672005 - ame: Brokerage Account Dividends 10.35 40,57
|__02/E2005 1035 072
|__ 032012005 — Split Transaction — | 4,000.00 495072
| oanuzes Sell Stock far Profit — Split Transaction - 3.555.00 847572
| varw2es Sell Stock far Profit — Split Transaction — | 1.600.00 10.075.72
| =i e

1 |
Present §10,075.72 Future: $10,075.72  Cleared: $0.00  Reconciled $0.00  Projected Minimum: $10,075.72
Wednesday 08 February 2006

An image of the Brokerage Account register after a series of cash dividends.

Note

If you want to track dividends on a per-stock basis, you would need to
create an Income:Dividends:STOCKSYMBOL account for each stock you
own that pays dividends.

Dividends Re-Invested

If you receive the dividend in the form of an automatic reinvestment, the transaction
for this should be handled within the stock or mutual fund account as income from
“Income:Dividend” for the appropriate number of reinvested shares. This type of
reinvest account is often referred to as a DRIP (Dividend Re-Investment Program).

As an example consider the following; purchase of NSTAR (NST) stock with the
dividends reinvested into a DRIP Account. Mutual fund re-investments would be the
same.

Starting with the purchase of 100 shares on Jan. 3, 2005, all dividends will be
reinvested and an account is created to track the dividend to the specific stock.
GnuCash simplifies the entry by allowing calculations within the cells of the
transaction. If the first dividend is $.29/share, enter $53.38 in the share price and
100*.29 in the Buy cell.
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S10,063.24
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Brokerage Account $15,075.72

Dividend Relnvesiment Plans

Total (USD)
$25,138.06
$10,063.24
$15,075.72
$15,075.72

$0.00

i NST NSTAR 1010797 NST $0,00

b g Equity $32,399.00 $32,399.00
v f Expenses Expenses $267.00
b @ Bank ABC §12.00
@ Commissions Commissions 5275.00
= @ Income Interest Income -$3,215.88
b fit Bank ABC §75.24

b Brokerage Account $3,349.28 $3,349.28
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An image of the Accounts tree after a series of dividends reinvestment.

Splits and Mergers

Companies may split their stock for many reasons but the most common is that the
price has risen higher than management thinks is a reasonable price for many
investors. Some of these splits are simple exchanges (eg 2 for 1 or 3 for 2) and some
are complex exchanges with cash distributions. Splits may also result in fewer shares
if the exchange rate is a reverse split (1 for 3 or .75 for 1).

Simple Stock Split

As an example, our holding of NST stock declared a 2 for 1 stock split effective June
6, 2005. The process for entering this transaction is; select Action -> Stock Split to
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start the druid.
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An image of the selection of the stock split druid.

The first screen is an Introduction, select Forward to display the selection of the
account and stock for the split. You will need to create an entry for each

Account:Stock combination you hold.

Stock Split

Stock Account

Select the account for which you want to record a stock split or merger.
Account Symbol = Shares
Assets:Investments: Brokerage Account:Stock:IBEM IBM 51.7598

Assets:Investments: DRIPs:NST NST 101.0797

_ % Cancel _ _ 4 Back __“&mnzaam

An image of the stock split druid at step 2 - Selection of Account/Stock.
Select the “Assets:Investments:DRIPs:NST” and click on Forward.

The next screen presents 5 fields in the Stock Splits Details window:

e Date - Enter the date of the split.
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e Shares - The number of shares increased (or decreased) in the transaction.

In our example it is a 2 for 1 split so the number of additional shares is the
number of shares currently in the register.

» Description - The Description should give a brief explanation of the transaction.

e New Price - If desired the new price of the stock, after the split, may be entered.

e Currency - The currency of the transaction is required. This should be the same
as the stock purchase currency.

Click on the Forward button.

Stock Split

Stock Split Details

Enter the date and the number of shares you gained or
lost from the stock split or merger. For stock mergers
(negative splits) use a negative value for the share
distribution. You can also enter a description of the
transaction, or accept the default one.

Date: _omgeom _E

Shares: (1010797

Description: [NST 2:1 Stock Spli ]

If you want to record a stock price for the split, enter
it below. You may safely leave it blank.

New Price: _

Currency: [USD (US Dallar) -]

| Xcancel | | @Back | [ & Fowand |

An image of the stock split druid at step 3 - Split Details.

The next screen will be skipped in this example as there was no “Cash in Lieu”.
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Stock Split

Cash In Lieu

If you received a cash disbursement as a result of
the stock split, enter the details of thar payment
here. Otherwise, just click Forward'.
Amount: : g
Memo: ﬁnww__ In Lieu _
Income Account Asset Account
= fit Income < f Assets
= fid Bank ABC = @ Bank ABC
= @ Interest ®CcD
@ CD & Saving
wmms:om = i Investments
= i Brokerage Account {fit Brokerage Account
i Cap Gain(Long) it DRIPs
@ Dividends @ Orphan-USD
w Interest
= @ DRIPs
@ NST
| X carcel | | ¢agack | [ & Fomard |

An image of the stock split druid at step 4 - Cash in Lieu.

A final “Finish” screen will give a last option to; Cancel, Back to modify any data
entered or Apply to complete the stock split with the data entered.

3 e
Bl Edi View Trsacion Aciors Eusiness Bepoes ook Wiedows belp
=] x ] L) & X 3

T 3 # B
Save. Clase Duplicate  Delete Enter Cancel Blank

itial Purchaze:
| Reimeeat Dwidend

DEUGZ005 | |21 Stock Sokd

An image of the “Assets:Investments:DRIPs:NST” register after a simple stock split
transaction.

Moderately Complex Stock Merger
As an example, assume you held AT&T stock during the Nov. 18, 2005 merger of

SBC with AT&T. For this example you will have purchased AT&T on April 1, 2005,
any dividends will have been paid in cash, therefore not entered into the AT&T stock

164 de 273



register.

The conditions of the merger were .77942 share of SBC stock were exchanged for
each share of AT&T stock. The merged company continued to use the symbol “T”
from AT&T.

AT&T paid a “dividend” of $1.20/share on the transaction date, however this will not
appear in the stock account as it was a cash distribution.

The process for entering this transaction is identical to the simple split until the
“Details” screen. You will need to create an split entry in each Investment
Account:Stock account combination that has shares splitting.

Stock 5plit

Stock Account

Select the account for which you want to record a stock split or merger.
Account Symbol  Shares

Assets:Investments:Brokerage Account:Stock:IBM IEM 51.7598

Assets:Investments:DRIPs:NST NST 2021594

(4] D

| & mc_.imau

| Mcancel | [ @Back |

An image of the stock split druid at step 2 - Selection of Account/Stock (Investment
Account:T).

Select the “Assets:Investments:Brokerage Account:Stock:T” and click on Forward.
The next screen presents 5 fields in the Stock Splits Details window:
e Date - Enter the date of the split. Here we'll enter November 18, 2005.

e Shares - The number of shares increased (or decreased) in the transaction.
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In our example it is a .77942 for 1 split so the number of shares will decrease
from the number of shares currently in the register. You may use GnuCash's
ability to preform calculations on an entry form by entering data directly (E.g.
“(.77942*%100)-100”) to calculate the decrease in shares from the split.

o Description - The Description should give a brief explanation of the transaction.
e New Price - If desired the new price of the stock, after the split, may be entered.

e Currency - The currency of the transaction is required. This should be the same
as the stock purchase currency.

Click on the Forward button.

Stock split

Stock Split Details

Enter the date and the number of shares you gained or
lost from the stock split or merger. For stock mergers
(negative splits) use a negative value for the share
distribution. You can also enter a description of the
transaction, or accept the default one,

Date: 117182005 =]

Shares: ((.77342°100-100

Description: |SBC / AT&T merger

If you want to record a stock price for the split, enter
it below. You may safely leave it blank.

New Price: [24.38 ]

Currency:  [USD (US Dollan |-

* ¥ Cancel _ _ @ Back _ _ch_éma_

An image of the stock split druid at step 3 - Split Details.
The next screen will be skipped in this example as there was no “Cash in Lieu”.

A final “Finish” screen will give a last option to Back to modify any data entered or
Apply to complete the stock split with the data entered.
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An image of the Investment Account:T register after a stock split transaction that
decreases the shares.

Chapter 9. Capital Gains
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Basic Concepts
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Taxation

This chapter will present some of the techniques used to keep track of the
unrealized and realized gains and losses, better known as capital gains and losses.

Basic Concepts

This chapter will present some of the techniques used to keep track of the
unrealized and realized gains and losses, better known as capital gains and losses.

Certain resellable assets can change value over time, such as stocks, bonds, houses,
or cars. Some assets (eg: a stock) could increase in value, some (eg: a car) could
decrease in value. It is important to be able to track some of these time-dependent
asset valuations, this chapter will show you how.

Probably everything you own will increase or decrease in value over time. So, the
question is for which of these assets should you track this changing value? The
simple answer is that you only need to track this for items which could be sold for
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cash in the future or which relate to taxation.

Consumable and disposable items (eg: food, gas for your car, or printer paper) are
obviously not involved. Thus, even though the new clothes you recently bought will
certainly depreciate, you would not want to track this depreciation since you have
no intention of reselling the clothes and there is no tax implications to the
depreciation on clothing. So, for this example, the purchase of new clothes should be
recorded as a pure expense... you spent the money, and it is gone.

Asset appreciation occurs when something you own increases in value over time.
When you own an asset which has increased in value, the difference between the
original purchase price and the new value is known as unrealized gains. When you
sell the asset, the profit you earn is known as realized gains or capital gains. An
example of an asset from which you could have unrealized gains, and eventually
capital gains, is stock in a publicly traded company.

Estimating Valuation

As mentioned in the introduction to this chapter, capital gains are the profits
received from the sale of an asset. This section will describe how to record capital
gains in GnuCash.

The accounting methods for handling asset appreciation differs somewhat from
depreciation because typically you are only concerned with the moment you sell the
asset and realize the capital gains. This is opposed to the continuous nature of
tracking depreciation. Capital gains are an important subject in the world of
taxation, because governments tend to be quite interested in taxing capital gains in
one manner or another.

Note

As always, there are exceptions. If you hold a bond that pays all of its
interest at maturity, tax authorities often require that you recognize
interest each year, and refuse this to be treated as a capital gain. Consult
the appropriate tax codes to determine the preferred treatment for each
type of asset you have which may be affected by capital gains taxes.

Estimating the increasing value of assets is generally not simple, because often it is
difficult to know its exact value until the moment it is sold.

Securities traded daily on open markets such as stock exchanges are possibly the
easiest type of asset to predict the value of, and selling the asset at market prices
may be as simple as calling a broker and issuing a Market Order. On the other hand,
estimating the value of a house is more difficult. Homes are sold less often than
stocks, and the sales tend to involve expending considerable effort and negotiations,
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which means that estimates are likely to be less precise. Similarly, selling a used
automobile involves a negotiation process that makes pricing a bit less predictable.

Values of collectible objects such as jewelry, works of art, baseball cards, and
"Beanie Babies" are even harder to estimate. The markets for such objects are much
less open than the securities markets and less open than the housing market. Worse
still are one-of-a-kind assets. Factories often contain presses and dies customized to
build a very specific product that cost tens or hundreds of thousands of dollars; this
equipment may be worthless outside of that very specific context. In such cases,
several conflicting values might be attached to the asset, none of them
unambiguously correct.

The general rule of thumb in accounting for estimating unrealized gains (or loses) is
that you should only revalue assets such as stocks which are readily sellable and for
which there are very good estimates of the value. For all other assets, it is better to
simply wait until you sell them, at which time you can exactly determine the capital
gains. Of course, there is no hard rule on this, and in fact different accountants may
prefer to do this differently.

Account Setup

As with most accounting practices, there are a number of different ways to setup
capital gains accounts. We will present here a general method which should be
flexible enough to handle most situations. The first account you will need is an Asset
Cost account (GnuCash account type "asset"), which is simply a place where you
record the original purchase of the asset. Usually this purchase is accomplished by a
transaction from your bank account.

In order to keep track of the appreciation of the asset, you will need three accounts.
The first is an Unrealized Gains asset account in which to collect the sum of all of
the appreciation amounts. The Unrealized Gains asset account is balanced by a
Unrealized Gains income account, in which all periodic appreciation income is
recorded. Finally, another income account is necessary, called a Realized Gains in
which you record the actual capital gains upon selling the asset.

Below is a generic account hierarchy for tracking the appreciation of 2 assets,
ITEM1 and ITEM2. The "Assets:Fixed Assets:ITEM1:Cost" accounts are balanced by
the "Assets:Current Assets:Savings Account" account, the "Assets:Fixed
Assets:ITEM1:Unrealized Gains" accounts are balanced by the "Income:Unrealized
Gains" account (similar for ITEM2).

-Assets
-Current Assets
-Savings Account

169 de 273

-Fixed Assets

-ITEM1
-Cost
-Unrealized Gain

-ITEM2
-Cost
-Unrealized Gain

-Income

-Realized Gains
-Unrealized Gains

Example

Let's suppose you buy an asset expected to increase in value, say a Degas painting,
and want to track this. (The insurance company will care about this, even if nobody
else does.)

Start with an account hierarchy similar to than shown in the section called “Account
Setup”, but replace "ITEM1" with "Degas" and you can remove the "ITEM2"
accounts. We will assume that the Degas painting had an initial value of one hundred
thousand dollars. Begin by giving your self $100,000 in the bank and then
transferring that from your bank account to your "Asset:Fixed Assets:Degas:Cost"
account (the asset purchase transaction). You should now have a main account
window which appears like this:
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=

W @

Save Open  Edit MNew Delete
i Accounts
Account Name v | Type Total 3
7 - i Assets UsSD 100,000.00
P fm Current Assets Asset USD 0,00
- @ Fixed Assets Asset USD 100,000.00
& @Um@mm Asset UsSD 100,000.00
@ Cost Asset UsD 100,000.00
i Unrealized Gain  Asset USD 0.00
P fm Equity Equity USD 100,000.00
- @ Income Income UsD 0.00
fm Realized Gains Income UsD 0.00
fm Unrealized Gains Income USD 0.00
USD, grand tetal: Assets: USD 100,000.00 Profits: USD 0.00 %

The asset appreciation example main window
Unrealized Gains

A month later, you have reason to suspect that the value of your painting has
increased by $10,000 (an unrealized gain). In order to record this you transfer
$10,000 from your Accrued Gains income account (Income:Unrealized Gains) to your
asset Unrealized Gains account (Assets:Fixed Assets:Degas:Unrealized Gain). Your
main window will resemble this:
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=no file> - Accounts .

File Edit Mew Actions Business Reports Tools Windows Help
Save _.mw
@ Accounts
Account Name v | Type Total 3
.q @)mmmﬁm “Pmmmﬁ USD 110,000.00
P f@m Current Assets Asset USD 0.00
4 @ Fixed Assets Asset USD 110,000.00
& @Um@mm Asset USD 110,000.00
@ Cost Asset UsD 100,000.00
i Unrealized Gain  Asset USD 10,000.00
b Equity Equity USD 100,000.00
~ & Income Income USD 10,000.00
fm Realized Gains Income UsD 0.00
fm Unrealized Gains Income USD 10,000.00
_mCmU\ grand total: Assets: USD 110,000.00 Profits: USD 10,000.00 =

Chart of Accounts after unrealized gain
Selling

Let's suppose another month later prices for Degas paintings have gone up some
more, in this case about $20,000, you estimate. You duly record the $20,000 as an
unrealized income like above, then decide to sell the painting.

Three possibilities arise. You may have accurately estimated the unrealized gain,
underestimated the unrealized gain, or overestimated the unrealized gain.

1. Accurate estimation of unrealized gain.

Your optimistic estimate of the painting's value was correct. First you must
record that the profits made are now realized gains, not unrealized gains. Do
this by transferring the income from the "Income:Unrealized Gains" to the
"Income:Realized Gains" account.

Secondly, you must credit your bank account with the selling price of the
painting. This money comes directly from your "Assets:Fixed Assets:Degas"
sub-accounts. Transfer the full "Assets:Fixed Assets:Degas:Cost" value into
"Asset:Fixed Assets:Savings Account”, and the full "Assets:Fixed
Assets:Degas:Unrealized Gain" into "Asset:Fixed Assets:Savings Account".
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These transactions should now appear as follows:

Table 9.1. Turning an Accrued Gain into a Realized Gain

|Assets:Degas:Unrealized Gains

Account

Transaction |Account
|Account Transfer to Amount Total
Income:Unrealized Gains [ncome:Realized $30,000 $0

Gains
. Asset:Fixed
|Assets:Fixed .
Assets:Degas:Cost Assets:Savings $100,000 $0
Account
. Asset:Fixed
Assets:Fixed Assets:Savings $30,000 $0

This leaves the "Asset:Fixed Assets:Savings Account" account with a total of
$130000 and "Income:Realized Gains" with a total of $30000.

<no file> - Accounts

File Edit

Save

@ Accounts

Account Name
.4 @ Assets
P fm Current Assets
< fm Fixed Assets
P @ Degas
b Equity
~ @ Income
fmi Realized Gains
fm Unrealized Gains

Wiew Actions

Business

¥ Type
Asset
Asset
Asset
Asset
Equity
Income
Income

Income

Beports

i

New

Tools Windows Help

[+]

Total 3
UsD 130,000.00
UsD 130,000.00
usD 0.00
UsD 0.00
UsD 100,000.00
UsD 30,000.00
USD 30,000.00

_cmok grand total: Assets: USD 130,000.00 Profits: USD 30,000.00 +

UsD 0.00 [~]

Chart of Accounts after realized gain

2. Under estimation of unrealized gain.

You were over-optimistic about the value of the painting. Instead of the $130000

you thought the painting was worth are only offered $120000. But you still
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decide to sell, because you value $120000 more than you value the painting. The
numbers change a little bit, but not too dramatically.

The transactions should now appear as follows (observe the last transaction
which balances the Unrealized Gains accounts):

Table 9.2. Turning an Accrued Gain into a Realized Gain

Transaction |Account
|Account Transfer to Amount Total
[[ncome:Unrealized Gains [[ncome:Realized Gains [$20,000 [$10,000
|Assets:Fixed Asset:Fixed
|Assets:Degas:Cost Assets:Savings Account $100,000 $0
|Assets:Fixed .

Assets:Degas:Unrealized Asset:Fixed $20,000 $10,000
- Assets:Savings Account

Gains

Assets:Fixed Income:Unrealized

|Assets:Degas:Unrealized Gai : $10,000 $0

Gains ains

This leaves the "Asset:Fixed Assets:Savings Account" account with a total of
$120000 and "Income:Realized Gains" with a total of $20000.

3. Over estimation of unrealized gain.

You manage to sell your painting for more than you thought in your wildest
dreams ($150,000). The extra value is, again, recorded as a gain, i.e. an income.

The transactions should now appear as follows (observe the last transaction
which balances the Unrealized Gains accounts):

Table 9.3. Turning an Accrued Gain into a Realized Gain
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Transaction |Account
|Account Transfer to Amount Total
Income:Unrealized Gains [Income:Realized Gains _wmoboo _w-mo\ooo
|Assets:Fixed Asset:Fixed Assets:Savings
|Assets:Degas:Cost Account $100,000 $0
|Assets:Fixed . .

Assets:Degas:Unrealized ~ [-SSeU:Fixed Assets:Savings |5 $-20,000
Gains Account




Assets:Fixed
Assets:Degas:Unrealized
Gains

Income:Unrealized Gains $20,000 $0

This leaves the "Asset:Fixed Assets:Savings Account" account with a total of
$150,000 and "Income:Realized Gains" with a total of $50,000.

Caution about Valuation

As we see in this example, for non-financial assets, it may be difficult to correctly
estimate the "“true' value of an asset. It is quite easy to count yourself rich based on
questionable estimates that do not reflect "money in the bank."

When dealing with appreciation of assets,
o Be careful with your estimation of values. Do not indulge in wishful thinking.

e Never, ever, count on money you do not have in your bank or as cash. Until you
have actually sold your asset and got the money, any numbers on paper (or
magnetic patterns on your hard disk) are merely that. If you could realistically
convince a banker to lend you money, using the assets as collateral, that is a
pretty reasonable evidence that the assets have value, as lenders are
professionally suspicious of dubious overestimations of value. Be aware: all too
many companies that appear "profitable" on paper go out of business as a result
of running out of cash, precisely because "valuable assets" were not the same
thing as cash.

Taxation

Taxation policies vary considerably between countries, so it is virtually impossible to
say anything that will be universally useful. However, it is common for income
generated by capital gains to not be subject to taxation until the date that the asset
is actually sold, and sometimes not even then. North American home owners usually
find that when they sell personal residences, capital gains that occur are exempt
from taxation. It appears that other countries treat sale of homes differently, taxing
people on such gains. German authorities, for example, tax those gains only if you
owned the property for less than ten years.

Chris Browne has a story from his professional tax preparation days where a family
sold a farm, and expected a considerable tax bill that turned out to be virtually nil
due to having owned the property before 1971 (wherein lies a critical "Valuation
Day" date in Canada) and due to it being a dairy farm, with some really peculiar
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resulting deductions. The point of this story is that while the presentation here is
fairly simple, taxation often gets terribly complicated...

Chapter 10. Multiple Currencies

Table of Contents

Basic Concepts
Account Setup
GnuCash Currency Support
Setting International Preferences
Recording/Updating Currency Exchange (How-To)
Manually Updating Exchange Rates
Automatic Updating Exchange Rates (How-To)
Disabling Exchange Rate Retrieval
Recording Purchases in a Foreign Currency (How-To)
Purchase of an asset with foreign currency
Purchasing foreign stocks
Tracking Currency Investments (How-To)
Purchasing a currency investment
Selling a currency investment
Reconciling Statements in a Foreign Currency (How-To)
Putting It All Together (Examples)
Basic scenario
Configure Accounts
Opening Balance
Purchase a house
Stock Purchasing
Get the online quotes
Lending money to a friend
Buying property in New Zealand with a loan from Japan
Whats next?

This chapter will show you how to setup your GnuCash accounts to use multiple
currencies.

Basic Concepts

GnuCash supports the use of multiple currencies in different accounts. For example,
you can have a bank account setup in Euros, and another using Hong Kong Dollars.

Some of the issues which arise when using multiple currencies is how do you transfer
funds between accounts with different currencies? How do you calculate the overall
value when you have mized currency accounts? How do reports deal with mixed
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currencies?

Account Setup

Your default account currency is set in Edit -> Preferences -> Accounts -> Default
Currency. You should set this parameter correctly, as it will save you much time
when building your account structure.

When you create a new account, you have the option to define the commodity. For
currency accounts, you can specify any one of the hundreds of currencies supported
by GnuCash by simply selecting it from the currency commodity list. You will notice
that the default currency is always whatever you have defined in the preferences.
So, if you mostly work with Euros, but have the occasional Ethiopian Birr account,
be sure to set your preferences to Euro.

As an example, let's set up a typical bank account scenario where you mostly work in
US Dollars, but do also have a European bank account using the Euro currency, as
well as one bank account in Hong Kong using Hong Kong Dollars. So, setup 3 bank
accounts, one using the Euro currency, one in US Dollars, and another in Hong Kong
Dollars. One possible account structure for this would be:

-Assets (USD)
-Current Assets (USD)
-US Bank (USD)
-European Bank (EUR)
-HK Bank (HKD)
-Equity (USD)
-Opening Balances
-USD (USD)
-EUR (EUR)
-EUR (HKD)

Note: the currency of each account is shown in parenthesis.

Since in this example you mostly work in USD, all of the parent accounts are set to
USD. Of course, if you mostly work in Euros, you could change the currency of these
parent accounts to EUR. To totals shown in the account tree window will always be
converted to the currency of each particular account. Notice, we also setup 3
Starting Balances equity accounts, used to initially populate the 3 banks.

Note
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You could also setup just a single Starting Balance account and use a
currency transfer to populate the "different currency" accounts. However,
this is more advanced option, which is explained in a later section (the
section called “Purchase of an asset with foreign currency”.

Below you see the result of this example, in which you start with USD 10,000, EUR
10,000 as well as HKD 10,000 in the three bank accounts. Notice that the total of
the parent accounts only show the value of the currency of subaccounts with
matching currencies. In the future you can setup the exchange rates between the
currencies, and the parent accounts will calculate the converted value of all
subaccounts. See the later section (the section called “Recording/Updating Currency
Exchange (How-To)”) on how to do this.

=no file= - Accounts

Eil

e Edit Mew Actions Business Reports Tools Windows Help

- @ Current Assets Asset
m European Bank Bank
i Hong Kong Bank Bank

i Us Bank

UsD 10,000.00
EUR 10.000.00
HKD 10,000.00
UsSD 10,000.00

UsD 10,000.00
UsD 0.00
UsD 0.00

10,000.00

= = it
Save Open  Edit MNew Delete
@ Accounts
) (=]
Account Name ~ | Type Total Total (USD) | 4
Ba @)mmmﬁm Asset USD 10,000.00 USsD 10,000.00

= fm Equity Equity USD 10,000.00 USD 10,000.00
~ & Opening Balances Equity USD 10,000.00 USD 10,000.00
i Euro Equity EUR 10,000.00 USD 0.00
@ HKD Equity HKD 10,000.00 UsD 0.00

@ usD Equity USD 10,000.00 USD 10,000.00 M

l [T+

_CmU\ grand total: ~ Assets: USD 10,000.00  Profits: USD 0.00

Initial setup of 3 bank accounts with different currencies.

Notice that the "Total (Report)" column is being displayed. This is configured in the
column header row, select Arrow down and select “Total(USD)”.

GnuCash Currency Support

GnuCash supports over a hundred currencies, from the Andorran Franc to the
Zimbabwe Dollar. You will also find supports for some lesser popular currencies like
the US Dollar, Canadian Dollar, European Euro, and British Pound.
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Setting International Preferences

GnuCash allows you to specify the following international related preferences
e Default currency you want the newly created registers to have
e Default currency for the reports
e Date and Time formats
e Euro support

For a full explanation of the International Preferences available, see the section
called “Setting Preferences”

Recording/Updating Currency Exchange (How-To)

GnuCash allows you to update the Currency Exchange Rates in two different ways,
manual and automatic. In the following two sections we will work through both
ways.

Before we start, let's have a quick look at the Chart of Accounts

=no file= - Accounts

File Edit View Actions Business Reports Tools Windews Help

= [

ﬁ.u-_

Save Open  Edit New Delete
E Accounts
Account Name ~ | Type Total Total (USD) AM
g @)mmmﬁm ‘>mmmﬁ UsD 10,000.00 UsD Hobn_c.cc‘
— @ Current Assets Asset USD 10,000.00 USD 10,000.00
m European Bank Bank EUR 10,000.00 UsD 0.00
fii Hong Kong Bank Bank  HKD 10,000.00 USD 0.00
i US Bank UsD 10,000.00 USD 10,000.00
= fm Equity Equity USD 10,000.00 USD 10,000.00
~ & Opening Balances Equity USD 10,000.00 USD 10,000.00
i Euro Equity EUR 10,000.00 USD 0.00
@ HKD Equity HKD 10,000.00 UsD 0.00
@ usD Equity USD 10,000.00 USD 10,000.00 |7
[l moy
USD, grand total:  Assets: USD 10,000.00  Profits: USD 0.00 ¥
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Initial setup of 3 bank accounts with different currencies.
Manually Updating Exchange Rates

Open the Price Editor by going to Tools -> Price Editor.

Securty Currancy Date Source Tpe  Price LS
odd | = remove old | | S Get quotes

Price Editor Window.

Click on the Add button to add a new currency exchange. A window will appear to
allow you to select the commodity you wish to define the exchange rate for. Click on
Select and set the Type to Currency and the Currency/security to EUR (Euro). This
window should appear like this:

Select security/currency’

Fpe: CURRENCY [v]
Securityjcurrency:  |EUR (Euro) !

_ [ ew :kmm:nm_: Pok _

Price Editor Select Commodity Window

Click Ok and in the Select Commodity window, set the exchange rate between the
selected commodity and the selected currency. In this example, you will set the
exchange rate to 1 EUR to 1 USD.
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Price Editor
Security: _mc_u, (Euro) __mm_mnﬁ.:_
Currency: ?mc (Us Dollar) _ - _
Date: ﬁMDDm‘DH‘HD
Type: _Cs_n:osj > _
pricer  [1 _

lIX Cancel &Pok

Price Editor Select Commodity Window

Security Curmancy Date Source Trpe
T CURRENCY
= EUR (Euro)
EUR (Eura) USD (US Dellar)  2006-01-10  usersprice-editor unknown

T ws ] T

Price b

1.000000

| &a et quotes

The Price Editor window after setting the exchange rate between Euros and US

Dollars
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File Edit Mew Actions

<

=no file= - Accounts

Business PReports Tools Windows Help

W @

= i Current Assets
i European Bank

# US Bank

B @mnr_;f
= il Opening Balances
@mca
fm HKD
i USD

Asset USD 20,000.00
Bank EUR 10,000.00

fm Hong kKong Bank Bank HKD 10,000,00

USD 10,000,00
Equity USD 20,000.00
Equity USD 20,000,00
Equity EUR 10,000.00
Equity HKD 10,000,00
Equity USD 10,000,00

UsD 20.000.00
UsD 10,000.00

UsD 0.00
UsD 10.000.00
UsD 20,000.00
UsD 20,000.00
UsD 10,000.00

UsD 0.00
UsD 10.000.00

Save Open  Edit MNew Delete

il Accounts

Account Name v | Type Total Total (USD) | &
g @.}mmmﬁm Asset USD 20,000.00 USD 20,000.00

USD, grand total:  Assets: USD 20,000.00

Profits: USD 0.00

-

_

—

Chart of Accounts after setting the exchange rate between Euros and US Dollars.

Observe that since you have no exchange rate for HKD, GnuCash do not convert the
HKD accounts to USD. This will be added in the next section.

Automatic Updating Exchange Rates (How-To)

In the previous section you saw how you could manually define a new currency
exchange rate, but there must be an easier way to do it. And there is.

Open the Price Editor by going to Tools -> Price Editor.

Security Currency
¥ CURRENCY

= EUR (Eura)

edd |

EUR{Eura)  USD (US Dallar)

Date Source Type Price 3
2006-01-10  usersprice-editor unknown 1000000
- Remove Old i | 8 et quotes

Price Editor Window before you obtain online quotes.

Click on the Get Quotes button to automatically load the various exchange rates you
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need.

Note

If the Get Quotes button is disabled, that means that the perl module
Finance::Quote is not installed. For information on how to install it, please
see the section called “Configuring for Automatic Retrieval of Quotes”

Security Currency Date Source Type Prica R 2
¥ CURRENCY
= EUR (Eura}
ELR (Ewre)  USD (US Dellar) 2006-04-26  Finance::Quote  last 1.240900
EUR(Euro)  USD (US Dollar) 2006-01:10  userprce-editor unknown  1.080000
= HKD (Hong Kong
HKD (Hong Ko USD (US Dollar)  2006-04-26  FinancenQuete  last 0.128900

| w=remove 0ld | | S Get quotes

4 add

Price Editor Window after we obtained online quotes.

You noticed that GnuCash will download exchange rates for all currencies you are
using in your various accounts. This will happend everytime you click on Get Quotes
or have GnuCash downloading quotes/exchange rates automatically as per the
section called “Configuring for Automatic Retrieval of Quotes”

And if you check the main Chart of Accounts you now see that GnuCash has
automatically converted the HKD amount to USD amount on the parent accounts
that are in USD, as well as on the Total (USD) column. Also the Euro accounts have
been been updated with the latest exchange rate.
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_~ Currency ExchangelUpdates - Accounts

File Edit Mew Actions Business Reports Tools Windows Help

= W @

Save Open  Edit MNew Delete

@ Accounts

Account Name v | Type Total Total (USD) |
~ @)mwmﬁm Asset USD 23,706.00 USD 23,706.00

~ @ Current Assets Asset USD 23,706.00 USD 23,706.00
i European Bank Bank EUR 10,000.00 USD 12,417.00

i HK Bank Bank HKD 10,000.00 USD 1,289.00

i US Bank Bank USD 10,000.00 USD 10,000.00

~ fm Equity Equity USD 23,706.00 USD 23,706.00
= fm Opening Balances Equity USD 23,706.00 WSD 23,706.00
fim Euro Equity EUR 10,000.00 USD 12,417.00

i HKD Equity HKD 10,000.00  USD 1,289.00

i USD Equity USD 10,000.00 WSD 10,000.00

[USD. grand total:  Assets: USD 23,706.00 Profits: USD 0.00 % |

Chart of Accounts after we obtain online quotes.
Disabling Exchange Rate Retrieval

Whenever you create an account that uses a non-default currency, exchange rate
retrieval will be automatically enabled for that currency. However, if you later
delete that account, GnuCash will not automatically disable exchange rate retrieval
for that currency.

If you have deleted the last account for a particular currency, and you do not wish to
retrieve exchange rates for that currency anymore, do the following:

e Open the Securities window by selecting Tools -> Security Editor.
e« Make sure the Show National Currencies box is selected.
+ Expand the CURRENCY row.

e Double click on the currency for which you want to disable exchange rate
retrieval.

e Deselect the Get Online Quotesbox and click OK.

Recording Purchases in a Foreign Currency
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(How-To)
You can do it in two different ways.

1) Use GnuCash build in currency exchange between accounts when you do your
transactions. This is mainly used for one time transactions, and nothing which
happens regurarly.

2) Use separate accounts for this Purchase, where all involved accounts use the
same currency. This is the recommended method, since it allows much better
tracking and follow up. In this way, you do one currency exchange transaction, and
after that you do normal transactions.

The rest of this section will explain more based upon option 2)
Purchase of an asset with foreign currency

Your normal place of residence is in Florida, therefore you are using USD as your
default currency. But, you do like to travel to Bahamas and go fishing. You like it so
much so you decided to purchase a boat there. To do this, you opened a bank
account in Jamaica, moved some money from US, and then purchased your dream
boat (smallest version)

To record this in GnuCash we use the following basic account structure

-Assets (USD)
-Current Assets (USD)
-US Bank (USD)
-Jamaican Bank (JMD)
-Fixed Assets (USD)
-Boat (JMD)
-Equity (USD)
-Opening Balances
-UsSD (USD)

Note: the currency of each account is shown in parenthesis.

First you need to transfere some money ($10,000) to Jamaica, and you use your
normal US bank account (whith balance of $100,000) for that. The bank give you an
exchange rate of USD 1 = JMD 64, but charges you USD 150 to do transfer the
money.
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3 m.:.n:‘._..mz;n;..x-_v;u,:‘=wwu:v.
Ble Edt Mew Fapsaction Actions Busness Bepons Dols Mindows Help

B * ® @ <+ x 2[H|=® T & .

Save  Close  Duplcate Delete Enter  Cancel Blark | Splk | jmp  Schedule  Transfer

& Accounts | jamaican Bank fi US Sank

[Fezaunt: [ [Dspasit  [withdrawal | B
| Equily:0penng BalancesiUSE |n | 100.000.00 | 06,00
0.000.00 | |

Jarmaca

BT

v

Transfer money to Jamaica

Select the Jamaica transaction line ($9,850.00), right click and select Edit Exchange
Rate

Transfer Funds

Basic Information

Amount:
Date:

Num:
Description:

Memo:

Transfer From Transfer To

Currency: USD (US Dollar) Currency: |MD (Jamaican Dallar)

Currency Transfer

® Exchange Rate: |64.00 1 USD = 64.000000 |MD

1JMD = 0.015625 USD

A dialog window where the exchange rate in a currency transaction is specified

To Amount:

As Exchange Rate you enter 1 USD = 64 JMD, since this is the rate your bank gave.
Press ok in the Transfer Funds (Edit Exchange Rate) window, and then save this split
transaction. Below is how it now looks in the main Chart of Accounts.
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Currency_ExchangeUpdates - Accounts

File Edit Mew Actions

Business PReports Tools Windows Help

m

Save New
i Accounts

Account Name v | Type Total Total (UsD) |

B @.}mmmﬁm Asset USD 99,850.00 USD 99,850.00

B @ Current Assets Asset USD 99,850.00 USD 99,850.00

@ Jamaican Bank Bank  JMD 630,400.00 USD 8,850.00

@ US Bank Bank USD 90,000.00 USD 90,000.00

B @ Fixed Assets Asset UsD 0.00 UsD 0.00

@ Boat Asset JMD 0.00 USD 0.00

< i Equity Equity USD 100,000.00 USD 100,000.00

& @oﬁum:,:m Balances Equity USD 100,000.00 USD 100,000.00

@CmU Equity USD 100,000.00 USD 100,000.00

~ f Expenses Expens USD 150,00 USD 150,00

i Service Charge Expens UsD 150.00 UsD 150.00

USD, grand total:  Assets: USD 99,850.00  Profits: -USD 150.00 &

|

| —

Chart of Accounts before purchasing the boat

You find the boat, and since it's a bargain at JMD 509,000 you decide to buy it. To
record this transaction in GnuCash, you will need to enter a simple transaction in
Assets:Current Assets:Jamaican Bank withdrawing 509,000 and transfering it to

Assets:Fixed Assets:Boat
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| = Currency_ExchangeUpdates - Accounts
File Edit Mew Actions Business Reports Tools Windows Help

B @ W @

Save Open  Edit MNew Delete

il Accounts

Account Name

Type Total Total (UsD) |

= fm Assets Asset USD 99,850.00 USD 99,850.00
= W Current Assets Asset UsD 91.896.88 USD 91,896.88

% Jamaican Bank JMD 121,400.00 USD 1,896.88

@ US Bank Bank USD 90,000.00 USD 90,000.00

B @ Fixed Assets Asset usD 7,853.12 UsD 7,953.12
@ Boat Asset  |MD 509,000.00 UsD 7,953.12

~ fi Equity Equity USD 100,000.00 USD 100,000.00
= @oﬁum:,:m Balances Equity USD 100,000.00 USD 100,000.00
@CmU Equity USD 100,000.00 USD 100,000.00

= f Expenses Expens USD 150,00 USD 150,00
i Service Charge Expens UsD 150.00 UsD 150.00

USD, grand total:  Assets: USD 99,850.00  Profits: -USD 150.00 &

Chart of Accounts after purchasing the boat

The Chart of Accounts now reflects that your bank account has been reduced with
the value of the boat (JMD 509,000), and that your Fixed Assets boat account has
been increased with the same amount. If you also have turned on the CoA (Column
Choice) "Total (USD)" you will see the corresponding value in USD. The USD value
will always reflect the latest currency exchange rate you have either automatically
or manually updated GnuCash with.

Purchasing foreign stocks

This example will show how to purchase stocks that are priced in a different
currency than your normal currency.

Assume that you live in New York and therefore you have set the default currency to
USD. You decide to purchase a stock traded in Hong Kong that is priced in HKD.
You would also like to be able to track the various income and expenses per stock
and broker.

You decide to purchase stock in the Beijing Airport (Hong Kong). (After all, the 2008
Olympics in Beijing have finished and the price has returned to Earth.)

Note
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The above stock (Beijing Airport) has been chosen only as an example, and
should not be taken as any kind of stock purchase advice.

You need to find out what the stock ticker is for this stock. To do this, you do a bit of
investigation on the Internet, and in particular on Yahoo! Finance - Ticker Symbol
Lookup (http://finance.yahoo.com/lookup). This gives you the following:

e Beijing Airport has the Stock Symbol 0694.HK at Yahoo

Since we wanted to be able to track all various incomes and expenses, we come up
with the following Account structure:

Assets:Investments:Brokerage Accounts:Boom:0694. HK
Assets:Investments:Brokerage Accounts:Boom:Bank
Equity:Opening Balances:HKD (HKD)
Expenses:Commissions:Boom.0694.HK (HKD)
Income:Investments:Dividend:Boom:0694.HK (HKD)

(Beijing Airport)
(HKD)

The Chart of Accounts looks like this after creating all the needed accounts:

Currency_BeforeStockPurchase - Chart of Accounts

Fle Edit View Actions Business Beports ools Windows Help
mmm ﬁ
@ Chart of Accounts
Account Name ¥ Type Commodity Total|  Total (USD)| &
- mwbmmmam Assat Us Dallar usD 0.00 UsD 0.00
b E Investrments Asset US Dallar usD 0.00 USD 0,00
= fm Brokerage Account Bank uUs Dallar USD 0.00 USD 0.00
~ ffii Boom Bank Hong Kong Dollar  HKD 0.00 USD 0.00
mw 0694 . HK Stock Beijing Airport 0 0694 HK USD 0.00
i Bank Bank Hong Kong Dellar  HKD 0.00 USD 0,00
< g Equity Equity  US Dallar USD 0.00 USD 0.00
= @ Opening Balances Equity  US Dollar USD 0.00 UsD 0.00
i HKD Equity  Hong Kong Dellar HKD 0.00 UsD 0.00
< g Expenses Expense US Dallar usD 0.00 usD o.00
= fl Commissions Expense US Dollar usD 0.00 UsD 0.00
hd Dmuo:.. Expense Hong Kong Dollar HKD 0.00 UsD 0.00
i 0654 HK Expense Hong Kong Dellar  HKD 0.00 UsD 0.00
= g Income Incorme  US Dallar UsD 0.00 UsSD 0.00
= i Investments income  US Dallar USD 0.00 USD 0.00
= fm Dividend Income  US Dollar USD 0.00 USD 0.00
b @ Boom income  Hong Kong Dellar  HKD 0.00 UsD 0.00
USD, grand total: Assets: USD 0.00 Profits: USD 0.00 5
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Chart of Accounts for international stocks

The stock definition can be seen in the Security Editor. (Tools -> Security Editor)

Securities
Securities
Mamespace Symbal Name Source Timezone 3 =
+ CURRENCY
¥ HK

0694.HK Beijing Airport  yahoo_asia Europe/London =
ar ™
«| Show Wational Currencies

[ ad |

International securities

If you have not moved some money (HKD 50,000) into the brokerage's cash account
(Assets:Investments:Brokerage Account:Boom:Bank), do so now, either using the
Equity (HKD) account, or an existing bank account (Currency Transfer).

Let's assume that stock price is HKD 3 per share. To record the purchase, open the
brokerage's HKD cash account (Assets:Investments:Brokerage Account:Boom:Bank),
and enter the following:

Buy Stocks

Assets:Investments:Brokerage Account:Boom:Bank Withdrawal 50,000
Expenses:Investments:Commission:Boom HKD Deposit 500
Assets:Investments:Brokerage Account:Boom:0694 Deposit 49,500 (16,500 shares)

If the exchange rate dialog box does not appear automatically, right-click on the

stock row, and select Edit Exchange Rate. Enter the number of shares (16,500) as
the To Amount.
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Transfer Funds

Basic Information

Amount;
Date:

Num:
Description;

Memo:

Currency Transfer

Exchange Rate!

® To Amount: 16,500.00

Transfer From Transfer To

Currency: HKD (Heng Kong Dollar) Currency: 0694.HK (Beijing Airport)

1 HKD = 0.333333 0694 .HK

10694 .HK = 3.000000 HKD

| X Cancel | | gPox

Setting the number of shares in the Transfer Funds dialog

If you return to the Chart of Accounts, you will see the purchased shares reflected in

the stock account's total.

g Currency_BeforestockPurchase - Chart of Accounts
m__oma;S@zwnn_o:mm:m_:mmm@nboanoo_mEDaQinEw_u

Mmm nm: w m Gﬁm
@ Chart of Accounts
Account Name ¥ | Type Commodity Total|  Total (UsD)| &
= f@ Assets Asset US Dollar USD 0.00 usD 0.00
= @i Investments Asset US Dollar UsSD 0.00 uUsD 0.00
> fm Brokerage Account Bank Us Dellar UsD 0.00 usD 0.00
= {5 Boom Bank Haong Kong Dollar HKD 0.00 USD 0.00
1 0694 HK Beijing Airpart 16,500 0694.HK usD 0.00
i Bank Bank Hang Kong Dollar HKD 0.00 USD 0.00
< fi® Equity Equity  US Dollar usD 0.00 usD 0.00
= @ Opening Balances  Equity  US Dollar usD 0.00 usD 0.00
i HKD Equity  Hang Kong Dollar HKD 50,000.00 UsD 0.00
= M Expenses Expense US Dollar USD 0,00 USD 0.00
= g Commissions Expense US Dollar UsD 0.00 uUsD 0.00
b fmBoom Expense Hong Kong Dollar HKD 500.00 usD 0.00
b f@ Income Income  US Dollar usD 0.00 usD 0.00
| uso, grand tatal Assets: USD 0.00 profits: USD 0.00 B
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Chart of Accounts with some international stocks

However, as you can see, the USD totals may be zero if GnuCash doesn't have an
exchange rate between USD and HKD. To fix this, go to Tools -> Price Editor and
click the Get Quotes button to automatically retrieve the exchange rates you need.

Note

This example shows how stock can be purchased in any currency by
entering the transaction in the register of the cash account used to make
payment. It is also possible to enter the purchase in the stock account's
register, but proceed with caution! When doing it that way, the stock is
assumed to be priced in the currency of the stock account's parent.

In this example, the stock account's parent (Assets:Investments:Brokerage
Account:Boom) is denominated in HKD. Since this is same currency as the
stock price, the purchase can be safely entered in the stock account's
register.

Tracking Currency Investments (How-To)

Currency investment is when you decide to invest in different countries currency,
and hope that their currency will raise in value relative your own currency.

When you enter these transactions into GnuCash, you will have to decide on how
much details you would like to have.

If you are not interested in details at all, a very simple account structure would be
enough. Something like this;

Assets:Investments:Currency:Bank (USD)
Assets:Investments:Currency: XXX (XXX)

But, if you do want to be able to track the Capital Gains or Losses, as well as the
various fees, you do need a bit more complexed layout. Something like this;

Assets:Investments:Currency:Bank (USD)
Assets:Investments:Currency:Currency Bank:XXX (XXX)
Expenses:Investments:Currency:Currency Bank:XXX  (XXX)
Income:Investments:Currency Bank:Capital Gains: XXX (XXX)

Where XXX is the currency you are investing in.
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Note

There is currently (30 April 2006) a small bug ( 340041 ) in GnuCash, that
makes it impossible to track currency investments capital gains.

Purchasing a currency investment

A typical purchase order might be something like this, seen from the
Assets:Investments:Currency:Bank.

Table 10.1. Buying a currency with a Split Transaction Scheme

[Account [Deposit |Withdrawal
|Assets:Investments:Currency:Bank mmwoﬂwﬂmcmw
Expenses:Investments:Currency:Currency

Bank:XXX Exchange Fee
[Assets:Investments: Currency:XXX _ [Sold Amount
Income:Investments:Currency Bank:Capital

Gains: XXX [LOSS] PROFIT
|Assets:Investments:Currency: XXX MWOoMMM Auswww To Ww%omcwmsu\;% M,o

|[Account [Deposit |Withdrawal
Invested
|Assets:Investments: Currency:Bank Amount

Expenses:Investments:Currency:Currency

Bank:XXX Exchange Fee

Invested Amount -
Exchange Fee

|Assets:Investments:Currency: XXX

You should get an Exchange Rate window popping up when you leave the last row in
the split above (Currency Transaction). If this window do not pop up, right click on
the row, and select Edit Exchange Rate. In the Exchange Rate window you specify
the exchange rate you got from the bank.

Selling a currency investment

Entering an currency you are selling is done in the same way as buying one except
the you are now transfering money from the Currency account to your Savings
account (very much similar to (the section called “Selling Shares”).

The proper recording of the currency sale *must* be done using a split transaction.
In the split transaction, you must account for the profit (or loss) as coming from an
Income:Capital Gains account (or Expense:Capital Loss). To balance this income,
you will need to enter the Currency asset twice in the split. Once to record the
actual sale (using the correct amount and correct exchange rate) and once to
balance the income profit (setting the amount to 0).

In short, a selling Currency transaction should look something like below, seen again
from the Assets:Investments:Currency:Bank.

Table 10.2. Selling a currency with a Split Transaction Scheme
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Note

There is currently (30 April 2006) a small bug ( 340041 ) in GnuCash, that
makes it impossible to track currency investments capital gains.

Reconciling Statements in a Foreign Currency
(How-To)

Reconciling foreigh statement are done in the same manner as when you reconcile
your local bank statement. If you have created a Chart of Accounts structure which
allows you to have the same Currency per account as your Reconcile Statement, it is
actually exactly the same as reconciling your local bank statement, apart from the
fact you might need a dictionary

If you have different currencies you might have to manually convert the amounts
from one currency to another while you reconcile the accounts.

Putting It All Together (Examples)

In this Putting It All Together you will use quite a bit of what you have learned so far
in this guide with a bit of a twist. The twist beeing a lot of different currencies.

Basic scenario

The following are the basic scenarios.
¢ You live in Australia and use AUD as our default currency

* You win the lottery as well as inherit some money
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¢ You pay of your existing house loan

e You purchase some stocks in Sweden using SEK (Ericsson B-Fria)
e You purchase some stocks in HK using HKD (Beijing Airport)

e You purchase some stocks in US using USD (Amazon)

¢ You lend some EURO to a friend (Peter)

e You borrow some money from a Japanese bank

e You buy a house in New Zealand

* You use a credit card in Australia

e You would like to have maximum control of your expenses
Note

Again these samples are not to be consider a valid and accurate advice.
They are only to be considered as an sample for the techniques used in
GnuCash, and not as a Investment Advice. Please consult a proper financial
advisor for more information regarding international investments/loans.

Configure Accounts
This time let's start with a fresh and new GnuCash data file, so File -> New, and edit
preferences (Edit -> Preferences) to set Default Currency as AUD. Since you have

decided to be able to track as much of your various expenses and incomes as possile,
the following account hierarchy could be used;

Assets:Current Assets:Savings Account (AUD)

Opening Balance

You open the mail one morning, and to your enormous surprise find that you are the
last living relative of a very distant relative who happend to be very rich. And also
$500,000 AUD richer. That was not the last though, another mail states you won the
lottery, and got $250,000 AUD for that.

To record these transaction we need the following accounts
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(AUD)
(AUD)

Equity:Lottery
Equity:Inheritance

The transactions you enter into your Assets:Current Assets:Savings Account should
look like this.

Table 10.3. You come into some extra money

_>oooc3 _anmmmm _Uooammmm
[[ncome:Lottery  [$250,000
[[ncome:Inheritance [$500,000 |

And the Chart of Accounts looks like this after above transactions have been
entered.

n::m_._nw_l.v_.h.-..._..n._n.m_nrg - Accounts
Fle Edit View Actions Business Reports Tools Windows Help

Save open  Edit New  Delete
fm Accounts |
Account Name *  Type Commedity Total| Total (USD)

Australian Dollar

- {4 Assets

$750,000.00

< g Current Assets Asset Australian Dollar $750,000.00 UsSD 0,00
= Savings Account  Sank Australian Dallar $750.000.00 UsD 0.00

= @ Equity Equity  Australian Daollar $750,000.00 USD 0.00
@ Inheritance Equity  Australian Dollar $500,000.00 USD 0.00

it Lottery Equity  Australian Dallar $250,000.00 USD 0.00

[ v

usO, grand total Assets: USD 0.00 profits: USD 0.00 s

Chart Of Accounts after receiving some money
Purchase a house

Atlast you can afford to pay of that house loan you had to take some years ago (with
a $50,000 deposit).

Assets:Fixed Assest:House
Liabilities:Loans:Mortgage
Expenses:Interest:Mortgage Interest
Equity:Opening Balance

(AUD) $300,000

(AUD) $250,000
(AUD)

(AUD) $50,000
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After you have had a small chat with your Mortgage bank, they agree to let you pay
it all of in one go, plus some interest (AUD 30,000). You should enter the following
split transaction into Assets:Fixed Assest:House account.

Table 10.4. Paying of the house mortgage

_>ooo:3 _Enﬁmmmm _Uoonmmmm
_kpmmmﬁmuocqocﬁ Assets:Savings >ooo:3_ _mmoooo
_mxvmamm”EﬁoﬁmmeoS@m@m Interest _woooo _
[Libilities:Loans:Mortgage [250000 |

The Liabilities:Loans:Mortgage Transaction Ledger looks like this after the
transacations have been entered

5 currency_PulToGether - Mo gage
";na.wi.;E;Su"gswmL,:u:wun:«Un_mh._no.._uau

H *» b g + x 3 ® B & .

saw Close  Duplicate  Dalete & Cancel Blank ump  Scheduls  Tansfer

it Accounts | House | @ Savings Account & Mo
[Bat [wur [Gesergton
200" 1] [Buying House

[Tt Dacrean 1ok increass [Galance -
T [ 250.00000]  250.600.00
| 300.000.00

50,000.00
250.00000

280,000,490

Frasard $000_Fulure 40 00 Clamred:$0.00_Raconcled: 000 Projciad Mikrum:$0.00
Faying of the house

Transaction Ledger of the House Loan
Stock Purchasing

Since you quite suddenly have a lot of money in your bank account, you decide to
visit a Financial Advisor, and after his recommendation (remember, this is fictional -
Not a genuine stock purchase advice) you decide to purchase Telecommunication
(Ericsson in Sweden), Beijing Airport (Hong Kong), and Amazon (USA).

The needed accounts to track these investments looks like this.

Assets:Investments:Swedish Broker:ERIC.ST (STOCK ERIC.ST Yahoo)

Assets:Investments:Swedish Broker:Bank (SEK)
Assets:Investments:HK Broker:0694.HK (STOCK 0694.HK Yahoo)
Assets:Investments:HK Broker:Bank (HKD)

Assets:Investments:US Broker:AMZN (STOCK AMZN Nasdaq)
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Assets:Investments:US Broker:Bank (USD)
Expenses:Investments:Commissions:Swedish Broker:ERIC.ST (SEK)
Expenses:Investments:Commissions:HK Broker:0694.HK (HKD)
Expenses:Investments:Commissions:US Broker:AMZN (USD)

Expenses:Investments:Currency Transfer (AUD)

You decide to invest $100,000 into each stock, and to do this we first do a currency
transaction to the various bank accounts associated with the stock.

The transaction you enter into your Assets:Current Assets:Savings Account should
look like this.

Table 10.5. Transfer money to overseas with a multiple currency transaction
split.

|Account Deposit Withdrawal Exchange  [Transaction
Rate Fee

|Assets:Investments: Swedish 100000 5 5869 35

Broker:Bank

|Assets:Investments:HK

Broker:Bank 100000 5.8869 30

|Assets:Investments:USD

Broker:Bank 100000 0.7593 25

Now when there is some money in the various stock brokerage accounts, you ask
each broker to buy stocks for the certain amount. Remember to execute the
transaction from the stocks associated bank account, and if the Exchange Rate
window do not pop up, right click the row and manually start it. Enter the number of
stocks you purchase in the last entry (To Amount:).

Table 10.6. Purchasing oversea stocks

[Stock Symbol [Number of shares[Amount |[Commission

[ERIC.ST [15000 [270000 [400
[0694.HK [70000 [280000 [300
[AMZN [1000 [32000 [25

As you can see in the Chart of Accounts, you have now purchased stocks in three
different currencise (HK, USD, as well as in SEK), but the Chart of Account (as seen
below) do not indicate how much it is valued in your home currency, AUD.
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g currency_PutToGether - Accounts
m:mmn_:szmn:e:mm:miammmave:wuve_mgzqezmmm_u

e ;
Rl E 8B
@ Accounts
Account Name ~ Type Commaodity Total Total (AUD) | | & =
= @ Assets Asset Australian Dollar $631,719.87 $631,719.87
= ) Current Assets Asset  Australian Dollar §168.,910.00 $169,910.00

fit Savings Account  Bank  Australian Dollar $169,910,00  $169.910.00

b & Fixed Assets Asset  Au an Dollar $300,000.00 $300,000.00
= g Investments Asset  Australian Dollar $161,809.87 $161.808 87
= ffit HK Broker Asset  Hong Kong Dollar  HKD 308,390.00 $52,385.81
8 0694.HK Stock  Beijing Airport 70,000 0654 HK $0.00
& Bank Bank Hong Kong Dellar  HKD 30€.390.00 $52.385.81
= it Swedish Broker  Asset  Swedish Krona SEK 286,290.00 $51,601.07
8 Bank Bank  Swedish Krona SEK 286,280.00 $51,601.07
&= ERIC.ST Stock  Ericsson B-Fria 15,000 ERIC.ST $0.00
= ffit US Broker Asset  US Dollar USD 43,905.00 $57.822.99
B AMZN Stock  Amazon 1,000 AMZN $0.00
US Dollar USD 43,905.00 $57.822.99
b i Equity Equity  Australian Dollar $800,000.00  $800.000.00
= fit Expenses Expense Australian Dollar $30,245.49 $30,245.49 Il
b g Interest Expense Australian Dollar $30,000.00 $30.000.00
= ) Investments Expense Australian Dollar $245 49 $245.49
= it Commissions Expense Australian Dollar $155.49 $155.49
= g HK Broker Expense Hong Kong Dollar HKD 300.00 $50.96
i} 0694 HK Expense Hong Kong Dollar HKD 300,00 $50.96 =
| % grand total: Assets: $631.719.87 Profits: -$30.245 .48 2

Some of the accounts in Chart of Accounts after the stock purchase

Next section will ensure you get the various exchange rates so GnuCash can show
your total worth in the local currency (AUD in this case)

Get the online quotes

To get the current exchange rates and stock quotes, go to Tools -> Price Editor and
then click on Get Quotes.

Lending money to a friend
Peter has run into some difficulties all the way over in Europe Land. Since he is a

very dear pal of yours, you decide to help him out with a personal loan of 40,000
Euro.

Assets:Money owed to me:Euro:Peter (Euro)
Income:Interest Income:Peter (Euro)
Expenses:Bank Charge (AUD)
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This is a simpe currency transaction from your Savings Account (AUD), to your
Assets:Money owed to me:Peter (EURO) account. You got the exchange rate of
0.606161, which means you need to withdraw AUD 65,989.10, as well as pay the
service fee of 35 AUD.

Buying property in New Zealand with a loan from Japan

Your long time Japanese friend offers you a Japanese house loan if you purchase a
property overseas, with only AUD 50,000 as deposit. After having discussed this with
your Financial Advisor in Australia and gone through the various risks and benefits
related to your situation, you decide to accept his offer.

Note

Again, this should not be taken as a financial advice. Please consult with a
registered financial advisor before undertaking investing (or spekulating)
in overseas markets, or local markets for that matter.

A word of warning might be of interest here, taking a loan overseas for a
very low interest rate might seem like a very good deal. Do keep in mind
though that the exchange rate might change and can change drastically. If
you take a loan in your local currency, you only have to worry about the
interest rate. Taking a loan overseas, then you have to worry about the
interest rate and the exchange rate.

You found a nice small cottage in a small coastal town near Auckland which would
be a perfect summer house, and you decide to use the money from Japan for this
purpose.

We need the following accounts for this example;

Liabilities:Loans:Japan Loan (JPY)
Expenses:Interest:Japan Loan JPY)
Expenses:Mortgage Adm Fees:Japan Loan JPY)
Assets:Current Assets:Japan Bank Jpy)
Assets:Fixed Assest:NZ House (NZ)

Table 10.7. Buying a NZ House Split Transaction

[Increase [Decrease
[300000 (NZD) |

goooc:ﬁ
[Assets:Fixed Assets:NZ House
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|Assets:Current Assets:Savings

IAccount 50000 (AUD) (1.18926)

28000000 (JPY)

Liabilities:Loans:Japan Loan (0.0137609)

Expenses:Mortgage Adm Fees:Japan (300000 (JPY)
Loan (0.0137609)

Whats next?

As you have seen in the above examples you have only done the initial purchases.
The rest, that is various selling, and unrealized gains tracking is left for you to
ponder upon.

Chapter 11. Depreciation

Table of Contents

Basic Concepts
Personal Finances
Business

Estimating Valuation
Depreciation Schemes

Account Setup

Example

This chapter will introduce the concept of depreciation in accounting and give some
real life examples for using it.

Basic Concepts

Depreciation is the accounting method for expensing capital purchases over time.
There are two reasons that you may want to record depreciation; you are doing
bookkeeping for your own personal finances and would like to keep track of your net
worth, or you are doing bookkeeping for a small busines and need to produce a
financial statement from which you will prepare your tax return.

The method of recording depreciation is the same in either case. but the end goal is
different. This section will discuss the differences between the two. But first, some
terminology.

o Accumulated depreciation - the accumulated total of book depreciation taken
over the life of the asset. This is accumulated in the depreciation account in the
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asset section.

* Book depreciation - this is the amount of depreciation that you record in your
financial statements per accounting period.

e Fair market value - the amount for which an asset could be sold at a given time.

e Net book value - this is the difference between the original cost and the
depreciation taken to date.

e Original cost - this is the amount that the asset cost you to purchase. It includes
any cost to get the asset into a condition in which you can use it. For example -
shipping, installation costs, special training.

e Salvage value - this is the value that you estimate the asset can be sold for at
the end of it's useful life (to you).

o Tax depreciation - this is the amount of depreciation that you take for income
tax purposes.

Personal Finances

Depreciation is used in personal finances to periodically lower an asset's value to
give you an accurate estimation of your current net worth. For example, if you
owned a car you could keep track of its current value by recording depreciation
every year. To accomplish this, you record the original purchase as an asset, and
then record a depreciation expense each year (See the section called “Example” for
an example). This would result in the net book value being approximately equal to
the fair market value of the asset at the end of the year.

Depreciation for personal finance has no tax implications, it is simple used to help
you estimate your net worth. Because of this, there are no rules for how you
estimate depreciation, use your best judgement.

For which assets should you estimate depreciation? Since the idea of depreciation
for personal finances is to give you an estimate of your personal net worth, you need
only track depreciation on assets of notable worth that you could potentially sell,
such as a car or boat.

Business

As opposed to personal finance where the goal is tracking personal worth, business
is concerned with matching the expense of purchasing capital assets with the
revenue generated by them. This is done through book depreciation. Businesses
must also be concerned with local tax laws covering depreciation of assets. This is
known as tax depreciation. The business is free to choose whatever scheme it wants
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to record book depreciation, but the scheme used for tax depreciation is fixed. More
often than not this results in differences between book and tax depreciation, but
steps can be taken to reduce these differences.

Now, what purchases should be capitalized? If you expect something that you
purchase to help you earn income for more than just the current year, then it should
be capitalized. This includes things like land, buildings, equipment, automobiles, and
computers - as long as they are used for business purposes. It does not include items
that would be considered inventory. So if you made a purchase with the intent to
resell the item, it should not be capitalized.

In addition to the purchase of the asset itself, any costs associated with getting the
asset into a condition so that you can use it should be capitalized. For example, if
you buy a peice of equipment and it needs to be shipped from out of town, and then
some electrical work needs to be done so you can plug the machine in, and some
specialized training is needed so you know how to use the machine, all these costs
would be included in the cost of the equipment.

You also need to know the estimated salvage value of the asset. Generally, this is
assumed to be zero. The idea behind knowing the salvage value is that the asset will
be depreciated untill the net book value (cost less depreciation) equals the salvage
value. Then, when the asset is written off, you will not have a gain or loss resulting
from the disposal of the asset.

The last step is to determine the method of depreciation that you want to use. This
will be discussed on the next few pages.

Note

Warning: Be aware that different countries can have substantially different
tax policies for depreciation; all that this document can really provide is
some of the underlying ideas to help you apply your "favorite"
tax/depreciation policies.

Estimating Valuation

A central issue with depreciation is to determine how you will estimate the future
value of the asset. Compared to the often uncertain estimates one has to do where
appreciation of assets is concerned, we are on somewhat firmer ground here. Using
sources listed below should make it fairly straight forward to estimate the future
value of your depreciating assets.

e Tax Codes: For businesses that want to use depreciation for tax purposes,
governments tend to set up precise rules as to how you are required to calculate
depreciation. Consult your local tax codes, which should explicitly state how to
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estimate depreciation.

e Car Blue Book: For automobiles, it is easy to look up in references such as "Blue
Books" estimates of what an automobile should be worth after some period of
time in the future. From this you will be able to develop a model of the
depreciation.

Depreciation Schemes

A depreciation scheme is a mathematical model of how an asset will be expensed
over time. For every asset which undergoes depreciation, you will need to decide on
a depreciation scheme. An important point to keep in mind is that, for tax purposes,
you will need to depreciate your assets at a certain rate. This is called tax
depreciation. For financial statement purposes you are free to choose whatever
method you want. This is book depreciation. Most small businesses use the same
rate for tax and book depreciation. This way there is less of a difference between
your net income on the financial statements and your taxable income.

This section will present 3 of the more popular depreciation schemes: linear,
geometric, and sum of digits. To simplify the examples, we will assume the salvage
value of the asset being depreciated is zero. If you choose to use a salvage value,
you would stop depreciating the asset once the net book value equals the salvage
value.

1. Linear depreciation diminishes the value of an asset by a fixed amount each
period until the net value is zero. This is the simplest calculation, as you
estimate a useful lifetime, and simply divide the cost equally across that
lifetime.

Example: You have bought a computer for $1500 and wish to depreciate it over
a period of 5 years. Each year the amount of depreciation is $300, leading to the
following calculations:

Table 11.1. Linear Depreciation Scheme Example

[Year|Depreciation|Remaining Value
O [1500

1 [300 [1200

2 [300 [900

3 [300 [600

4 [300 [300

[5  [300 o
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2. Geometric depreciation is depreciated by a fixed percentage of the asset value

in the previous period. This is a front-weighted depreciation scheme, more
depreciation being applied early in the period. In this scheme the value of an
asset decreases exponentially leaving a value at the end that is larger than zero
(i.e.: a resale value).

Example: We take the same example as above, with an annual depreciation of
30%.

Table 11.2. Geometric Depreciation Scheme Example

Year|Depreciation|Remaining Value
0 - 1500
1 450 1050
2 315 735
3 220.50 514.50
4 154.35 360.15
5 108.05 252.10
Note

Beware: Tax authorities may require (or allow) a larger percentage in
the first period. On the other hand, in Canada, this is reversed, as they
permit only a half share of "Capital Cost Allowance" in the first year.
The result of this approach is that asset value decreases more rapidly
at the beginning than at the end which is probably more realistic for
most assets than a linear scheme. This is certainly true for
automobiles.

. Sum of digits is a front-weighted depreciation scheme similar to the geometric
depreciation, except that the value of the asset reaches zero at the end of the
period. This is a front-weighted depreciation scheme, more depreciation being
applied early in the period. This method is most often employed in Anglo/Saxon
countries. Here is an illustration:

Example: First you divide the asset value by the sum of the years of use, e.g. for
our example from above with an asset worth $1500 that is used over a period of
five years you get 1500/(1+2+3+4+5)=100. Depreciation and asset value are
then calculated as follows:
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Table 11.3. Sum of Digits Depreciation Scheme Example

_M\mmﬁ_bmﬁwm&mno: _mmEmEEQ Value
O [1500

1 [100*5=500 [1000

2 [100*4=400 [600

[3 [100*3=300 [300

l4  [100*2=200 [100

[ [100*1=100 |0

Account Setup

As with most accounting practices, there are a number of different ways to setup
depreciation accounts. We will present here a general method which should be

flexible enough to handle most situations. The first account you will need is an Asset

Cost account (GnuCash account type "asset"), which is simply a place where you

record the original purchase of the asset. Usually this purchase is accomplished by a

transaction from your bank account.

In order to keep track of the depreciation of the asset, you will need two

depreciation accounts. The first is an Accumulated Depreciation account in which to
collect the sum of all of the depreciation amounts, and will contain negative values.
In GnuCash, this is an account type asset. The Accumulated Depreciation account is

balanced by a Depreciation Expense account, in which all periodic depreciation
expenses are recorded. In GnuCash, this is an account type expense.

Below is a generic account hierarchy for tracking the depreciation of 2 assets,

ITEM1 and ITEM2. The "Asset Cost" accounts are balanced by the "Bank" account,

the Accumulated Depreciation account is balanced by the Depreciation Expense
account.

-Assets
-Fixed Assets
-ITEM1
-Cost (Asset Cost account)
-Depreciation (Accumulated Depreciation account)
-ITEM2
-Cost (Asset Cost account)
-Depreciation (Accumulated Depreciation account)
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-Current Assets
-Bank
-Expenses

-Depreciation (Depreciation Expense account)

One of the features of the account hierarchy shown above is that you can readily see
some important summary values about your depreciating asset. The "Assets:Fixed
Assets:ITEM1" account total shows you the current estimated value for item1, the
"Assets:Fixed Assets:ITEM1:Cost" shows you what you originally paid for item1,
"Assets:Fixed Assets:ITEM1:Depreciation" shows you your accrued depreciation for
item1, and finally, "Expenses:Depreciation" demonstrates the total accrued
depreciation of all your assets.

It is certainly possible to use a different account hierarchy. One popular account
setup is to combine the Asset Cost and Accrued Depreciation asset accounts. This
has the advantage of having fewer accounts cluttering your account hierarchy, but
with the disadvantage that to determine some of the summary details mentioned in
the paragraph above you will have to open the account register windows. As with
most things, there are many ways to do it, find a way that works best for you.

The actual input of the depreciation amounts is done by hand every accounting
period. There is no way in GnuCash (as of yet) to perform the depreciation scheme
calculations automatically, or to input the values automatically into the appropriate
accounts. However, since an accounting period is typically one year, this really is
not much work to do by hand.

Example

Let's go ahead and step through an example. Imagine you are a photographer and
you use a car and an expensive camera for your personal business. You will want to
track the depreciation on these items, because you can probably deduct the
depreciation from your business taxes.

The first step is to build the account hierarchy (as shown in the previous section,
replace ITEM1 and ITEM2 with "car" and "camera"). Now, record the purchase of
your assets by transferring the money from your bank account to the appropriate
Asset Cost accounts for each item (eg: the "Assets:Fixed Assets:Car:Cost" account for
the car). In this example, you start with $30k in the bank, the car cost $20k and the
camera cost $10k and were both purchased on January 1, 2000.
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gnucash_depreciation - Accounts

File Edit

=

Save

i Accounts

Account Name

Wiew Actions

v R Assets
I @ Current Assets
— @ Fixed Assets
= fm Carmera
i Cost
o Depreciation
v R Car
@ Cost
m Depreciation
D fm Equity
- @ Expenses
fm Depreciation

Business Reports

i

Mew

v | Type
Asset
Asset
Asset
Asset
Asset
Asset
Asset
Asset
Asset
Equity
Expense

Expense

Tools Windows

Total

USD 30,000.00
UsD 0.00

UsSD 30,000.00
USD 10,000.00
UsSD 10,000.00
UsD 0.00

UsD 20,000.00
USD 20,000.00
UsD 0.00

USD 30.000.00
UsD 0.00

UsD 0.00

Help

D]

_ USD, grand total:

Assets: USD 0.00

Profits: USD 0.00

-

-
_

The asset depreciation example main window, before depreciation

Looking at the tax codes, we realize that we must report depreciation on these
items using the "sum of digits" scheme, over a 5 year period. So, the yearly
depreciation amounts for the car come to $6667, $5333, $4000, $2667, $1333 for
years 1 to 5 respectively, rounded to the nearest dollar. The yearly depreciation
amounts for the camera are $3333, $2667, $2000, $1333, $667. Consult the previous
section on Depreciation Schemes for the formula for calculating these values.

For each accounting period (IE: fiscal year) you record the depreciation as an
expense in the appropriate Accrued Depreciation account (eg: the "Asset:Fixed
Assets:Car:Depreciation" account for the car). The two windows below show your
car's accrued depreciation account and the main window after the third year (IE:
three periods) of depreciation using this "sum of digits" scheme.

208 de 273



gnucash_depreciation - Depreciation

e e g e Chapter 12. Accounts Receivable
ﬂ x .H_ ¥ + X £ 4 E ¥ B -

ale  Delete Entes cantel Blank Spit Jump  Schedule

@ Accourts @ O Table of Contents

[Pat= Transfer

Overview of Business Features
Basic Concepts
R R Cet T R ek P i T R0 Initial Setup
= Account Setup
Company Registration
System Components

Prozant:
Enter a de

The asset depreciation register window

Customers
File Edit View Actions Business Reports Tools Windews Help New
= @ Find and Edit
e e Invoices
@ Accounts Z@S\
! . Edit
7 Account Name ~ | Type Total 4 i Post
”4 fi Assets Asset UsD 6,000.00 | Find
% I @ Current Assets Asset USD 0.00 , Print
|~ i Fixed Assets Asset USD 6,000.00 Assign Starting Invoice Number
, < fiit Camera Asset USD 2,000.00 Customer Jobs
” i Cost Asset USD 10,000.00 , Process Payment
7 fil Depreciation  Asset -USD 8,000.00 Changing the Invoice Appearance
- @m Car Asset USD 4,000.00
f pap— — T SR TROT Accounts Wmom?.mzm (or A/R) refers to products or services provided by your
| S —— company for which payment has not yet been received.
ﬁ b ofm Equity Equity USD 30,000.00 | . .
oy Expense  USD 24,000.00 Overview of Business Features
7 G Depreciation Expense USD 24,000.00
The accounting needs of a business are quite different from that of a person.
, |USD. grend total: Assets: -USD 24,000.00 Profts: UsD 0.00 2 | Businesses have customers that owe money, vendors which are owed money,
. P employee payroll, more complex tax laws, etc. GnuCash offers business oriented

features to facilitate these needs.
The asset depreciation main window
Accounts Receivable (A/R) are used by businesses to record sales for which they are

Note not immediately paid. Accounts Payable (A/P) record bills that they have received,
but might not pay until later. These types of accounts are used primarily when you

A Word of Caution: Since depreciation and tax issues are closely related, have a lot of bills and receipts flowing in and out, and do not want to lose track of

you may not always be free in choosing your preferred method. Fixing them just because you do not pay or get paid right away. For most home users, A/R

wrong calculations will cost a whole lot more time and trouble than getting and A/P are too complicated to be worth the effort.

the calculations right the first time, so if you plan to depreciate assets, it is

wise to make sure of the schemes you will be permitted or required to use. Basic OQHnO@UHm
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Accounts Receivable (or A/R) refers to products or services provided by your
company for which payment has not yet been received. This is represented on the
balance sheet as an asset, because the expectation is that you will receive payment
soon.

Initial Setup

To set up GnuCash to handle accounts receivable for a company two preliminary
things must be done. The first is to build an appropriate Account Hierarchy and the
second is to register the company in GnuCash.

Account Setup

There are many different ways to set up a business account hierarchy. You can start
with the Business Accounts setup which is available from the New Account Hierarchy
druid, or you could build one manually. To access the prebuilt Business Accounts,
start GnuCash and click on File -> New File and proceed until you see the list of
available accounts, select Business Accounts.

The prebuilt Business Account hierarchy will not meet your needs exactly. You will
need make adjustments for the hierarchy to function well with your particular
situation. It should be close enough that it is recommended you begin with it.

Accounts Receivable (or A/R) refers to products or services provided by the company
on credit for which payment has not yet been received. This is represented on the
balance sheet as an asset, because you expect to receive payment soon. To use
GnuCash's integrated accounts receivable system, you must first set up an account
(usually a sub-account under Assets) defined with account type A/Receivable. It is
within this account that the integrated A/R system will place transactions.

Basic A/R Account Hierarchy:

-Assets

-Checking

-Accounts Receivable
-Income

-Sales

You need to add additional asset, expense, and income accounts to this hierarchy for
it to be useful. The important aspects of this hierarchy are the use of an income
account and the Accounts Receivable asset account, with account type set to
A/Receivable.
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Note

You do not need to create an individual A/R account for each customer.
GnuCash keeps track of customers internally and provides per-customer
reports based on the internal tracking.

Company Registration

After you have built the account structure, register the GnuCash file as belonging to
your company. To register your company, select File -> Properties:

« Enter the name of your company along with contact information such as your
phone number, fax number, e-mail address and website URL.

« Enter your company's tax payer id number in the Company ID field.

e Select default tax tables applicable to your most common customers and
vendors.

System Components

GnuCash has an integrated accounts receivable system. The transactions generated
by the A/R system are recorded within the Accounts Receivable account. You
generally do not work directly with this account. You generally work with the four
integrated GnuCash A/R application components available through the Business ->
Customer sub-menu. These four components are:

e Customers are people or companies to whom you sell products or services on
credit.

« Invoices represent the physical invoice you send to a customer to request
payment. This invoice contains an itemized list of things you sold.

« Jobs (optional) is where you register Customer Jobs. Jobs are a mechanism by
which you can group multiple invoices to a particular customer.

e Process Payments is used to register payments you received from a customer.

The following sections introduce the individual components in more detail.

Customers

Customers are people or companies to whom you sell goods or services. They must
be registered within the A/R system.
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New

To register a new customer, enter the menu Business -> Customer -> New
Customer. Fill in customer information, such as Company Name, Address, Phone,
Fax, etc. Below is a list of the other options:

¢ Identification - Customer Number - can be any number by which you would like
to refer to this customer. You may leave it blank and a number will be chosen
automatically.

Identification - Active - differentiates active customers from inactive ones. This
is useful when you have many past customers, and you want to see only those
marked active.

Billing Address - Name - is the contact name of the person to receive the
invoices.

Notes - records any additional comments about the customer.

Billing Information - Currency - specifies the default billing currency.

Billing terms must be preregistered using Business -> Billing Terms Editor.

Billing Information - Discount - gives the customer a default percentage based
discount at the time of invoice creation. Enter a value from 0 to 100. You can
override the default discount when you create an invoice.

Billing Information - Credit Limit - stores the maximum credit you are willing to
extend to the customer. This field is for your reference purposes only. GnuCash
does not use the value.

Billing Information - Tax Included - this specifies whether nor not tax is included
in invoice amounts by default. You can choose Yes, No, or Use Global.

o Yes means that the tax is already included in amounts on invoices.
o No means tax is not included.

o Use Global means to use the setting made in the global preferences
accessible through Edit -> Preferences.

« Billing Information - Tax Table - specifies a default tax table to apply to invoice
line items. Tax tables must be registered from the Business -> Tax Table Editor
menu item.

o Shipping Address - records the customer's shipping address if it is different from
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Billing Information - Terms - specifies the default billing terms for this customer.

the billing address. The shipping address is for your reference. GnuCash does not

use the value.

This is what the New Customer registration window looks like:

New Customer - ABC Inc ()

Customer _ Billing Information _ Shipping Address #

Identification

Custormer Nurmber: _

Company Name: | ASC Inc

Billing Address

Name: ” Bob McBob

Address: | 123 First Ave,

| Somecity, S5 12345

|
k

Phone: |515-234-5678

f

Fax: |515-235-3679

Email: | abc@abc.com

Motes
Bob McBaob, Sales Dept.

12
~
O O L

@Em_u . X cancel &W

New Customer Registration Window

Find and Edit

To search for an existing customer, use the Business -> Customer -> Find Customer

window. You select a customer to View/Edit from the results of the search. This
window is also used to look up customers when creating invoices and processing

payments.
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.,. Find Customer
Customer Search
Search Criteria

& add search for items where  all ¢

% Case Insensitive? || == Bemaove | |

Company Mame || contains 4| |abe

Trpe of search
New search
® Refine current search
Add results to current search

ID# v | Company Contact
000001 ABCinc  Bob McBob

‘iew/Edit Custamer
Customer's Jobs
Delete results from curent search

Customer's Invoices

Search anly active data Process Payment

e New Custorer X Clase

Find Customer Window

If many customers match the search criteria you provide, the search can be refined
by running an additional search within the current results. The current result set is

searched when the Refine Current Search radio button is selected. In fact, GnuCash
selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria,
change the search criteria, click the New Search radio button and then the Find
button. The relevant step is the New Search selection. If the customer is not in the
result of the original search, and you only search within this set, the customer
cannot be found, regardless of new search criteria.

Note

To return a list of all registered active customers, set the search criterion
to matches regex, and place a single dot "." in the text field area. Make
sure Search only active data is checked, then click Find. The regular

expression "." means to match anything.

Invoices

An invoice is the paperwork you send to a customer to request payment for products
or services rendered. GnuCash can generate and track invoices.

New
To send an invoice to a customer you must first create a new invoice. To create an
invoice use Business -> Customer -> New Invoice. The New Invoice window must be

filled in appropriately:

¢ Invoice Information - Invoice ID - the identification number of this invoice. This
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is your internal number for this invoice. If you leave it blank, an invoice number
will be generated automatically.

« Invoice Information - Date Opened - the date this invoice was created.

« Billing Information - Customer - the customer who is to receive this invoice. Use
the Select button to access the Find Customer window described in the previous
section. When you have looked up the customer to be invoiced, click the Select
in the search window to select the customer.

« Billing Information - Job (optional) - associates the new invoice with a customer
job. Customer jobs are described in the following section.

« Billing Information - Billing ID - this is the customer's PO Number or other
"customer reference number". You should use it to identify your invoices to this
customer (and job, if you have one).

« Billing Information - Terms - the payback terms agreement for this invoice. A list
of registered terms is available within the pop up menu. If you specified a
default value for the selected customer, this field is initialized with the default.

New Invoice

Invoice Information
Invoice 1D ﬁ |_
Date Opened |04/19/06 v
Billing Infermation

Custemer _>mn Inc _mm,mnﬁ;._

Job _ __mm,mn#:_

Billing I _>mn Purchase Order # 12988 _

Terms _ 30 Days 0_

MNotes

Your personal notes go here.
Notes do not appear on printed invoices.

_ 8 el _ _kmmznm_: Pk _

Creating a New Invoice

When you click the OK button, the Edit Invoice window opens.

Edit
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From the Edit Invoice window you can enter an itemized list of things you sold on
this invoice, in a manner similar to how the account register works.

documentation - Edit Involce - 000001

fle Edt Mew Actions Busness Beports Bols windows Help

X @m - 3

cancal Duplcate  Blank

Ivoice D 000001 personal notes ga here O
Nates do not sgpear en prirted imvaices,

Date Openad Edit

| Active 1B A8C Purchase Order # 17988

o Entrias
[Ir[Besergtion [Artion _[incarme Account |uantity | Unit Price |01 O | Discount | [1] 7| Subtata [Tax__|*
% Nails waterial 1.000.00 010 % < x 10000 000
*%_Hammer Material _ Income:Sales 100 50000 % < 5.00 X 47500 000
| o< X 000 0.0

§575.00 Tax:$0.00

Edit Invoice Window
There are 15 columns in the Invoice Entries area:
e Date - The date this item was sold.

« Invoiced? - X means the item is attached to this invoice, an empty box means the
item is not attached to this invoice. The item is attached for you when you
proceed to the next line item.

o Description (optional) - is what the item or service is called.

e Action (optional) - is a user defined field. You can place Cost Center information
here, or use one of the 3 predefined actions, Hours, Material, or Project.

e Income Account - selects which income account is credited with this income.
e Quantity - tracks how many of the items you sold.
e Unit Price - is the unit price of the item.
« Discount Type - is the type of discount:
o $ means Discount is a monetary value
o % means Discount is a percentage.
You can click the field to toggle between the discount types.

e Discount How - the discount can be computed as follows:
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o > means the discount applies after tax.
o < means the discount applies before tax.

o = means both discount and tax are applied to the pretax value.

You can click the field to change the setting.

o Discount (optional) - is the total discount, in monetary units or percentage,
depending on Discount Type. You can leave it blank for no discount. Any default
discount you specified for the customer will be automatically entered for each
new item.

o Taxable? - is this item taxable? X means yes, a blank field means no. You can
click the field to toggle the setting.

e Tax Included? - has the tax already been included in the unit price? X means yes,
a blank field means no. For example, if there is 1 item of $100 with a tax of 5%
then:

o If Tax Included is empty, then subtotal = $100 and tax = $5.

o If Tax included is set (X), then subtotal = $95.23 and tax = $4.77. The
computation is: Subtotal = Total / (1+taxrate) and Tax = Total - Subtotal =
Total - (Total / (1+taxrate)).

« Tax Table (optional) - this is a pop up menu of all the available tax tables. If you
make the item taxable, then this table is used to compute the amount of tax. The
tax table determines tax percentages and the accounts to which tax is charged.

o Subtotal (uneditable) - is the computed subtotal for this item (less tax).
e Tax (uneditable) - is the computed tax for this item.

When you have finished entering all the items, you can Post and print the invoice.

Post

When you finish editing an invoice and are ready to print, you must Post the invoice.
The invoice does not have to be posted immediately. In fact, you should only post an
invoice when you are ready to print it. Posting an invoice places the transactions in

an accounts receivable account.

The Post Invoice window appears and asks you to enter information:
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Question ] m_mn.-.ﬁm

Di Il tt t the i ¥ P . . . . .
@ow R To find an existing invoice, use the Business -> Customer -> Find Invoice
application. From the results of the search, you can select an invoice to edit or view.

Post Date |04/13/06

Due Date ZOH&
Description : _
Post to Account [Assets:Accounts Receivi| v | i Before you can edit a posted invoice, you will need to Unpost it.

Sl Gt S One of the design goals in GnuCash's Account Receivable system was to allow

different processes to get to the same state, so you can reach an invoice from

E E different directions based on the way you think about the problem:

¢ You can search for the customer first, then list their invoices.

Post Invoice Window

You can search for invoices by number or by company name.
» Post Date - specifies the date for the transactions entered into the accounts * v v pany

receivable account. e You can list invoices associated with a customer job.
e Due Date - is the date on which payment for the invoice is expected. Print

o If you specified payment terms when you created the invoice, the date is

calculated according to selected terms, and the entry field is insensitive. After you post an invoice, you should print it and send it to your customer. To print

an invoice use File -> Print Invoice menu item.

o If you did not specify payment terms, enter the expected payment due date

here. An example of the default GnuCash invoice print output is shown below.

« Description - is an arbitrary description. When invoice transactions are placed in Invoice #000001

the accounts receivable account, this description is entered in the memo field of HH”_NWE memm oo76 Secamd st
those transactions. T 2343
ABC Inc
« Post To Account - selects the accounts receivable account in which invoice oty 55 12045
transactions are posted. You can select the account from a list of existing
. Reference: ABC Purchase Order # 12988
A/Receivable accounts. Terms: 30 Days - sarne as cash
. . . . . . Date Description n.w_qﬂﬂamm Quantity _w"ﬂnsm Discount | Taxable Total
e Accumulate Splits - determines if invoice items which transfer to the same | | |
. . . . . P il nal X 1
account are combined into a single split for that account or entered individually. i Lo tate ¥ 1o0000| 040|000 0000
. . . . s 04/19/06 H: Mat: 1.00 500.00 5.00% 475.00
For the sample invoice which sold Nails and a Hammer, the setting affects post i ‘Ek. _ ammer e | #5000 . Md —
ubtotal .
results as follows: Tax $0.00

Amount

o Checked (splits are accumulated) - a single transfer of $575.00 from the Due
Income:Sales account is recorded.

$575.00

Thank you f